AMD-RAIDXpert2
User Guide
The information contained herein is for informational purposes only, and is subject to change without notice. While every precaution has been taken in the preparation of this document, it may contain technical inaccuracies, omissions and typographical errors, and AMD is under no obligation to update or otherwise correct this information. Advanced Micro Devices, Inc. makes no representations or warranties with respect to the accuracy or completeness of the contents of this document, and assumes no liability of any kind, including the implied warranties of noninfringement, merchantability or fitness for particular purposes, with respect to the operation or use of AMD hardware, software or other products described herein. No license, including implied or arising by estoppel, to any intellectual property rights is granted by this document. Terms and limitations applicable to the purchase or use of AMD’s products are as set forth in a signed agreement between the parties or in AMD's Standard Terms and Conditions of Sale.

**Trademarks**

AMD, the AMD Arrow logo, and combinations thereof are trademarks of Advanced Micro Devices, Inc. Other product names used in this publication are for identification purposes only and may be trademarks of their respective companies.

Reverse engineering or disassembly is prohibited.

Microsoft and Windows are registered trademarks of Microsoft Corporation.

Linux is a registered trademark of Linus Torvalds.

PCle is a registered trademark of PCI-Special Interest Group (PCI-SIG).

**Dolby Laboratories, Inc.**

Manufactured under license from Dolby Laboratories.

**Rovi Corporation**

This device is protected by U.S. patents and other intellectual property rights. The use of Rovi Corporation's copy protection technology in the device must be authorized by Rovi Corporation and is intended for home and other limited pay-per-view uses only, unless otherwise authorized in writing by Rovi Corporation.

USE OF THIS PRODUCT IN ANY MANNER THAT COMPLIES WITH THE MPEG ACTUAL OR DE FACTO VIDEO AND/OR AUDIO STANDARDS IS EXPRESSLY PROHIBITED WITHOUT ALL NECESSARY LICENSES UNDER APPLICABLE PATENTS. SUCH LICENSES MAY BE ACQUIRED FROM VARIOUS THIRD PARTIES INCLUDING, BUT NOT LIMITED TO, IN THE MPEG PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEG LA, L.L.C., 6312 S. FIDDLERS GREEN CIRCLE, SUITE 400E, GREENWOOD VILLAGE, COLORADO 80111.
# Contents

**Revision History** .................................................................................................................. 12  

**Chapter 1 Safety Precautions** ................................................................................................. 15  
1.1 General ................................................................................................................................. 15  
1.2 Safety Definitions ................................................................................................................... 15  
1.3 Caution Messages .................................................................................................................. 15  
1.3.1 Caution Messages About Disks ....................................................................................... 15  
1.3.2 Caution Messages about Arrays ...................................................................................... 15  

**Chapter 2 Getting Started** ..................................................................................................... 18  
2.1 RAIDXpert2 Technology ....................................................................................................... 18  
2.2 Who Should Use This Manual ............................................................................................... 18  
2.3 System Requirements for Using RAIDXpert2 ...................................................................... 18  
2.3.1 Supported Processors and Chipsets .................................................................................. 19  
2.3.2 Supported Operating Systems ......................................................................................... 19  
2.4 Features of RAIDXpert2 ....................................................................................................... 20  
2.5 RAIDXpert2 Feature Set ........................................................................................................ 22  

**Chapter 3 Understanding Arrays, Disks and RAID Levels** .................................................... 26  
3.1 Understanding Arrays ........................................................................................................... 26  
3.2 RAID Levels ........................................................................................................................ 26  
3.3 Array States .......................................................................................................................... 27  
3.4 Creating Arrays: Future Expansion ...................................................................................... 29  
3.5 Expanding Disk Capacity Online: Using OCE ..................................................................... 29  
3.6 Migrating RAID Levels Online: Using ORLM ................................................................. 29  
3.7 Array Tasks: Starting and Stopping Tasks ............................................................................ 30  
3.8 Understanding Disks ............................................................................................................. 31  
3.8.1 Disks States ..................................................................................................................... 31  
3.9 Rescanning Disks for Changes in State ................................................................................ 32  
3.10 Sparing Options: Disks and Arrays ..................................................................................... 33  
3.11 Dedicated Sparing ................................................................................................................ 33  
3.12 Global Sparing ..................................................................................................................... 34  
3.13 RAID Performance Considerations ...................................................................................... 34
3.13.1 Number and Organization of Disks ................................................................. 34
3.13.2 Caching Attributes ....................................................................................... 34
3.13.3 Application Workload .................................................................................. 35
3.14 RAID Reliability Considerations ................................................................. 35
  3.14.1 Data Redundancy ....................................................................................... 35
  3.14.2 Backup ...................................................................................................... 35
3.15 Flexibility and Expansion Considerations .................................................. 35
3.16 Multiple RAID Levels ................................................................................... 35

Chapter 4 Platform RAID Enablement Prerequisites ............................................ 36
  4.1 Platform BIOS Settings - Enable RAID for the AMD SP3-Series Chipsets ....... 36
  4.2 Platform BIOS Settings – Enable RAID for the AMD Socket AM4- Compatible Processors .......................................................... 37

Chapter 5 BIOS Configuration Utility (Option ROM) ............................................ 39
  5.1 When to Use the AMD-RAID Controller BIOS Configuration Utility ........ 39
  5.2 Access the AMD-RAID Controller BIOS Configuration Utility (OPROM) ... 40
  5.3 Understanding the Color Code in the BIOS Configuration Utility ............... 40
  5.4 Initialize Disks ............................................................................................... 40
  5.4.1 Initialize Disks ........................................................................................... 40
  5.5 Create Arrays ............................................................................................... 41
  5.5.1 Before You Begin ...................................................................................... 41
  5.5.2 Create an Array ....................................................................................... 41
  5.5.3 Create an AMD-RAID Bootable Array .................................................... 42
  5.5.4 Delete Arrays ........................................................................................... 44
  5.5.5 Swap Arrays ............................................................................................ 45
  5.5.6 Manage Spares ....................................................................................... 45
  5.5.7 View Disk Details .................................................................................... 46
  5.5.8 View Array Details .................................................................................. 47
  5.5.9 Rescan All Channels ............................................................................... 47
  5.5.10 Change the Controller Options .............................................................. 47
  5.5.11 Continue Booting from the BIOS Configuration Utility ....................... 48

Chapter 6 RAIDXpert2 Configuration Utility (HII) .................................................. 49
  6.1 When to Use the RAIDXpert2 Configuration Utility (HII) ......................... 49
<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Software Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>System Setup Process Overview</td>
</tr>
<tr>
<td>7.2</td>
<td>Before You Begin</td>
</tr>
<tr>
<td>7.3</td>
<td>Copying AMD-RAID Drivers to Removable Storage</td>
</tr>
<tr>
<td>7.3.1</td>
<td>Copying AMD-RAID Drivers in a Microsoft® Windows® Environment</td>
</tr>
<tr>
<td>7.3.2</td>
<td>Copying AMD-RAID Drivers in a Linux® Environment</td>
</tr>
<tr>
<td>7.4</td>
<td>Installing AMD-RAID Drivers</td>
</tr>
<tr>
<td>7.4.1</td>
<td>Installing AMD-RAID Drivers while Installing Microsoft® Windows®</td>
</tr>
<tr>
<td>7.5</td>
<td>Installing the AMD RAIDXpert2 Management Suite for Microsoft® Windows®</td>
</tr>
<tr>
<td>7.5.1</td>
<td>Windows® – AMD RAIDXpert2 Management Suite</td>
</tr>
<tr>
<td>7.5.2</td>
<td>Windows® – AMD RAIDXpert2 Management Suite Installation (Manually)</td>
</tr>
<tr>
<td>7.5.3</td>
<td>Installing AMD-RAID Drivers While Installing Linux® Operating System</td>
</tr>
<tr>
<td>7.6</td>
<td>Installing the AMD RAIDXpert2 Management Suite for Microsoft® Windows®</td>
</tr>
<tr>
<td>7.7</td>
<td>Installing the AMD RAIDXpert2 Management Suite for Linux®</td>
</tr>
<tr>
<td>7.8</td>
<td>Installing the AMD RAIDXpert2 Graphical User Interface (GUI)</td>
</tr>
<tr>
<td>7.8.1</td>
<td>RHEL Linux® – AMD RAIDXpert2 Web GUI Installation</td>
</tr>
<tr>
<td>7.8.2</td>
<td>Ubuntu – AMD RAIDXpert2 Web GUI Installation</td>
</tr>
</tbody>
</table>
# AMD-RAIDXpert2 User Guide

## Chapter 8  RAID Software Update

1. Purpose
2. System Overview Process
3. Updating the AMD RAIDXpert2 Management Suite
   - Update the AMD RAIDXpert2 Management Application (Web GUI)—Catalyst
   - Copy the AMD RAIDXpert2 Installer to the Systems Desktop: Red Hat Linux®
   - Copy the AMD RAIDXpert2 Installer to the Systems Desktop: Ubuntu Linux®
4. Updating the AMD-RAID OS Drivers – SOC and AMD 300-Series Chipset
   - Windows® Drivers
   - Linux® Drivers
   - Adding NVMe to Existing AMD-RAID System

## Chapter 9  AMD RAIDXpert2 Graphical User Interface (GUI)

1. Start RAIDXpert2
   - Web-Browser Access
   - Desktop Shortcut Access
2. Password Protection
   - Things to Know About Passwords
   - Change a Password at the Options Menu
3. Help and About Windows®
4. Reviewing the RAIDXpert2 GUI
   - The Array View Section of the Array Status Window
   - The Disk List Section of the Array Status Window
   - The Array List Section of the Array Status Window
   - The Event View Section of the Array Status Window
   - Array and Disk Commands
5. Working with Disks
   - Initialize Disks
   - Rescan Disks
   - Change Cache Properties for Disks
   - Assign Spares
   - Legacy Disks
6. Working with Arrays
9.6.1 Create and Format Arrays.................................................................97
9.6.2 Name Arrays .................................................................................99
9.6.3 Transform Arrays........................................................................100
9.6.4 Restore (Rebuild) Arrays...............................................................102
9.6.5 Prepare to Physically Remove an Array........................................103
9.6.6 Delete Arrays................................................................................104
9.6.7 Change Cache Settings for Arrays................................................105
9.6.8 Change the Priority Level of a Task................................................105
9.6.9 Interrupt, Cancel, or Resume a Task...............................................106
9.6.10 Check for Consistency.................................................................106
9.6.11 Schedule a Consistency Check.....................................................107
9.6.12 Scan an Array in the Background...............................................108
9.6.13 Add or Remove Dedicated Spares.................................................108
9.6.14 Add or Remove Global Spares.....................................................109
9.6.15 Hide an Array...............................................................................109
9.6.16 Secure Erase..............................................................................109
9.7 Working with Views........................................................................110
  9.7.1 Display or Hide Controller Event Log Panel...............................110
  9.7.2 Log Window................................................................................110
  9.7.3 Refresh the Display.....................................................................110
9.8 Working with Options.....................................................................111
  9.8.1 Change Password Settings..........................................................111
  9.8.2 Set Event Notifications...............................................................111
  9.8.3 Licensing...................................................................................111
9.9 Add Spares Using a RAIDABLE Array.............................................111

Chapter 10  rcadm Command Line Interface Tool....................................113
  10.1 What is rcadm?............................................................................113
    10.1.1 To Use rcadm with a Linux® Operating System.........................114
    10.1.2 To Use rcadm with a Windows® Operating System....................114
  10.2 Manage Arrays and Disks: rcadm --manage..................................114
    10.2.1 Understand Query Output.......................................................114
    10.2.2 rcadm Controller List Elements..............................................115

Contents
Chapter 12

12.1 Software License: EULA ......................................................... 137
  12.1.1 Limited License to Authorized Distributors ....................... 137
  12.1.2 Limited License to End Users ....................................... 137
  12.1.3 Restrictions ................................................................ 138
  12.1.4 Proprietary Rights .................................................... 138

Chapter 11 Troubleshooting ............................................................................. 129
  11.1 Troubleshooting ................................................................. 129
  11.2 System Startup Problems .................................................... 129
  11.3 Warning Messages: POST Screen ....................................... 130
  11.4 Array-Related Errors ......................................................... 131
  11.5 Disk Related Errors ........................................................... 135
    11.5.1 Troubleshooting Disks ................................................. 135

Chapter 10 Transform Arrays: rcadmc --transform ...................................... 120
  10.1 Transform Arrays: rcadmc --transform ................................ 120
  10.2 Follow or Monitor Arrays and Disks: rcadmc --follow .............. 120
  10.3 View Help from the Command Line ...................................... 118
  10.4 Create New Arrays: rcadmc --create .................................. 118
    10.4.1 Before You Begin ...................................................... 119
    10.4.2 Example .................................................................. 119

Chapter 9 Follow or Monitor Arrays and Disks: rcadmc --follow .................. 120
  9.1 Follow or Monitor Arrays and Disks: rcadmc --follow .............. 120

Chapter 8 Transform Arrays: rcadmc --transform ...................................... 120
  8.1 Transform Arrays: rcadmc --transform ................................ 120

Chapter 7 View Help from the Command Line .......................................... 118
  7.1 View Help from the Command Line ...................................... 118

Chapter 6 Create New Arrays: rcadmc --create ...................................... 118
  6.1 Create New Arrays: rcadmc --create .................................. 118

Chapter 5 Delete Arrays: rcadmc --delete ............................................ 119
  5.1 Delete Arrays: rcadmc --delete ......................................... 119

Chapter 4 Follow or Monitor Arrays and Disks: rcadmc --follow .............. 120
  4.1 Follow or Monitor Arrays and Disks: rcadmc --follow .............. 120

Chapter 3 View Help from the Command Line .......................................... 118
  3.1 View Help from the Command Line ...................................... 118

Chapter 2 Transform Arrays: rcadmc --transform ...................................... 120
  2.1 Transform Arrays: rcadmc --transform ................................ 120

Chapter 1 Troubleshooting ............................................................................. 129
  1.1 Troubleshooting .................................................................. 129

Contents
12.1.5 Terms and Conditions .......................................................... 138
12.1.6 No Warranty ........................................................................ 139
12.1.7 Limitation of Liability ............................................................ 139
12.1.8 Export Controls ..................................................................... 139
12.1.9 General ................................................................................. 140
List of Tables

Table 1. Document Convention ................................................................. 14
Table 2. Glossary of Terms ........................................................................ 14
Table 3. System Requirements for RAIDxpert2 ........................................ 18
Table 4. Supported Processors and Chipsets ............................................. 19
Table 5. Features of RAIDxpert2 .............................................................. 20
Table 6. Feature Set for RAIDxpert2: Basic License Level ...................... 22
Table 7. RAID Levels – General Characteristics .................................... 26
Table 8. Array States ................................................................................ 28
Table 9. Failure States by RAID Level .................................................... 28
Table 10. Array Expansion Considerations .............................................. 29
Table 11. Types of Tasks per Array .......................................................... 31
Table 12. Disk States ................................................................................. 31
Table 13. Sparing Options ....................................................................... 33
Table 14. When to use the AMD-RAID Controller BIOS Configuration Utility (Option ROM) .. 39
Table 15. BIOS Configuration Utility Color Codes .................................... 40
Table 16. When to use the AMD-RAID RAIDxpert2 Configuration Utility (HII) ................................................................................... 49
Table 17. Default Cache Tag Size .............................................................. 52
Table 18. Linux® Procedure for Installing the Management Suite ............. 76
Table 19. Elements of the Array View Section, Array Status Window ......... 89
Table 20. Elements of the Disk List Section, Array Status Window ............ 90
Table 21. Elements of the Array List Section, Array Status Window ........ 91
Table 22. Elements of the Event View Section, Array Status Window ....... 93
Table 23. Commands at the Array and Disk Menus .................................. 94
Table 24. New and Legacy Disks, as They Appear in the BIOS Configuration Utility / RAIDxpert2 Configuration Utility (HII) and RAIDxpert2 .................................................. 97
Table 25. Creating Arrays: Issues and Recommendations ....................... 98
Table 26. Transforming Arrays: Issues and Recommendations ................. 100
Table 27. Deleting Arrays: Issues and Recommendations ......................... 104
Table 28. Cache Array Options .................................................................. 105
Table 29. Consistency Check Options .................................................... 107
Table 30. Event Log Priority Levels ....................................................... 111
Table 31. Modes for the \texttt{rcadm} Program ................................................................. 113
Table 32. \texttt{rcadm} Controller List Elements ......................................................... 115
Table 33. \texttt{rcadm} Disk List Elements ..................................................................... 116
Table 34. \texttt{rcadm} Array List Elements .................................................................... 117
Table 35. The System Does Not Boot ........................................................................ 129
Table 36. The BIOS Configuration Utility Does Not Display ..................................... 129
Table 37. Username and Password ........................................................................... 130
Table 38. POST Screen Warning Messages ............................................................... 130
Table 39. Cannot Create an Array .............................................................................. 132
Table 40. An Array is in a Critical State ...................................................................... 133
Table 41. An Array is in an Offline State ..................................................................... 133
Table 42. Cannot Assign a Dedicated Spare to an Array .......................................... 133
Table 43. Cannot Create a Global Spare ..................................................................... 134
Table 44. Recreate a Deleted Array ........................................................................... 134
Table 45. Disk Errors ................................................................................................. 135
# Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>February 2019</td>
<td>3.09</td>
<td>Updated Section 12.1.4, Proprietary Rights.</td>
</tr>
<tr>
<td>January 2019</td>
<td>3.08</td>
<td>Updated Table 9 and Table 33. Editorial corrections</td>
</tr>
</tbody>
</table>
| March 2018     | 3.07     | NVMe RAID validation update  
Added references to CTS – Cache Tag Size – in Array Creation, Web GUI and rcadm. |
| July 2017      | 3.06     | Updated the steps to install xampp for RHEL and Ubuntu Operating systems |
| June 2017      | 3.05     | Fourth Public Release.  
• Updated steps to install Ubuntu OS in RAID mode.  
• Removed references to RAIDXpert2 Plus.  
• Removed references to RAID-5 array.  
• Edited steps to Assign and Unassign spares.  
• Removed the section related to “Change the Controller Options” |
| December 2016  | 3.02     | Third Public Release.  
• Added a new chapter for RAIDXpert2 Configuration Utility (HII).  
• Added a new chapter for RAID Driver Software Update.  
• Updated Operating System Requirements.  
• Updated revisions of Ubuntu Desktop Linux to 16.04 32 bit and 64 bit  
• Updated revisions of RedHat (RHEL) 7.3 64 bit  
• Updated steps for BIOS and UEFI boot platforms.  
• Removed support for Ubuntu 15.04, 15.10.  
• Removed support for RedHat 7.2 (RHEL) |
| June 2016      | 3.01     | Second Public Release.  
Removed support for the Microsoft® Windows® 8 operating system.  
Removed support for Ubuntu 13.10. This included removing extra steps that concerned Ubuntu 13.10.  
Updated Operating System Requirements  
Removed references to Windows XP and Windows 8.1.  
Replaced SUSE (SLED) references with Red Hat (RHEL) 7.2 64 bit  
Updated revisions of Ubuntu Desktop Linux  
• 15.04 32 bit and 64 bit  
• 15.10 32 bit and 64 bit  
Removed support for SLED  
Removed support for Ubuntu 12.04.04 and 14.04, 32 bit and 64 bit  
Changed supported controllers  
Removed RAID5 from Table 6 and Table 8  
Updated steps for BIOS and UEFI boot platforms |
| November 2013  | 3.00     | Initial Public release |
Preface

This user guide:

- Describes how to configure RAID mode on AMD platforms.
- Provides information about arrays, disks, and RAID levels (RAID types).
- Describes how to improve storage system performance or reliability by understanding array and disk tasks and options.
- Describes how to acquire and load RAIDXpert2 drivers for Windows®, Windows 7 32-bit, Windows 7 64-bit, Windows 10 64-bit and later operating systems and Linux® operating systems.
- Describes the features and procedures for using RAIDXpert2, which is the RAIDXpert2 GUI.

Intended Audience

This user guide is intended for use by system administrators and technicians who are experienced with the following:

- Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached Storage (NAS) operators
- Network administration
- Network installation
- Storage system installation and configuration

Prerequisites

Prerequisites for installing and configuring this product include familiarity with:

- Servers and computer networks
- RAID and input/output signal technology (such as SCSI, SATA, or NVMe)
- Fibre Channel and Ethernet protocols
Document Conventions and Symbols

Table 1. Document Convention

<table>
<thead>
<tr>
<th>Convention</th>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navy blue, underlined text</td>
<td>Web site addresses</td>
</tr>
<tr>
<td>(<a href="http://www.example.com">http://www.example.com</a>)</td>
<td></td>
</tr>
<tr>
<td>Bold font</td>
<td>Key names</td>
</tr>
<tr>
<td></td>
<td>Text typed into a GUI element, such as into a box</td>
</tr>
<tr>
<td></td>
<td>GUI elements that are clicked or selected, such as menu and list items,</td>
</tr>
<tr>
<td></td>
<td>buttons, and check boxes</td>
</tr>
<tr>
<td>Italics font</td>
<td>Text emphasis</td>
</tr>
<tr>
<td>Monospace font</td>
<td>File and directory names</td>
</tr>
<tr>
<td></td>
<td>System output</td>
</tr>
<tr>
<td></td>
<td>Code</td>
</tr>
<tr>
<td></td>
<td>Text typed at the command line</td>
</tr>
<tr>
<td>Monospace, Italic font</td>
<td>Code variables</td>
</tr>
<tr>
<td></td>
<td>Command line variables</td>
</tr>
<tr>
<td>Monospace, bold font</td>
<td>Emphasis of file and directory names, system output, code, and</td>
</tr>
<tr>
<td></td>
<td>text typed at the command line</td>
</tr>
</tbody>
</table>

Customer Support

For customer support, contact your system supplier or motherboard vendor.

Glossary

Table 2. Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>rcadm</td>
<td>A command line interface (CLI) tool for managing RAID controllers on Linux®, on Windows®, and UEFI operating systems. It is used for creating, transforming, and deleting arrays; and adding and removing disks.</td>
</tr>
<tr>
<td>Legacy disk</td>
<td>Legacy disks include new or unrecognized disks which may contain data or even an operating system. Legacy disks appear in the BIOS Configuration Utility and in RAIDXpert2 as legacy arrays. When the legacy disk is initialized, configuration data is written to the disk. The legacy array then becomes an online disk usable in arrays. CAUTION: A legacy disk can contain valid data. When a legacy disk is initialized, all data on the disk is lost.</td>
</tr>
<tr>
<td>Linux®</td>
<td>Free, open-source UNIX-based operating system.</td>
</tr>
</tbody>
</table>
Chapter 1  Safety Precautions

1.1  General

This section includes general safety precautions and specific RAIDXpert2 cautions. Read and keep this user manual for future reference.

1.2  Safety Definitions

CAUTION: Indicates that failure to follow directions could result in damage to equipment or data.

IMPORTANT: Provides clarifying information or specific instructions.

Note: Provides additional information.

TIP: Provides helpful hints and shortcuts.

1.3  Caution Messages

This section lists the Caution messages that appear in the book.

1.3.1  Caution Messages About Disks

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the disk for the fail-over to complete, or assign a different disk with enough space. If a dedicated spare is assigned and a disk fails, the restore process starts automatically, if there is enough space available on the dedicated spare.

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted during initialization so ensure the correct disks are chosen to initialize.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its corresponding legacy disk is initialized, the data is lost.

CAUTION: When a disk is initialized, all data on the disk is lost.

1.3.2  Caution Messages about Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.
CAUTION: Do not delete the first array listed in the Arrays section, if it is the AMD-RAID bootable array. Doing this deletes the operating system and AMD-RAID files.

CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant array deletes the array and its data. The array no longer appears in Array View. This is especially true for a non-redundant bootable array. Initializing a disk in a non-redundant bootable array causes the array to Fail and deletes the operating system, AMD-RAID files, and device drivers.

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being corrupted if the system experiences a power interruption or unexpected shutdown.

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array (Linux®).

CAUTION: All data contained in a AMD-RAID array are lost if the RAIDXpert2 disks of the array are migrated to a non-AMD-RAID system.

CAUTION: When an array is securely erased, the data on the array is lost. The array remains hidden after the secure erase completes. User must Un-hide the array for data operations.

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported.

CAUTION: If the user creates an Array with Skip Initialization, the array will not be redundant.

CAUTION: Controller support for Socket SP3 compatible processors are as follows:
- 8-NVMe + 2-SoC + 1-PT when set to RAID in the BIOS
- 10-NVMe when SoC and PT are Disabled in the BIOS
- 10-NVMe + 1-PT when SoC is Disabled in the BIOS
- 9-NVMe + 2-SoC when PT is Disabled in the BIOS

CAUTION: Hot-Swapping is not recommended for disks that are part of AMD-RAID array.

CAUTION: Socket SP3 compatible processors support a maximum of 14 SATA ports on the system depending on customer platform design (8 from PT SATA controller, 6 from AMD SATA controller including devices connected to M.2 port).

CAUTION: Maximum number of disks (both NVMe and SATA) that can be used for Creating/Transforming a Volume, RAID-0 and RAID-10 arrays is eight. For RAID-1 only two disks are supported.

CAUTION: RAID on AMD SP3 compatible processor platform M.2 port supports both AMD SATA controller and PCIe M.2 NVMe. At any given time, each M.2 port can support either M.2 SATA or M.2 NVMe, but not both.
**CAUTION:** Individual disks which are not part of a RAID array will not be listed in Device Manager under the Disk Drive section. Individual Disks can be managed through RAIDXpert2 web utility, HII and the EFI shell.
Chapter 2  Getting Started

2.1  RAIDXpert2 Technology

RAIDXpert2 consists of (a) storage management and (b) a RAID controller and port virtualization. RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports, PCIe M.2 slots and PCIe NVMe Addin cards.

2.2  Who Should Use This Manual

Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its features and capabilities.

All unit operators must be familiar with system hardware, data storage, RAID technology, input/output signal technology (such as NVMe, SCSI, SAS, or SATA), and Direct Attached Storage (DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts and technology.

The intended user audience of this user manual is system administrators and experienced users.

2.3  System Requirements for Using RAIDXpert2

Make sure the systems that use RAIDXpert2 meet the requirements indicated in Table 3.

Table 3. System Requirements for RAIDXpert2

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Memory (RAM)       | Minimum: 4 GB, 8 GB for AMD Ryzen® processors and AMD Family 17h Models 60h-6Fh processors  
                    | Recommended: 8 GB, 16 GB for AMD Ryzen processors                             |
| Storage Devices    | 1–14 SATA or SSD drives or M.2 SATA drives or NVMe M.2 HHHL. The number of disks depends on the number, type, and capacity of the arrays to be created. |
2.3.1 Supported Processors and Chipsets

The following processors are supported by the current release of RAIDXpert2:

Table 4. Supported Processors and Chipsets

<table>
<thead>
<tr>
<th>Supported Processors &amp; Chipsets</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported AMD Processors</td>
<td>AMD Ryzen™ Desktop Processor</td>
</tr>
<tr>
<td></td>
<td>AMD Ryzen™ Threadripper™ Processor</td>
</tr>
<tr>
<td></td>
<td>AMD Ryzen™ Desktop Processor with Radeon™ Vega Graphics</td>
</tr>
<tr>
<td></td>
<td>AMD Family 17h Models 60h-6Fh processors</td>
</tr>
<tr>
<td>Supported AMD Chipsets</td>
<td>AMD X370 Chipset</td>
</tr>
<tr>
<td></td>
<td>AMD B350 Chipset</td>
</tr>
<tr>
<td></td>
<td>AMD X399 Chipset</td>
</tr>
</tbody>
</table>

2.3.2 Supported Operating Systems

RAIDXpert2 supports the following operating systems:

RC-9.2 x release:
- Microsoft® Windows® 10—64 bit.

RC-8.1 x Release:
- Microsoft Windows 10—32 bit and 64 bit
- Red Hat Enterprise Linux® (RHEL) 7.3—64 bit
- Ubuntu Desktop Linux 16.04—32 bit and 64 bit
2.4 Features of RAIDXpert2

The features of RAIDXpert2 described in this user manual apply to all license levels and supported operating systems.

Table 5 describes these features. Also see Table 6, on page 22, for a summary of features that are available with the RAIDXpert2 Basic license.

<table>
<thead>
<tr>
<th>RAIDXpert2 Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrays (general information)</td>
<td>RAIDXpert2 allows:</td>
</tr>
<tr>
<td></td>
<td>• An array refers to data storage created by RAIDXpert2 from one or more disks. Although an array can be created from several disks, it is seen by the operating system as a single disk.</td>
</tr>
<tr>
<td></td>
<td>• Creating arrays of different RAID levels using the same disks.</td>
</tr>
<tr>
<td></td>
<td>• Creating different RAID level arrays on the same disk, to adapt each array to the I/O that it processes.</td>
</tr>
<tr>
<td></td>
<td>• Creating an array from a mix of different type disks. For example, a RAID10 array can be created from a group of disks that contain two SATA II HDDs and two SATA SSDs or only on NVMe or group of SATA and NVMe disks.</td>
</tr>
<tr>
<td></td>
<td>• Migrating an existing array to another RAID level, if the type of array being used is not the optimal type for the application. This function depends on the array capacity, redundancy level, RAIDXpert2 license level and capacity of the drive or free space available.</td>
</tr>
<tr>
<td>Array Hiding</td>
<td>An array can be hidden from the operating system so that neither the software nor users can see or access it.</td>
</tr>
<tr>
<td>Array Recovery</td>
<td>If a redundant array is accidentally deleted, it might be recovered by creating a new array with the same properties as the deleted array. (This can occur only if disk Write Access operations are not in-progress.)</td>
</tr>
<tr>
<td>Background Array Initialization (BGI)</td>
<td>The background initialization of a redundant array creates the redundant data that allows the array to survive a disk failure.</td>
</tr>
<tr>
<td></td>
<td>Background initialization allows a redundant array to be used immediately. Data is not lost if a disk goes offline prior to completion of the BGI process.</td>
</tr>
<tr>
<td>Cache Support for Arrays</td>
<td>Various array-caching options are supported: No Cache, Read Ahead Cache, Write Back Cache, Read Ahead and Write Back Cache.</td>
</tr>
</tbody>
</table>
### Table 5. Features of RAIDXpert2 (Continued)

<table>
<thead>
<tr>
<th>RAIDXpert2 Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Cache Support for Disks             | Various disk-caching options are supported: No Cache, Read Ahead Cache, Write Back Cache, Read Ahead and Write Back Cache.  
  **Note:** By default, NVMe Physical disk Read Ahead and Write Back cache are always disabled. User cannot enable the setting as it may impact the operational performance of the NVMe disk.                                                                                                                                                                                                                                                                                                                                 |
| Secure Erase                       | All data on an array can be erased and ensured it is unrecoverable, even with advanced data recovery techniques.                                                                                                                                                                                                                                                                                                                                                       |
| Consistency Check                  | A Consistency Check is a background operation that verifies and corrects the mirror or parity data for fault-tolerant disks. It is recommended that a Consistency Check be run periodically on an array.                                                                                                                                                                                                                                                            |
| Disk Roaming                       | With disk roaming, SATA cables can be disconnected from their disks and shuffled without confusing RAIDXpert2.  
  **Note:** Disconnect the SATA cables from the disks only when the system is shutdown.  
  Disk roaming also allows:  
  - Disks to be moved to different slots in the backplane. RAIDXpert2 detects which disks belong to which arrays, regardless of where the disks are moved in the backplane.  
  - Disk(s) to be moved between systems.  
  **Note:** It might not be possible to move disks between systems if they contain boot arrays.                                                                                                                                                                                                                                                                            |
| Fault Tolerance                    | The following fault tolerance features are available with RAIDXpert2, in order to prevent data loss in case of a failed disk.  
  - Disk failure detection (automatic).  
  - Array rebuild using hot spares (automatic, if the hot spare is configured for this functionality).  
  - Hot-swap manual replacement of a disk without rebooting the system (available only for systems with a backplane that supports hot-swapping) is not recommend for disks that are part of the Boot Virtual Disk or are connected to the AMD RAID supported chipsets. This applies to all chipsets.  
  For example if a disk fails in a RAID1, the array remains functional and data is read from the surviving mirrored disk.                                                                                                                                                                                                 |
| Mirror Rebuilding                  | A broken mirrored array can be rebuilt after a new disk is inserted and the disk is designated as a spare. The system does not have to be rebooted.                                                                                                                                                                                                                                                                 |
| Multiple RAID Levels per Disk       | Support for multiple array levels per disk allows the administrator to create arrays of different RAID levels using the same disks.                                                                                                                                                                                                                                                                               |
Table 5. Features of RAIDXpert2 (Continued)

<table>
<thead>
<tr>
<th>RAIDXpert2 Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Native Command Queuing (NCQ)</td>
<td>Native Command Queuing is a command protocol of disks that are supported by RAIDXpert2. NCQ enables individual disks to internally optimize the order in which Read and Write commands are executed. RAIDXpert2 permits a queue depth of up to 32 read/write commands per disk.</td>
</tr>
<tr>
<td>Online Capacity Expansion (OCE)</td>
<td>OCE is a process that allows the user to add storage capacity to an existing array, without taking the system offline. OCE enables the user to increase the total storage capacity of an array by integrating unused storage into the array. Data can be accessed while the disks are added and while data on the array is being redistributed.</td>
</tr>
<tr>
<td>Online RAID Level Migration (ORLM)</td>
<td>With online RAID level migration, users can easily move an array from one RAID level to another. While the migration is taking place, data is accessible and protected to the lowest protection of either the source RAID level or the destination RAID level.</td>
</tr>
<tr>
<td>RAID Level Support</td>
<td>RAIDXpert2 supports RAID levels 0, 1, 10, Volume, and RAIDABLE.</td>
</tr>
<tr>
<td>Self-Monitoring Analysis and Reporting Technology (SMART)</td>
<td>SMART is a hard-disk-drive (HDD) capability which allows reporting of reliability information. If a drive anticipates there is a high likelihood of future failure it triggers a SMART error condition. RAIDXpert2 presents this error condition so the drive can be replaced before the predicted failure occurs.</td>
</tr>
</tbody>
</table>

2.5 RAIDXpert2 Feature Set

Table 6. Feature Set for RAIDXpert2: Basic License Level

<table>
<thead>
<tr>
<th>Features</th>
<th>Sub-Features</th>
<th>RAIDXpert2 Basic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option ROM (BIOS) Support¹</td>
<td>Create array</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Delete array</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Boot/INT13 control</td>
<td>Yes</td>
</tr>
<tr>
<td>UEFI Driver (BIOS) Support</td>
<td>Create array</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Delete array</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Raidxpert2 Configuration utility (HII)¹</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>efi Shell utility</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 6. Feature Set for RAIDXpert2: Basic License Level (Continued)

<table>
<thead>
<tr>
<th>Features</th>
<th>Sub-Features</th>
<th>License Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Levels Supported²</td>
<td>0</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>RAIDABLE</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Volume</td>
<td>Yes</td>
</tr>
<tr>
<td>Array Creation</td>
<td>No initialization</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Foreground initialization</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Background array scan</td>
<td>Yes</td>
</tr>
<tr>
<td>Array Deletion</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Array Transformation</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Sparing</td>
<td>Global</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Dedicated</td>
<td>Yes</td>
</tr>
<tr>
<td>Consistency Check</td>
<td>Background redundancy check</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Scheduled</td>
<td>Yes</td>
</tr>
<tr>
<td>Online Capacity Expansion (OCE)³</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Online RAID Level Migration (ORLM)</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Drive/Disk Roaming⁴</td>
<td>Same-system support</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Between-systems support</td>
<td>Yes</td>
</tr>
<tr>
<td>RAIDXpert2 Web GUI (Management GUI)</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>rcadm (management CLI)</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 6. Feature Set for RAIDXpert2: Basic License Level (Continued)

<table>
<thead>
<tr>
<th>Features</th>
<th>Sub-Features</th>
<th>RAIDXpert2 Basic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Interfaces Supported⁵</td>
<td>SATA</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>SSD</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>ATAPI</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>M.2 SATA SSD</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>M.2 NVMe SSD</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>HHHL NVMe SSD</td>
<td>Yes</td>
</tr>
<tr>
<td>Dissimilar Disk Support Within The Same Array</td>
<td>No Cache</td>
<td>Yes</td>
</tr>
<tr>
<td>Cache Support</td>
<td>Read Ahead Cache</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Write Back Cache</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Read Ahead and Write Back Cache</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Array and Delete Array Functions Without Rebooting</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Restore (Rebuild) Priority</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Multiple RAID Levels per Disk⁶</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Touched Region Logging⁷</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>System Event Log Integration</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Instant Create Support⁸</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Hot-Swap Support</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
Notes:

1. At the AMD BIOS Page, arrays can be created or deleted with AMD BIOS Configuration Utility (HII) or Option ROM. Option ROM support is available only with the RC-8.1 release. Array or physical disk information can be displayed, assign Global or Dedicated spares and Critical or Offline arrays are indicated. INT13 support can be turned off completely at the BIOS Configuration Utility. NVMe is not supported by the Option ROM.

2. See Chapter 3, Understanding Arrays, Disks and RAID Levels, on page 26, for detailed information about understanding arrays, RAID levels, and performance and reliability considerations.

3. The unique ability of RAIDXpert2 to provide online expansion to RAID levels across multiple disks becomes extremely valuable when expanded storage is a requirement.

4. Disk roaming allows arrays to be moved from port to port, either within the same system or between systems.

5. See the system’s motherboard specifications for the supported device interface. RC-8.1 and RC-8.2 branches support only SATA. RC-9.1 and above release branches support SATA, M.2 NVMe SSD and HHHL NVMe SSD

6. Multiple RAID levels (array types) per disk allows the administrator to create different RAID levels on the same disks. For example: The administrator wants data redundancy for the user data, and creates a RAID1 set using part of the disks’ data. At the same time the administrator wants performance for the swap spaces, and creates a RAID0 array using the rest of the disks’ capacities (space). This feature is useful in collecting unused capacity from disks with different capacities. This feature increases data integrity for redundant array types, by logging areas of an array that have been written to. In the event of a system crash, the logged area’s consistency is checked and/or corrected. Without this feature, data corruption might occur.

7. Arrays can be instantly created and used by skipping the background consistency check. For certain types of redundant arrays this is a viable option and has no data integrity drawbacks. A consistency check can always be done at a later time. If an initialization is skipped when creating a RAID1, the array is not redundant until a consistency check is performed.

8. It is not recommended to add a Disk to the system and to the array while the system is operating.
Chapter 3  Understanding Arrays, Disks and RAID Levels

3.1  Understanding Arrays

Arrays are several disks that are grouped together to improve either the performance or reliability of a storage system. Because some RAID levels enhance performance while others improve reliability, it is important to consider the user’s needs when planning an array configuration.

Note: It is highly recommended that this user manual be reviewed in its entirety before configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options) must be understood by the user before creating arrays.

3.2  RAID Levels

RAIDXpert2 supports the RAID levels indicated in Table 7.

Table 7. RAID Levels – General Characteristics

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Main Characteristic</th>
<th>Use/Usefulness</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID0 (Striping)</td>
<td>• Provides the highest performance but no data redundancy. Data in the array is</td>
<td>RAID0 arrays are useful for holding information, such as the operating system</td>
</tr>
<tr>
<td></td>
<td>striped (distributed) across several disks.</td>
<td>paging file, where performance is extremely important but redundancy is not.</td>
</tr>
<tr>
<td></td>
<td>• Supports 2-8 disks.</td>
<td></td>
</tr>
<tr>
<td>RAID1 (Mirroring)</td>
<td>• Mirrors data on a partition of one disk to another.</td>
<td>Useful when there are only two disks available and data integrity is more</td>
</tr>
<tr>
<td></td>
<td>• Supports 2 disks.</td>
<td>important than storage capacity.</td>
</tr>
<tr>
<td>RAID10 (Striped RAID1 Sets)</td>
<td>• Combines mirrors and stripe sets. RAIDX10 allows multiple disk failures, up to 1</td>
<td>Offers better performance than a simple mirror because of the extra disks.</td>
</tr>
<tr>
<td></td>
<td>failure in each mirror that has been striped.</td>
<td>Requires twice the disk space of RAID1 to offer redundancy.</td>
</tr>
<tr>
<td></td>
<td>• Supports 4, 6, or 8 disks.</td>
<td></td>
</tr>
</tbody>
</table>
Table 7. RAID Levels – General Characteristics (Continued)

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Main Characteristic</th>
<th>Use/Usefulness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume (JBOD)</td>
<td>• RAIDXpert2 treats one or more disks or the unused space on a disk as a single array.</td>
<td>Provides the ability to link-together storage from one or several disks, regardless of the size of the space on those disks. Useful in scavenging space on disks unused by other disks in the array. Does not provide performance benefits or data redundancy. Disk failure will result in data loss.</td>
</tr>
<tr>
<td>RAIDABLE (also known as RAID Ready)</td>
<td>• Allows a RAIDABLE disk to be transformed later to RAID0 or RAID1.</td>
<td>See RAID0 (Striping), on page 26 or RAID1 (Mirroring) on page 26 for post-transformation usefulness.</td>
</tr>
<tr>
<td></td>
<td>• Supports one disk.</td>
<td></td>
</tr>
</tbody>
</table>

3.3 Array States

Within the management applications, an array is a logical device that can exist in one of four states: Normal, Ready, Critical, or Offline.

- In RAIDXpert2, these states display in the Array List section in a column named State.
- Within the rcdm Command Line interface, these states also display in a column named State.

The array states are defined in Table 8, on page 28.
### Table 8. Array States

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>The Normal state is displayed when everything is functioning correctly.</td>
</tr>
<tr>
<td>Ready</td>
<td>The Ready state is displayed while an array is being created.</td>
</tr>
<tr>
<td>Critical</td>
<td>The Critical state is displayed when the array is no longer redundant (fault tolerant) because of one or more disk failures. Arrays can still be read and written to, but the data is no longer protected should another disk fail.</td>
</tr>
<tr>
<td>Offline</td>
<td>The Offline state is displayed when arrays cannot be read or written to because of one or more disk failures.</td>
</tr>
</tbody>
</table>

Whether an array is marked as Critical or Offline depends upon what RAID level it is and how many disks within the array have failed. Note the changes in state in Table 9.

### Table 9. Failure States by RAID Level

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>This Failure State</th>
<th>Is Displayed Whenever</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID1 (Redundant Arrays)</td>
<td>Critical</td>
<td>A single disk fails.</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td>Two disks fail.</td>
</tr>
<tr>
<td>RAID10 (RAID Levels with Multiple Redundancies)</td>
<td>Critical</td>
<td>A single disk fails in any one of the sets.</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td>All the disks in a set fail.</td>
</tr>
<tr>
<td>Volume, RAIDABLE and RAID0</td>
<td>Offline</td>
<td>A single disk fails.</td>
</tr>
</tbody>
</table>

More than one array can be created using the same set of disks. If a disk is disconnected that belongs to more than one array, only the arrays that try to access the disk and receive I/O errors report the failure. For example: there are two arrays, both of which are RAID1 sets, and both use disk 4. If a system that is being used by array 1 receives an I/O error when trying to communicate with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does not change to Critical until an I/O error is reported. If systems using array 1 are not communicating with failed disk 4, the state of array 1 still displays as Normal.

If a rescan of all channels is performed after disconnecting a disk, the state of every array using the missing disk changes from Normal to either the Critical or Offline, depending on the RAID level.
See Section 3.9, Rescanning Disks for Changes in State, on page 32 for a discussion of when to recscans disks and the outcomes when doing so.

### 3.4 Creating Arrays: Future Expansion

When creating arrays, consider whether disk capacity needs to expand in the future. If the file system must be expanded, perform the tasks indicated in Table 8.

#### Table 10. Array Expansion Considerations

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Do This...</th>
<th>And Consider This...</th>
</tr>
</thead>
</table>
| Microsoft® Windows®    | Format the arrays with NTFS. Microsoft Corporation provides a utility (Diskpart.exe) that can dynamically extend an NTFS file system onto any unused adjacent space. Note also that using a single partition per array makes expansion much easier. | 1. The Diskpart.exe utility version depends on which version of the Windows operating system is running.  
2. The Diskpart.exe utility can be found on the CD for some versions of Windows operating systems, or on the Microsoft Corporation website ([http://www.microsoft.com](http://www.microsoft.com)) for other versions. Use the correct version for the operating system. |
| Linux®                 | Use an expandable file system.                                             | Because RAIDXpert2 software is limited to eight arrays, if a large number of logical volumes are needed, use a logical volume manager (LVM). |

### 3.5 Expanding Disk Capacity Online: Using OCE

Online Capacity Expansion (OCE) allows:

- Adding disks to an array at any time to increase an array’s capacity.
- Accessing the array data while it is being redistributed.

To increase the size and organization of an array, transform the array. For more information about transforming arrays, see Section 9.6.3, Transform Arrays on page 100.

### 3.6 Migrating RAID Levels Online: Using ORLM

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost any other RAID level. This task includes migrating the array from a non-redundant RAID level to a redundant RAID level.
Prior to starting a RAID level migration/transformation, make sure that the disks selected for the destination array have sufficient capacity. RAID level migration/transformation can occur only when the destination array has the same or larger capacity as the source array.

While the migration/transformation is taking place, data is accessible and protected to the lowest protection of either the source RAID level or the destination RAID level.

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also be used as part of the system backup and recovery strategy through the use of the RAID1 and RAID10 levels.

To perform this process, see Section 9.6.3, Transform Arrays on page 100.

### 3.7 Array Tasks: Starting and Stopping Tasks

Tasks are started when one of the following actions are performed:

- Create a redundant array.
- Transform an array.
- Restore an array.
- Securely erase an array.
- Check for consistency on redundant arrays.
- Verify that data was not corrupted after a system crash (Check_Bitmap performed automatically).

Full task control can be used on Create, Consistency Check and Bitmap Check tasks. On a Transform or Restore task for dedicated and global spares, task control can only pause/resume, but it cannot remove the task. To remove these types of tasks, pause and then remove them.

The tasks indicated in Table 11 on page 31, can be displayed for each array.
### Table 11. Types of Tasks per Array

<table>
<thead>
<tr>
<th>Task</th>
<th>When Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transform</td>
<td>While an array is being transformed.</td>
</tr>
<tr>
<td>Create</td>
<td>While an array is being created.</td>
</tr>
<tr>
<td>Consistency Check</td>
<td>While verifying the mirror disk (RAID1 or RAID10) consistency is correct. (For redundant type arrays only.)</td>
</tr>
<tr>
<td>Restore</td>
<td>While an array is being restored.</td>
</tr>
<tr>
<td>Secure Erase</td>
<td>While an array secure erase is being performed.</td>
</tr>
<tr>
<td>Check_Bitmap</td>
<td>While verifying that the mirror halves on a RAID1 or RAID10 set, are consistent. This action is performed automatically to ensure that data is not corrupted whenever a system crashes.</td>
</tr>
<tr>
<td>Not_Active</td>
<td>When no other tasks are being performed.</td>
</tr>
</tbody>
</table>

### 3.8 Understanding Disks

#### 3.8.1 Disks States

Within the management applications, a disk can be part of one or more arrays and can exist in one of five states: Online, Offline, New, Legacy, or SMART Error.

- In RAIDXpert2, these states are displayed in the Disk List section in a column named State. See Table 20, on page 90, for additional information.
- Within the rcadm command line interface, these states are also displayed in a column named State. See Table 33, on page 116, and Table 34, on page 117, for additional information.

The disk states are defined in Table 12.

### Table 12. Disk States

<table>
<thead>
<tr>
<th>Disk State</th>
<th>When Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>Whenever the disk is connected, functioning correctly, and RAIDXpert2 can communicate with it.</td>
</tr>
</tbody>
</table>
A disk can be a member of multiple arrays. A disk failure in one array doesn't necessarily mean it has failed in other arrays.

After a rescan is performed the following can occur:

- A disconnected disk no longer appears in the Disk List (although the disk appears as Missing in the Array View for the arrays to which it belonged).
- A disk that experiences a catastrophic failure appears in the Disk List as Offline and is highlighted in red. The disk appears as Failed for the arrays to which it belonged.
- A disk that has a SMART error appears in the Disk List as SMART Error. (A disk with a SMART error can’t be used to create an array)
- A disk that experiences a software-related failure appears in the Disk List as Online and is highlighted in red. New arrays can be created with the disk.

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing until the system attempts to communicate with the failed or disconnected disk.

### 3.9 Rescanning Disks for Changes in State

The information displayed in the Disk List section is the state of the disks when they were last scanned. If a rescan has not been performed, the information being displayed is the state of the disks at boot time.

Every time a disk is connected or disconnected while online, a message asks if the user wants to perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array List and the Disk List is updated. This view might show arrays as being in a Critical or Offline state, if all disks have not been installed or removed.

Although it is highly recommended that the system be shut down before adding or removing disks, disks can be added or removed while the system is online (“hot-swapping”), if the system supports the hot-swapping function. This is not recommended for disks that are part of the Boot Virtual Disk or those that are connected to the AMD RAID supported chipsets.
Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects that a disk has been added or removed. For example, to hot-swap a RAID1 set with two disks into a new system, do not perform a rescan until both disks have been connected.

Arrays associated with the disks that are not yet connected change state to either Critical or Offline. In the example above, if the state of the RAID1 set changes to Offline, data is unavailable.

Rescanning can also result in the state of a disk being reported differently in the Array View and the Disk List. A disk within an array can have a state of Failed in the Array View field, while at the same time it can show a state of Online in the Disk List.

### 3.10 Sparing Options: Disks and Arrays

RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in Table 13.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dedicated</td>
<td>A spare disk assigned to a specific redundant array.</td>
</tr>
<tr>
<td>Global</td>
<td>A spare disk that is shared by multiple arrays.</td>
</tr>
</tbody>
</table>

Note: An array is marked Critical or Offline if a disk reports a Failed state to an I/O, or if the Disk, SATA cable, or power cable is disconnected.

Note: One or more spares can be assigned to a redundant RAID level.

Note: Spare assignments do not apply to non-redundant RAID levels. To protect data, transform the array to a redundant RAID level. Spares can then be assigned.

### 3.11 Dedicated Sparing

A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.

A dedicated spare can be assigned to any redundant array type, and up to four spares can be assigned to an array.

Note: Disk capacity of the Dedicated Spare must be greater or equal to the capacity of the smallest disk in the array.

**CAUTION:** Assigning a dedicated spare does not reserve space on the disk. Therefore, an automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the disk for the fail-over to complete, or assign a different disk with enough space. If a
If there is not enough disk space on the global spare, make room for the fail-over to complete, or assign a different disk with enough capacity as the spare. If there is enough space available on the global spare and a disk failure occurs, the restore process starts automatically.

For additional information, see Section 9.6.14, Add or Remove Global Spares, on page 109.

3.13 RAID Performance Considerations

With RAID technology, performance is based on the following considerations:

- The number and organization of disks in an array.
- Caching attributes used for the array.
- Application workload.

3.13.1 Number and Organization of Disks

RAID functions increase performance by putting more disks to work and by buffering data for the host.

Many disks can transfer data at greater than 100 MB per second. RAIDXpert2 can aggregate this bandwidth in an almost linear fashion, as more of the same disks are included in an array.

3.13.2 Caching Attributes

Arrays can also be configured to provide Read and Write Back cache, Write Back cache, Read Ahead cache and No cache option with RAIDXpert2 configuration utility and WebGUI utility, if desired. Write Back caching has a large effect on most workloads, but should be used with caution.
3.13.3 Application Workload

When configuring an array, workload is probably the most important performance variable. Most applications do many more reads than writes. The best performance is obtained with array types like RAID0 or RAID10.

3.14 RAID Reliability Considerations

RAID reliability is enhanced through data redundancy and backup.

3.14.1 Data Redundancy

RAID1 or RAID10 are necessary for redundancy. With redundancy, both capacity and performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is obtained even with redundant-type arrays.

3.14.2 Backup

It is good practice to back up your data periodically in case of a catastrophic failure. Tape backup or other media can be used to secure your data.

3.15 Flexibility and Expansion Considerations

Before configuring an array, consider the following points to enhance the flexibility of the RAID system.

3.16 Multiple RAID Levels

With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to the I/O that it processes. Also, more than one array can be created per disk.

Depending on the array capacity and redundancy level, an existing array can be transformed to another RAID level, if the level of the array being used is not the optimal RAID level for the application. Also, different arrays with different characteristics can be built for different applications.
Chapter 4  Platform RAID Enablement Prerequisites

This chapter assists to configure and enable RAID mode in Platform BIOS for the listed AMD products in Table 4 on page 19.

Note: Prior to starting the below procedure, Platform should be programmed with RAID Supported BIOS. Obtain the BIOS from your system supplier or motherboard vendor.

4.1 Platform BIOS Settings - Enable RAID for the AMD SP3-Series Chipsets

Note: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS based off the AMI BIOS.

1. Power-on the system.
2. Press Delete or ESC to enter the System BIOS setup page.
3. In the BIOS setup:
   a. Select the Advanced tab, then press Enter.
   b. Select the AMD PBS tab, then press Enter.
   c. Set NVMe RAID Mode to Enabled.
4. In the BIOS setup:
   a. Select the Advanced tab, then press Enter.
   b. Select the AMD CBS tab, then press Enter.
   c. Select FCH Common Options, then press Enter.
   d. Select SATA Configuration Options, then press Enter.
   e. Set SATA Controller to Enabled.
5. In the BIOS setup:
   a. Select the Advanced tab, then press Enter.
   b. Select the AMD CBS tab, then press Enter.
   c. Select FCH Common Options, then press Enter.
   d. Select SATA Configuration Options, then press Enter.
   e. Set SATA Mode to RAID.
6. In the BIOS setup:
   a. Select the Advanced tab, then press Enter.
   b. Select Promontory Common Options, then press Enter.
   c. Select PT SATA Configuration Options, then press Enter.
   d. Set PT SATA Port Enable to Enabled.
7. In the BIOS setup:
   a. Select the **Advanced** tab, then press **Enter**
   b. Select **Promontory Common Options**, then press **Enter**
   c. Select **PT SATA Configuration Options**, then press **Enter**
   d. Set **PT SATA Mode** to **RAID**.

8. In the BIOS setup:
   a. Select the **Advanced** tab, then press **Enter**
   b. Select **CSM Configuration**, then press **Enter**
   c. Set **CSM Support** to **Enabled**

9. In the BIOS setup:
   a. Select the **Advanced** tab, then press **Enter**
   b. Select **CSM Configuration**, then press **Enter**
   c. Set **Boot Option Filter** to **UEFI Only**

10. In the BIOS setup:
    a. Select the **Advanced** tab, then press **Enter**
    b. Select **CSM Configuration**, then press **Enter**
    c. Set **Storage -> UEFI**

11. Save (F4) the setting and restart the system.
12. To proceed with RAID array creation, Refer to Section 5.5.2, Create an Array, on page 41.

### 4.2 Platform BIOS Settings – Enable RAID for the AMD Socket AM4- Compatible Processors

*Note: The steps to configure a system to RAID mentioned here are specific to AMD NDA BIOS based off the Insysde BIOS.*

1. Power-on the system
2. Press ESC to enter the **System BIOS** setup page
3. Select **Setup Utility**, then press **Enter**
4. In the BIOS setup:
   a. Select the **Advanced** tab
   b. Select **IDE Configuration**, then press **Enter**
   c. Set **SATA Configure** as to **RAID**, then press **Enter**
   d. Set **Force RAID Mode** to **Enabled**, then press **Enter**
5. In the BIOS setup:
   a. Select the **Boot** tab
   b. Set **Boot Type to UEFI Boot Type** or **Dual Boot Type**, then press **Enter**
   c. Set **EFI Device First** to **Enable**, then press **Enter**
6. In the BIOS setup:
Platform RAID Enablement Prerequisites

Chapter 4

38

a. Select the AMD-PBS tab
b. Set NVME RAID Mode to Enabled, then press Enter

7. In the BIOS setup:
   a. Select the AMD-CBS tab
   b. Select FCH Common Options, then press Enter
   c. Select SATA Configuration Options, then press Enter
   d. Set SATA Controller to Enabled, then press Enter
   e. Set SATA Mode to RAID, then press Enter

8. In the BIOS setup:
   a. Select the AMD-CBS tab
   b. Select Promontory Common Options, then press Enter
   c. Select PT SATA Configuration Options, then press Enter
   d. Set PT SATA Port Enable to Enabled, then press Enter
   e. Set PT SATA Mode to RAID, then press Enter

9. Save and restart.

10. To proceed with RAID array creation, Refer to Section 5.5.2, Create an Array, on page 41.
Chapter 5  
BIOS Configuration Utility  
(Option ROM)

Before you begin, enable platform RAID mode by referring to Chapter 4, Platform RAID Configuration Prerequisites.

5.1 When to Use the AMD-RAID Controller BIOS Configuration Utility

Note: For OPROM to get listed, set both AMD and PT SATA Controller to RAID.

Note: OPROM will not be visible when Boot mode is set to UEFI only.

Note: OPROM supports only SATA devices with RC-8.1 release

Note: OPROM is applicable only to AMD Ryzen™ Desktop Processor Products

The AMD-RAID Controller BIOS Configuration Utility is also known as the Option ROM. OPROM can be used to accomplish the below RAID functional procedures indicated in Table 14.

Table 14. When to use the AMD-RAID Controller BIOS Configuration Utility (Option ROM)

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Description</th>
<th>Find Information At</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize a new disk</td>
<td>To initialize a new disk drive for data storage.</td>
<td>Section 5.4, Initialize Disks, on page 40</td>
</tr>
<tr>
<td>Create or delete arrays</td>
<td>Create arrays at different RAID levels (depending on the license level for the system), or delete an array.</td>
<td>Section 5.5, Create Arrays, on page 41.</td>
</tr>
<tr>
<td>Swap arrays</td>
<td>Change the array order, especially for the AMD-RAID bootable array.</td>
<td>Section 5.5.5, Swap Arrays, on page 45.</td>
</tr>
<tr>
<td>Manage hot spares</td>
<td>Allows selection of global and dedicated hot spares.</td>
<td>Section 5.5.6, Manage Spares, on page 45</td>
</tr>
<tr>
<td>View disk and array details</td>
<td>View information about each disk or array.</td>
<td>Section 5.5.7, View Disk Details, on page 46</td>
</tr>
<tr>
<td>Rescan all channels</td>
<td>Rescan all channels to detect new or removed disks and arrays.</td>
<td>Section 5.5.8, View Array Details, on page 47</td>
</tr>
<tr>
<td>Change controller options</td>
<td>Change INT13 boot support, turn off Critical arrays or warning for Offline arrays while booting, or change the number of disks that can be spun-up when the system is powered-on.</td>
<td>Section 5.5.10, Change the Controller Options, on page 47</td>
</tr>
<tr>
<td>Continue to boot</td>
<td>Exit the BIOS Configuration Utility and continue booting the system.</td>
<td>Section 5.5.11, Continue Booting from the BIOS Configuration Utility, on page 48</td>
</tr>
</tbody>
</table>
5.2 Access the AMD-RAID Controller BIOS Configuration Utility (OPROM)

*Note:* OPROM can be accessed only when Boot mode is set to Dual boot type or Legacy boot type.

When booting the system, press **Ctrl + R** when the BIOS banner displays. There is a maximum of three seconds to use this key combination to enter the BIOS Configuration Utility.

*Note:* If the BIOS Configuration Utility does not display, contact your system or motherboard supplier.

5.3 Understanding the Color Code in the BIOS Configuration Utility

Color codes indicate the type or status of information at the BIOS Configuration Utility. See Table 15.

### Table 15. BIOS Configuration Utility Color Codes

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White text</td>
<td>Indicates an available option or informational text.</td>
</tr>
<tr>
<td>Black text, yellow highlighting</td>
<td>Indicates an option or device for which action might be taken.</td>
</tr>
<tr>
<td>Yellow text</td>
<td>Indicates information about the yellow-highlighted option.</td>
</tr>
<tr>
<td>Green text</td>
<td>Indicates an item that has been selected.</td>
</tr>
<tr>
<td>Light blue text</td>
<td>Indicates that the item cannot be selected.</td>
</tr>
<tr>
<td>Magenta text</td>
<td>Indicates items that are related to spares.</td>
</tr>
<tr>
<td>Red text</td>
<td>Indicates a failed virtual or physical disk or a warning. For example, informational text might be red if an option is not available.</td>
</tr>
</tbody>
</table>

5.4 Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD-RAID array.

Initialization writes AMD-RAID configuration information (metadata) to a disk.

5.4.1 Initialize Disks

*CAUTION:* If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted during initialization so ensure the correct disks are chosen to initialize.
CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, all data on the disk is lost.

1. At the Main Menu, use the arrow keys to highlight Initialize Disk(s).
2. Press Enter to select Initialize Disk(s).
3. Select the disks to initialize:
   - To select all disks, press the A key
   - To select individual disks, highlight a disk with the arrow keys and press Insert. Any number of disks may be selected using this method
4. Press Enter to initialize the selected disks or press ESC to cancel the initialization.

Initialization takes 10 to 15 seconds per disk. During initialization, a status indicator shows which disk is being initialized. When the initialization is complete, the status indicator turns off. A complete rescan of all channels is done automatically during initialization.

5.5 Create Arrays

Arrays can be created after the disks are initialized. See Section 3.2, RAID Levels, on page 26, for deciding what type of RAID levels to use for the array.

TIP: See also Section 9.6.1, Create and Format Arrays, on page 97, and Section 10.4, Create New Arrays: rcadm --create, on page 118.

5.5.1 Before You Begin

- In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported by AMD-RAID.
- For redundant arrays, the Create process starts after the operating system and AMD-RAID OS drivers have been installed and the system has booted to the operating system. However, the arrays are immediately available to use for either a bootable array or a data array.
- Array numbers are valid only for a given boot, and might be different in the BIOS Configuration Utility and RAIDXpert2. If a permanent label is required, use the Array Naming feature.
- At any point in the procedure, return to a prior window by pressing ESC.
- If the system is booted from an AMD-RAID bootable array, the first array in the Arrays section must be the bootable array. The system boots only from the first array in the Arrays section. As necessary, use the Swap Two Arrays feature to swap arrays and place the RAIDXpert2 bootable array in the first position.

5.5.2 Create an Array

1. At the Main Menu, use the arrow keys to highlight Create Array.
2. Press Enter.
3. Select the disks with which to create the array:
• To select all disks, press the A key
• To select individual disks, highlight a disk with the arrow keys and press Insert. Any number of disks may be selected using this method

4. Press Enter to include the selected disks in the array.

5. In the User Input section, use the arrow keys to select an array type. Only array types that can be created with the selected disks are available.

6. Press Enter.

7. Select an array size by doing the following:
   a. To create an array whose size is less than or equal to 2.199 TB:
      • Press the Page Up or the up arrow key to increase the array size and the Page Down or down arrow key to decrease the size.
      • Press Enter when the desired size is reached.
   b. To create an array whose size is greater than 2.199 TB:
      • Press the Page Up or the up arrow key to increase the array size.
      • Press Enter when the desired size of 2.199 TB is reached.
      Note: A message displays stating that a size greater than the maximum is being attempted, and whether the size of the array should be limited.
      • Press ESC to bypass the Page Up or the up arrow key to continue modifying the size.
      • Press Enter when either the desired size or the maximum available size is reached.

8. Select a caching level using the arrow keys then press Enter.

9. Press the C key to confirm the array settings or press ESC to go back to a previous page.

10. Repeat step 8 through step 11 to create additional arrays.

   Note: When installing the operating system to an AMD-RAID bootable array, modify the boot priority list in the motherboard BIOS. See the motherboard’s user documentation for more information. Ensure that the AMD-RAID bootable array is included in the boot priority list.

11. Ensure that INT13 support is enabled on the RAID controller, as described in Section 5.5.10, Change the Controller Options, on page 47.

5.5.3 Create an AMD-RAID Bootable Array

CAUTION: Do not use eSATA drives for bootable arrays as they are removable.

The operating system and RAIDXpert2 files can be installed to a RAIDXpert2 bootable array. Use the procedure in Section 5.5.2, Create an Array, on page 41, to create the bootable array. Ensure it is the first array listed in the Arrays section of the BIOS Configuration Utility.

To install the operating system and RAIDXpert2 files see Chapter 7, Software Installation, 59.
5.5.3.1 Create RAIDABLE Array

*Note:* Refer to Table 7 for RAIDABLE array characteristics.

1. At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.
2. Select the appropriate disk using Insert to create the RAIDABLE array level, then press Enter.
3. In the User Input section, use the arrow keys to select RAIDABLE, then press Enter.
4. In the Caching mode section, use the arrow keys to select the Cache setting for the array, then press Enter.
5. Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
6. RAIDABLE array listed in the Arrays section

5.5.3.2 Create Volume Array

*Note:* Refer to Table 7 for Volume array characteristics.

1. At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.
2. Select the appropriate number of disks using Insert to create the Volume array level, then press Enter.
3. In the User Input section, use the arrow keys to select Volume, then press Enter.
4. To set the Desired Array capacity, Use Page-UP or Page-Down key, then press Enter.
5. In the Caching mode section, use the arrow keys to select the Cache setting for the array, then press Enter.
6. Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
7. Volume array listed in the Arrays section

5.5.3.3 Create RAID0 Array

*Note:* Refer to Table 7 for RAID0 array characteristics.

1. At the Main Menu, use the arrow keys to highlight Create Array, then press Enter.
2. Select the appropriate number of disks using Insert to create the RAID0 array level, then press Enter.
3. In the User Input section, use the arrow keys to select Volume, then press Enter.
4. To set the Desired Array capacity, Use Page-UP or Page-Down key, then press Enter.
5. In the Caching mode section, use the arrow keys to select the Cache setting for the array, then press Enter.
6. Press the C key to confirm creation of array or press the ESC key to go back to a previous page.
7. RAID0 array listed in the Arrays section

5.5.3.4 Create RAID1 Array

*Note:* Refer to Table 7 for RAID1 array characteristics.
1. At the Main Menu, use the **arrow keys** to highlight **Create Array**, then press **Enter**.
2. Select the appropriate number of disks using **Insert** to create the **RAID1** array level, then press **Enter**.
3. In the User Input section, use the **arrow keys** to select **Volume**, then press **Enter**.
4. To set the Desired Array capacity, Use **Page-UP** or **Page-Down key**, then press **Enter**.
5. In the Caching mode section, use the **arrow keys** to select the Cache setting for the array, then press **Enter**.
6. Press the **C** key to confirm creation of array or press the **ESC** key to go back to a previous page.
7. **RAID1** array listed in the **Arrays** section

5.5.3.5 **Create RAID10 Array**

*Note: Refer to Table 7 for RAID10 array characteristics.*

1. At the Main Menu, use the **arrow keys** to highlight **Create Array**, then press **Enter**.
2. Select the appropriate number of disks using **Insert** to create the **RAID10** array level, then press **Enter**.
3. In the User Input section, use the **arrow keys** to select **Volume**, then press **Enter**.
4. To set the Desired Array capacity, Use **Page-UP** or **Page-Down key**, then press **Enter**.
5. In the Caching mode section, use the **arrow keys** to select the Cache setting for the array, then press **Enter**.
6. Press the **C** key to confirm creation of array or press the **ESC** key to go back to a previous page.
7. **RAID10** array listed in the **Arrays** section

5.5.4 **Delete Arrays**

*CAUTION:* Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

*CAUTION:* Do not delete the first array listed in the **Arrays** section, if it is the **AMD-RAID** bootable array. Doing this deletes the operating system and **AMD-RAID** files.

5.5.4.1 **Delete an Array**

1. At the Main Menu, use the **arrow keys** to highlight **Delete Arrays** then press **Enter**.
2. Select the arrays to delete:
   - To select all arrays, press the **A** key.
   - To select individual arrays, highlight an array with the **arrow keys** and press **Insert**.
     Any number of arrays may be selected using this method.
3. Press **Enter** to delete the selected arrays. A warning message displays.
4. Press the **C** key to confirm the deletion, or press the **ESC** key to exit to the **Main Menu**.
5.5.5 Swap Arrays

Use the Swap Two Arrays option to arrange arrays in a different order.

5.5.5.1 Before You Begin

- If more than one array is created, install the operating system to any of them. However, a small amount of boot information is always written to a disk(s) in the first array (Array 1) of the Array section, regardless on which array the operating system is installed.
- It is recommended that the user install the operating system on an AMD-RAID bootable array at a redundant RAID level, such as RAID1 or RAID 10 and swap the array into the first position, if it is not already Array 1.
- Swapping arrays can be performed only at the BIOS Configuration Utility.

5.5.5.2 Swap Arrays

1. At the Main Menu, use the arrow keys to highlight Swap Two Arrays, then press Enter.
2. Select the arrays to swap:
   a. Highlight an array using the arrow keys.
   b. Press Insert to select it.
   c. Highlight a different array using the arrow keys.
   d. Press Insert to select it.
3. Press Enter to swap the arrays.

5.5.6 Manage Spares

This option allows the user to assign or unassign global or dedicated spares.

5.5.6.1 Assign Global Spares

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press Enter.
2. Use the arrow keys to highlight Assign Global Hot Spare(s), then press Enter.
3. Select the disks to assign as global spares:
   - To select all disks, press the A key
   - To select individual disks, highlight a disk with the arrow keys and press Insert. Any number of disks may be selected using this method
4. Press Enter to assign the selected disks as global spares.

5.5.6.2 Assign Dedicated Spares

1. At the Main Menu, use the arrow keys to highlight Manage Host Spare(s), then press Enter.
2. Use the arrow keys to highlight Assign Dedicated Hot Spare(s), then press Enter.
3. Use the **arrow keys** to highlight the array. (must be a redundant array)
4. Press **Insert** to select the array, then press **Enter**.
5. Select the disks to assign as dedicated spares.
   - To select all disks, press the **A** key.
   - To select individual disks, use the **arrow keys** to highlight the disk and press **Insert** to select it. Any number of disks may be selected using this method.
   - Press **Enter**.
6. Press the **C** key to continue, or press the **ESC** key to return to the Main Menu.

### 5.5.6.3  Un-Assign Spares

1. At the **Main Menu**, use the **arrow keys** to highlight **Manage Host Spare(s)**, then press **Enter**.
2. Use the **arrow keys** to highlight **Unassign Hot Spare(s)**, then press **Enter**.
3. Select the disks to unassign as spares:
   - To select all disks, press the **A** key.
   - To select individual disks, use the **arrow keys** to highlight the disk and press **Insert** to select it. Any number of disks may be selected using this method.
4. Press **Enter** to unassign the selected disks.
5. Press the **C** key to continue, or press the **ESC** key to return to the Main Menu.

### 5.5.7  View Disk Details

This option allows the user to view details about the disk. Nothing can be changed using this menu option; it is for informational purposes only.

1. At the Main Menu, use the **arrow keys** to highlight **View Disk Details**, then press **Enter**.
2. Use the **arrow keys** to highlight a disk. Information about the disk is displayed in the Information field across the top:
   - Unique Disk ID
   - Drive Type
   - Cache Settings
   - Maximum Free Space
   - Model Number
   - Serial Number
3. Press **ESC** to exit to the **Main Menu**.
5.5.8 View Array Details

This option allows the details of the array to be viewed. Nothing can be changed using this menu option; it is for informational purposes only.

1. At the Main Menu, use the arrow keys to highlight View Array Details, then press Enter.
2. Use the arrow keys to choose an array.
3. The full details of the array are displayed in the Information field across the top:
   - Array number
   - RAID level
   - Size
   - State
   - Cache settings

*Note: The disks in the array are selected (green).*

5.5.9 Rescan All Channels

This option allows the user to rescan all channels to detect new or removed disks and arrays. It rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1. At the Main Menu, use the arrow keys to highlight Rescan All Channels.
2. Press Enter.
3. The activity indicator in the Information field spins while the disks are being polled.

5.5.10 Change the Controller Options

Controller Options allows the user to configure options for the boot sequence.

*Note: By default, all options are On. It is recommended that options remain On.*

5.5.10.1 Booting the System from an Array

This option allows the user to enable boot support.

It is recommended that this option be disabled only if the system is booted from another device.

1. At the Main Menu, use the arrow keys to highlight Controller Options then press Enter.
2. Use the arrow keys to highlight Toggle INT13 Boot Support.
3. Press Enter to toggle between On and Off.
4. Press ESC to return to the Main Menu.
5.5.10.2 Pausing the Boot Sequence for Warning Messages

When the Pause feature is enabled and an array goes critical, offline, or there is another problem with the system, the boot process stops and an error message is displayed on the screen. The user must press Enter to continue booting.

If the Pause feature is disabled, error messages are briefly displayed as the system continues to boot.

1. At the Main Menu, use the arrow keys to highlight Controller Options, then press Enter.
2. Set pauses to the boot sequence for critical warnings.
   a. Use the arrow keys to highlight Toggle Pause if Critical.
   b. Press Enter to toggle between On (enables pauses) and Off (disables pauses).
3. Set pauses to the boot sequence for offline warnings by doing the following:
   a. Use the arrow keys to highlight Toggle Pause if Critical.
   b. Press Enter to toggle between On (enables pauses) and Off (disables pauses).
4. Press ESC to return to the Main Menu.

5.5.10.3 Change the Staggered Spinup Count

Depending on a system’s power supply load-rating, the end-user might want to limit the number of disks that are spun-up together when a system is powered on.

For example, if a system has six disks and the staggered spinup count is set to 2, RAIDXpert2 sends a command to spin-up disks 1 and 2 together, then disks 3 and 4, and finally disks 5 and 6.

1. At the Main Menu, use the arrow keys to highlight Controller Options, then press Enter.
2. Use the arrow keys to highlight Set Staggered Spinup Count, then press Enter. The number within the brackets changes color to indicate it is selected.
3. Use the arrow keys to change the number within the brackets. The minimum is 1 and the maximum is 8.
4. Press Enter to save the setting, or press ESC to return to the Main Menu.

5.5.11 Continue Booting from the BIOS Configuration Utility

After settings have been changed, continue booting the system from the point where the user entered the RAIDXpert2 BIOS Configuration Utility.

5.5.11.1 Resume the Boot Process

1. At the Main Menu, use the arrow keys to highlight Continue to Boot.
2. Press Enter.
Chapter 6  RAIDXpert2 Configuration Utility (HII)

Before you begin, enable platform RAID mode by referring to Chapter 4, Platform RAID Enablement Prerequisites, on page 36.

6.1 When to Use the RAIDXpert2 Configuration Utility (HII)

The RAIDXpert2 Configuration Utility is also known as the HII. Use the utility to accomplish the procedures indicated in Table 16.

Table 16. When to use the AMD-RAID RAIDXpert2 Configuration Utility (HII)

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Description</th>
<th>Find Information At</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize a new disk</td>
<td>To initialize a new disk drive for data storage.</td>
<td>Section 6.3, Initialize Disks, on page 50</td>
</tr>
<tr>
<td>Create Arrays</td>
<td>Create arrays at different RAID levels (depending on the license level for the system)</td>
<td>Section 6.4, Create Arrays, on page 51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 6.5, Delete Arrays, on page 55</td>
</tr>
<tr>
<td>Delete Arrays</td>
<td>Delete an array</td>
<td>Section 6.5, Delete Arrays, on page 55</td>
</tr>
<tr>
<td>Manage hot spares</td>
<td>Allows selection of global and dedicated hot spares.</td>
<td>Section 6.6, Manage Spares, on page 55</td>
</tr>
<tr>
<td>View Controller details</td>
<td>View information about each controller.</td>
<td>Section 6.7, View Controller Details, on page 56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 6.8, View Disk Details, on page 57</td>
</tr>
<tr>
<td>View Disk details</td>
<td>View information about each disk.</td>
<td>Section 6.7, View Controller Details, on page 56</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 6.8, View Disk Details, on page 57</td>
</tr>
<tr>
<td>View Array details</td>
<td>View information about each array.</td>
<td>Section 6.8, View Disk Details, on page 57</td>
</tr>
<tr>
<td>Rescan all channels</td>
<td>Rescan all channels to detect new or removed disks and arrays.</td>
<td>Section 6.10, Rescan All Channels, on page 58</td>
</tr>
</tbody>
</table>
6.2 Access the AMD RAIDXpert2 Configuration Utility (HII)

Note: The step(s) mentioned below is specific to AMD NDA BIOS.

AMD SP3-Series Chipsets BIOS is based on AMI BIOS:

To enter the RAIDXpert2 Configuration Utility (HII) Power on the system, then press DEL. In the Menu Bar, select Advanced, select RAIDXpert2 Configuration Utility, then press Enter

AMD Socket AM4-Compatible Processor is based on Insyde BIOS:

To enter the RAIDXpert2 Configuration Utility (HII) Power on the system, then press ESC. Select Device Management, then press Enter. Select RAIDXpert2 Configuration Utility, then press Enter.

Note: If the BIOS Configuration Utility does not display, contact your system or motherboard supplier.

6.3 Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD-RAID array.

Initialization writes AMD-RAID configuration information (metadata) to a disk.

CAUTION: If a disk is part of an AMD-RAID array, the disk cannot be selected for initialization. To initialize the disk anyway, delete the AMD-RAID array. Data on the disk is deleted during initialization so ensure the correct disks are chosen to initialize.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, all data on the disk is lost.

1. At the RAIDXpert2 Configuration Utility's Main Menu, use the arrow keys to select Physical Disk Management, then press Enter.
2. Use the arrow keys to select Select Physical Disk Operations, then press Enter.
3. Use the arrow keys to highlight Initialize Disk, then press Enter
4. Select the disk(s) to initialize:
   • To select individual disks, highlight a disk with the arrow keys and press the Space Bar or Enter. Multiple disks may be selected using this method.
   • When the desired number have been selected, use the arrow keys to select OK, then press Enter.
   • Review the warning message, if you want to proceed, use the arrow keys to select YES, then press the Enter key, or press ESC to cancel the initialization.
Initialization takes 10 to 15 seconds per disk. During initialization, a complete rescan of all channels is done automatically.

## 6.4 Create Arrays

Arrays can be created after the disks are initialized. See Section 3.2, RAID Levels, on page 26, for deciding what type of RAID levels to use for the array.

**TIP:** See also Section 9.6.1, Create and Format Arrays on page 97, and Section 10.4, Create New Arrays: `rcadm --create`, on page 118.

### 6.4.1 Before You Begin

- In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported by AMD-RAIDXpert2.
- For redundant arrays, the Create process starts after the operating system and AMD-RAID OS drivers have been installed and the system has booted to the operating system. However, the arrays are immediately available to use for either a bootable array or a data array.
- Array numbers are valid only for a given boot, and might be different in the RAIDXpert2 Configuration Utility (HII) and RAIDXpert2 Web GUI. If a permanent label is required, use the RAIDXpert2 Web GUI Array Naming feature.
- At any point in the procedure, return to a prior window by pressing ESC.
- If the system is booted from an AMD-RAID bootable array, the first array in the Arrays section must be the bootable array. The system boots only from the first array in the Arrays section.

### 6.4.2 Create an Array

*Note:* The step(s) mentioned below are specific to **AMD NDA BIOS. AMD SP3-Series Chipsets BIOS is based on AMI BIOS. AMD Socket AM4-Compatible Processor is based on Insyde BIOS.**

Before proceeding with array create and manage, System BIOS configuration should be setup as mentioned in Chapter 4, Platform RAID Enablement Prerequisites for system RAID mode to be enabled

- The **RAIDXpert2 Configuration Utility** can be used to create a bootable array with levels Volume, Raidable, RAID0, RAID1 and RAID10. Configure array cache and Cache tag size settings by following the steps mentioned in the sections below.
Table 17. Default Cache Tag Size

<table>
<thead>
<tr>
<th>Array Type</th>
<th>Default CTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDD Array</td>
<td>64k</td>
</tr>
<tr>
<td>SSD Array</td>
<td></td>
</tr>
<tr>
<td>Mix of HDD/SSD Array</td>
<td></td>
</tr>
<tr>
<td>All NVMe Array</td>
<td>256k</td>
</tr>
<tr>
<td>Mix of NVMe with HDD/SSD Array</td>
<td>256k</td>
</tr>
</tbody>
</table>

Caution: Cache Tag Size cannot be changed for an array after creation.

To install the operating system and RAIDXpert2 files see Chapter 7, Software Installation, on page 59.

6.4.2.1 Create an AMD-RAID Bootable Array

CAUTION: Do not use eSATA drives for bootable arrays as they are removable.

To install the operating system, AMD RAID Device driver and RAIDXpert2 Web-GUI utility refer to Chapter 7, Software Installation, 59.

6.4.2.2 Create a RAIDABLE Array

Note: Refer to Table 7 for RAIDABLE array characteristics.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.
   • From the Select RAID Level Drop down menu, use the arrow keys to select RAIDABLE, then press Enter.
4. Select the disk with which to create the array:
   • Use the arrow keys to select Select Physical Disks, then press Enter.
   • Select an individual disk, highlight a disk with the arrow keys and press the Space Bar or Enter.
   • Use the arrow keys to select Apply Changes, then press Enter.
5. Please refer to Table 17 on page 52 for Default Cache Tag Size.
6. Using the arrow keys to select Read Cache Policy, then press Enter.
   • Select the desired Read Cache Policy, then press Enter.
7. Using the arrow keys to select Write Cache Policy, then press Enter.
   • Select the desired Write Cache Policy, then press Enter.
8. Use the arrow keys to select Create Array, then press Enter.
6.4.2.3 Create a VOLUME Array

*Note: Refer to Table 7 for VOLUME array characteristics*

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.
   - From the Select RAID Level Drop down menu, use the arrow keys to select VOLUME, then press Enter.
4. Select the disks with which to create the array:
   - Use the arrow keys to Select Physical Disks, then press Enter.
   - Select desired disks, highlight a disk with the arrow keys and press the Space Bar or Enter.
   - Use the arrow keys to select Apply Changes, then press Enter.
5. Please refer to Table 17 on page 52 for Default Cache Tag Size.
6. Using the arrow keys to select Read Cache Policy, then press Enter.
   - Select the desired Read Cache Policy, then press Enter.
7. Using the arrow keys to select Write Cache Policy, then press Enter.
   - Select the desired Write Cache Policy, then press Enter.
8. Use the arrow keys to select Create Array, then press Enter.

6.4.2.4 Create a RAID0 Array

*Note: Refer to Table 7 for RAID0 array characteristics*

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.
   - From the Select RAID Level Drop down menu, use the arrow keys to select RAID0, then press Enter.
4. Select the disks with which to create the array:
   - Use the arrow keys to Select Physical Disks, then press Enter.
   - Select desired disks, highlight a disk with the arrow keys and press the Space Bar or Enter.
   - Use the arrow keys to select Apply Changes, then press Enter.
5. Please refer to Table 17 on page 52 for Default Cache Tag Size.
6. Using the arrow keys to select Read Cache Policy, then press Enter.
   - Select the desired Read Cache Policy, then press Enter.
7. Using the arrow keys to select Write Cache Policy, then press Enter.
6.4.2.5 Create a RAID1 Array

Note: Refer to Table 7 for RAID1 array characteristics

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.
   - From the Select RAID Level Drop down menu, use the arrow keys to select RAID1, then press Enter.
4. Select the disks with which to create the array:
   - Use the arrow keys to Select Physical Disks, then press Enter.
   - Select desired disks, highlight a disk with the arrow keys and press the Space Bar or Enter.
   - Use the arrow keys to select Apply Changes, then press Enter.
5. Please refer to Table 17 on page 52 for Default Cache Tag Size.
6. Using the arrow keys to select Read Cache Policy, then press Enter.
   - Select the desired Read Cache Policy, then press Enter.
7. Using the arrow keys to select Write Cache Policy, then press Enter.
   - Select the desired Write Cache Policy, then press Enter.
8. Use the arrow keys to select Create Array, then press Enter.

6.4.2.6 Create a RAID10 Array

Note: Refer to Table 7 for RAID10 array characteristics

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Create Array, then press Enter.
3. Use the arrow keys to select Select RAID Level, then press Enter.
   - From the Select RAID Level Drop down menu, use the arrow keys to select RAID10, then press Enter.
4. Select the disks with which to create the array:
   - Use the arrow keys to Select Physical Disks, then press Enter.
   - Select desired disks, highlight a disk with the arrow keys and press the Space Bar or Enter.
   - Use the arrow keys to select Apply Changes, then press Enter.
5. Please refer to Table 17 on page 52 for Default Cache Tag Size.
6. Using the **arrow keys** to select Read Cache Policy, then press Enter.
   - Select the desired Read Cache Policy, then press Enter.
7. Using the **arrow keys** to select Write Cache Policy, then press Enter.
   - Select the desired Write Cache Policy, then press Enter.
8. Use the **arrow keys** to select Create Array, then press Enter.

### 6.5 Delete Arrays

**CAUTION:** Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

**CAUTION:** Do not delete the first array listed in the Arrays section, if it is the AMD-RAID bootable array. Doing this deletes the operating system and AMD-RAID files.

#### 6.5.1 Delete an Array

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the **arrow keys** to select Array Management, then press Enter.
2. Use the **arrow keys** to select Delete Arrays then press Enter.
3. Select the array(s) to delete:
   - Use the **arrow keys** to select the desired array or multiple arrays, then press the Space Bar or Enter to change option to Enabled for deletion.
   - If you want to select all of the arrays, use the **arrow keys** to select Check all, then press Enter.
   - Use the **arrow keys** to select Delete Array, then press the Space Bar or Enter.
   - To select all the arrays for deletion: use the arrow keys to select Check all, then press the Space Bar or Enter.
   - Review the warning message, if you want to proceed, press the Space Bar or Enter.
   - Use the **arrow keys** to select, Yes to Delete arrays or press the ESC key to exit.

### 6.6 Manage Spares

This option allows the user to assign or unassign global or dedicated spares.  
*Note: In order to assign a physical disk as a Global Spare, it must not be part of any Array.*

#### 6.6.1 Assign Global Spares

1. At the RaidXpert2 Configuration Utility’s Main Menu, use the **arrow keys** to select Physical Disk Management, then press Enter.
2. Use the **arrow keys** to select Select Physical Disk Operations, then press Enter.
3. Use the **arrow keys** to select Select Physical Disk, then press Enter.
4. Use the **arrow keys** to select Assign Global Hot Spare, then press Enter.
5. Review the warning message, if you want to proceed, use the arrow keys to select Yes or press ESC or select No, to exit.

6.6.2 Assign Dedicated Spares

Note: Dedicated spares can only be assigned to redundant arrays and must the same size or larger than the other members of the redundant array.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Manage Array Properties, then press Enter.
3. Use the arrow keys to select Select Array.
   • From the drop down menu, select the desired array (must be a redundant array), then press Enter.
4. Use the arrow keys to select Manage Dedicated Hot Spares, then press Enter.
5. Select the disks to assign as dedicated spares.
   • To select the disk, use the arrow keys to highlight the disk and press the Space Bar or Enter to select it.
   • Use the arrow keys to select Add Hot Spare Physical Disk, then press Enter.
   • At the warning message, press the space bar or Enter to Confirm.
   • Use the arrow keys to select Yes, then press Enter or press the ESC key to exit adding the Dedicated Spare.

6.6.3 Unassign Spares

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Physical Disk Management, then press Enter.
2. Use the arrow keys to select Select Physical Disk Operations, then press Enter.
3. Use the arrow keys to select Select Physical Disk, then press Enter.
4. From the drop down menu, use the arrow keys to select the Global / Dedicated Spare, then press Enter.
5. Use the arrow keys to select Unassign Hot Spare, then press Enter.
6. Review the warning message, if you want to proceed, select Yes, then press Enter or press the ESC key to exit.

6.7 View Controller Details

This option will display the details about of the controllers. Nothing can be changed using this menu option; it is for informational purposes only.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Controller Management, then press Enter.
2. Use the arrow keys to select Select View Controller Information, then press Enter.
3. Use the arrow keys to select Select Controller, then press Enter.
4. From the drop-down menu, select the desired controller, then press Enter.
5. Information about the controller is displayed below the Select Controller header:
   - PCI ID
   - Controller Physical Disk Count
   - Total Physical Disk Count
   - Total Array Count
   - UEFI Driver Version
   - Firmware Properties/Firmware Build Time
6. To view another controller, press Enter and from the drop-down menu, select a different controller, then press Enter.
7. Press ESC to exit to the Main Menu.

6.8 **View Disk Details**

This option allows the user to view details about the physical disk(s). Nothing can be changed using this menu option; it is for informational purposes only.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to highlight Physical Disk Management, then press Enter.
2. Use the arrow keys to select View Physical Disk Properties, then press Enter.
3. Use the arrow keys to select Select Physical Disk, then press Enter.
4. From the drop down menu, select the physical disk you want more information about, then press Enter.
5. Information about the physical disk is displayed below the Select Physical Disk header:
   - Unique Disk ID
   - State
   - Size
   - Smart Status
   - Revision
   - Drive Type
   - Maximum Free Space
   - Used Space
   - Disk Protocol
   - Disk Speed
   - Associated Array, if part of one
   - Serial Number
   - Model Number
6. To view another physical disk, press Enter and from the drop down menu, select a different physical disk, then press Enter.
7. Press ESC to exit to the Main Menu.

6.9 View Array Details

This option will display the details of an array. Nothing can be changed using this menu option; it is for informational purposes only.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Array Management, then press Enter.
2. Use the arrow keys to select Select Manage Array Properties, then press Enter.
3. Use the arrow keys to select Select Array, then press Enter.
4. From the drop down menu, select the desired array, then press Enter.
5. Use the arrow keys to select View Associated Physical Disks, then press Enter.
6. Press the Space Bar to select one of the members of the Array.
7. Use the arrow keys to select View Physical Disk Properties, then press Enter.
8. Information about the array is displayed below the Select Array header:
   - Array number
   - RAID level
   - State
   - Size
   - Cache Tag Size
   - Cache settings
   - Associated physical disks
9. To view another array, press ESC twice and perform steps 2 through 8 again.
10. Press ESC to exit to the Main Menu.

6.10 Rescan All Channels

This option allows the user to rescan all channels to detect new or removed disks and arrays. It rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1. At the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select Controller Management, then press Enter.
2. Use the arrow keys to select Rescan Disks, then press Enter.
   - After a rescan completes, all of the physical disks will be displayed.
3. Use the arrow keys to select OK, then press Enter.
Chapter 7  Software Installation

This chapter is designed to assist you with installation of Operating systems, by performing these general procedures:

7.1  System Setup Process Overview

A generic system setup process follows these steps:

1. Copy the AMD-RAID drivers to a removable storage medium.
2. Power on the system.
3. To enable RAID on Refer to Chapter 4, Platform RAID Enablement Prerequisites, on page 36. (This enables the loading of the AMD-RAID Option-ROM and or AMD-RAID UEFI driver).
4. Initialize the disks using the AMD-RAID Array Configuration Utility (HII) or AMD-RAID Option-ROM.
5. Create arrays using the AMD-RAID Array Configuration Utility (HII) or AMD-RAID Option-ROM.
6. Install the AMD-RAID drivers on the system.
7. Load the operating system.
8. Install the OS RAID Management Suite (AMD RAIDXpert2) on the system.

Note: To protect your data, always perform a backup prior to installing any new, major hardware or software.

7.2  Before You Begin

Have the Windows® or Linux® operating system software available and ready to install.

7.3  Copying AMD-RAID Drivers to Removable Storage

You need to copy the drivers to a removable storage medium before you begin the installation.

7.3.1  Copying AMD-RAID Drivers in a Microsoft® Windows® Environment

1. Power on the system.
2. Locate and use a system that is running a Windows operating system and has a CD DVD drive or an I/O port for removable storage media (such as a USB flash drive).
3. Go to a browser and access the web site of your system supplier or motherboard vendor.
4. Insert the storage medium into the system:
   • Connect a USB flash drive to a USB I/O port or insert a blank CD-DVD disk into the applicable drive.
5. Download the AMD-RAID drivers from the web site to the appropriate removable storage medium.

7.3.2 Copying AMD-RAID Drivers in a Linux® Environment

1. Power on the system.
2. Locate and use a system that is running a Windows operating system and has a USB I/O port for the USB flash drive.
3. Use a browser to access the web site of your system supplier or motherboard vendor.
4. Insert a USB flash drive into the USB I/O port of the system.
5. Download the AMD-RAID drivers for the correct distribution version of Linux®. Copy the drivers onto the USB flash drive:
   - For Red Hat Linux: Copy the .iso image file (that matches the applicable distribution of Linux to the USB flash drive. For example:
     o dd-rcaid-RHEL7-3.10.0-327.el7-x86_64.iso
   - For Ubuntu: Copy the driver files contained inside the dd-rcaid-Ubuntu [Ubuntu version number].w.x-yz-folder into a dd directory located on a root path of the USB flash drive. For example:
     o dd
       • load_amdraid
       • post_install
       • post_install2
       • pre_install
       • rcaid.ko
       • rcaid_generic.ko
       • readme

7.4 Installing AMD-RAID Drivers

Follow the procedures below for Pre-install of AMD RAID Driver during Installation of your Microsoft Windows or Linux® Operating System.

7.4.1 Installing AMD-RAID Drivers while Installing Microsoft® Windows®

7.4.1.1 Installing AMD-RAID OS Drivers during a Microsoft® Windows® 10 Installation

Note: The windows described in this procedure are typical. Path names and text can vary, depending on user-designated selections and other parameters.

Note: NVMe devices are listed in the “Where do you want to install Windows?” do not delete any of the partitions or format the devices. Doing so will delete the AMD-RAID metadata and
the desired RAID level will be deleted. After AMD-RAID drivers have been loaded, a valid AMD-RAID Virtual Disk appears.

1. Power on the system.
2. Create a bootable array, refer to Section 6.4, Create Arrays, on page 51.
3. Insert the Microsoft Windows operating system media/disk into the system’s Optical drive.
4. Boot the system and allow it to access the Microsoft Windows operating system installation media/disk.
5. At the Windows setup window:
   - Select the language, time, and keyboard options
   - Click Next.
   - Click Install Now or similar.
   - If prompted, select the desired Operating System
   - Click Next.
   - Depending on the installation window observed, choose one of the methods below to load rcbottom.inf
     - If the window observed is Select driver to install
       - Insert the storage medium with the AMD-RAID drivers into the USB port or applicable system drive
       - Click Browse.
       - Navigate to the directory containing the saved AMD-RAID drivers
       - Click OK.
       - Select the first rcbottom.inf driver in the list
       - Click Next.

Note: If the installation has multiple controllers, there will be two or more rcbottom.inf’s listed, installation of rcbottom.inf is recommended only once.

     - Else follow onscreen prompt until Where to install Windows? window observed
       - Select Load driver
       - Click Browse.
       - Navigate to the directory containing the saved AMD-RAID drivers
       - Click OK.
       - Select the first rcbottom.inf driver in the list
       - Click Next.
6. At the Load Driver Window:
   - Click OK
   - Click Browse.
   - Navigate to the directory containing the saved AMD-RAID drivers
   - Click OK.
7. Select (Check Mark) the **I Accept the License Terms**
   - Click **Next**.
   - Select **Custom: Install Windows Only (advanced)** or similar.

8. After both the rcbottom and rcraid drivers have been loaded, a valid Virtual disk appears in “Where do you want to install Windows?” window:
   - Click **Load Drivers**
   - Click **Browse**
   - Navigate to the directory containing the saved **AMD-RAID** drivers
   - Click **OK**
   - Select the **rccfg.inf** driver in the list
   - Click **Next**

9. At the “Where do you want to install Windows”
   - Click **Next**

10. Follow the on-screen instructions to complete the installation of the applicable Windows operating system.

11. After the OS is installed, open Device Manager and verify the following:
    - Expand Storage Controllers: there are entry(ies) listed as **AMD-RAID Bottom Device**
    - Expand Storage Controllers: there are entry(ies) listed as **AMD-RAID Controller**
    - Expand System Devices: there is an entry listed as **AMD-RAID Config Device**.

12. Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the applicable drive(s) or port. Proceed to Section 7.6, Installing the AMD RAIDXpert2 Management Suite for Microsoft® Windows®, on page 76.

### 7.5 Installing the AMD RAIDXpert2 Management Suite for Microsoft® Windows®

#### 7.5.1 Windows® – AMD-RAIDXpert2 Management Suite

1. Obtain the latest Catalyst executable file from your system supplier or motherboard vendor. Download the file to the system’s desktop, execute it and follow the on-screen prompts.
2. Click on the RAIDXpert2 Desktop Icon
   - Select the applicable **language** from the drop-down menu (default is English)
7.5.2 Windows® – AMD RAIDXpert2 Management Suite Installation (Manually)

Note: AMD RAIDXpert2 Management Suite installation default is a Silent installation.

1. Obtain the AMD RAIDXpert2 Management Suite executable file (Setup.exe) from your system supplier or motherboard vendor. Download Setup.exe to the system’s desktop.

2. Install AMD RAIDXpert2 (setup.exe):
   a. Open a command prompt, must be run as Administrator
   b. By typing `cd C:\User\User_Name\Desktop`
   c. For silent installation: `setup.exe`
   d. For GUI installation: `setup.exe -i gui`

3. Turn off Windows Firewall (or unblock during step 2).

4. Click on the RAIDXpert2 Desktop Icon
   - Select the applicable language from the drop-down menu (defaults on English)
• Default credentials are:
  i. Username – **admin**
  ii. Password – **admin**

5. Change the credentials:
   e. Create new username
   f. Create new password

6. Re-log into the system with the new credentials.

See Section 9.1.1.1, Browser Setup, on page 87, for supported browsers and configurations.

### 7.5.2.1 Installing AMD-RAID BIOS Drivers during a Microsoft® Windows® 7 Installation

*Note:* The windows described in this procedure are typical. Path names and text can vary, depending on user-designated selections and other parameters.

*Note:* Windows® 7 is supported only with RE-8.1 release. No NVMe support is available with Windows 7.

1. Power on the system.

*Note:* Do not boot up with a USB flash key in the system when performing an install, as the system will use that as the boot device.

2. Create a bootable array by following the procedures in Section 6.4.2.1, Create an AMD-RAID Bootable Array, on page 52.

3. Insert the Microsoft Windows operating system CD-ROM or DVD into the system's CD or DVD drive.
4. Boot the system and allow it to access the Microsoft Windows operating system CD-ROM or DVD.

5. At the Windows setup dialog box, do the following:
   a. Select the language, time, and keyboard options, then click Next.
   b. Click Install Now. If prompted, select the desired Operating System, then click Next.
   c. Insert the storage medium with the AMD-RAID drivers into the USB port or applicable system drive, then click Browse.
   d. Navigate to the directory containing the saved AMD-RAID drivers, then click OK.
   e. Select the rcbottom.inf driver from the list, then click Next.

   Note: If the system has multiple controllers, there will be two or more rcbottom.inf’s listed.

6. At the Load Driver Window, do the following:
   a. Click OK, Browse.
   b. Navigate to the directory containing the saved AMD-RAID drivers, then click OK.
   c. Select the rcraid.inf driver from the list, then click Next.
   d. Select the I Accept the License Terms checkbox, then click Next.
   e. Select Custom: Install Windows Only (advanced) option.
   f. Click Load Drivers, Browse.
   g. Navigate to the directory containing the saved AMD-RAID drivers, then click OK.
   h. Select the rccfg.inf driver, then click Next. A valid drive displays at the Windows installation location screen.

7. Click Next, then follow the on-screen instructions to complete the installation.

8. Once the OS installation is complete, open Device Manager and verify the following:
   - In the Expand Storage Controllers list, the AMD-RAID Bottom Device and AMD-RAID Controller entries are displayed.
   - In the Expand System Devices list, the AMD-RAID Config Device entry is displayed.

9. Remove the storage medium and Microsoft Windows OS CD-ROM or DVD from the applicable drive(s) or port.

10. Proceed to Section 7.6, Installing the AMD RAIDXpert2 Management Suite for Microsoft® Windows®, on page 76.

**7.5.3 Installing AMD-RAID Drivers While Installing Linux® Operating System**

   Note: The Linux® operating system modules must include the gcc+ compiler and the pthreads library so that the rcadm program can be installed properly.

   Note: Linux Operating System is supported only with RC-8.1 release. No NVMe support available with Linux Operating System.
7.5.3.1 Installing the AMD-RAID BIOS Drivers During a Red Hat Enterprise Linux® 7.3 64 bit (RHEL) Installation

**Note:** Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive, following the instructions in Section 7.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on page 60.

**Note:** When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux expert mode.

**Note:** Not all of the windows indicated in this procedure will appear during the installation.

1. Power on the system.
2. Insert the USB drive that contains the AMD-RAID drivers into the USB port.
3. Insert the Red Hat operating system CD-ROM or DVD into the system’s CD or DVD drive.
4. Create a bootable array by following the procedure in Section 6.4, Create Arrays, on page 51.
5. At the Red Hat Enterprise Linux welcome window, do the following:
   a. Press the Up arrow, then select **Install Red Hat Enterprise Linux 7.3**.
   b. Press Tab.
   c. Type `modprobe.blacklist=ahci inst.dd nomodeset` at the end of the existing string then press Enter. For example, `vmlinux initrd.img......quiet modprobe.blacklist=ahci inst.dd nomodeset`
6. At the **Driver Disk Device Selection**, press 1 (the number of the flash drive), then press Enter.
7. At the **Choose Driver Disk ISO** file, press 1 (the number of the dd-rraid-RHEL....el7.2x86_64.iso entry), then press Enter.
8. At Select Drivers to Install, do the following:
   a. Press 1 (the number of the /media/DD/……x86_64.rpm entry), then press Enter. The /media/DD/… is selected and should look like [X] /media/DD/……x86_64.rpm.
   b. Press the C key, then press Enter.
9. At the **Driver Disk Device Selection**, press the C key, then press Enter.
10. At the Welcome to Red Hat Enterprise Linux Screen, do the following:
    a. Choose the desired Language and Country.
    b. In the bottom right corner, then click **Continue**.
11. At the Installation Summary Screen:
    a. Under Localization, configure the following:
       • Date and Time
       • Keyboard
       • Language Support
    b. Under Software, configure the following:
• Installation Source
• Software Selection
  • Under Base Environments, select Server with GUI.
  • Under Add-Ons for Selected Environments, select **Compatibility Library**.
• In the upper left corner, click **Done**.

c. Under System, configure the following:
• Installation Destination
  • Under Local Standard Disks, select **AMD-RAID Array**.
  • In the upper left corner, click **Done**.
• Network and Hostname
  • In the bottom left corner, enter a valid Hostname.
    • Select an Ethernet Port.
    • In the bottom right corner, click **Configure**.
    • Enter valid entries.
    • Click **Save**.
  • In the upper left corner, click **Done**.

12. In the bottom right corner, click **Begin Installation**.

13. At the Configuration window, do the following:
   a. Click **Root Password**:
      • Enter an applicable root password.
      • Re-enter the root password.
      • In the upper right corner, click **Done**.
   b. Click **User Creation**:
      • Enter a Full Name.
      • Enter a Username.
      • Enter an applicable password.
      • Re-enter the user password.
      • In the upper right corner, click **Done**.

14. When the Installation Complete message displays, do the following:
   a. In the bottom right corner, click **Reboot**.
   b. Eject and remove the USB flash drive and the installation media.

15. At the Initial Setup of Red Hat Enterprise Linux Server 7.3, do the following:
   a. Press **1**, then press **Enter**.
   b. Press **2**, then press **Enter**.
   c. Press **R**, then press **Enter**.
   d. Press the **C** key, then press **Enter**.
16. Login to the system and do the following:
   a. Select a user.
   b. Enter a password.
17. At the Welcome window, select the desired language, then click Next.
18. At the Select Input Sources Window, select the desired Input Source, then click Next.
19. If desired, Configure Online Accounts, then click Next.
20. Click Start using Red Hat Enterprise Linux Server.
21. For RHEL 7.3 64 bit installs, manually load the following el7.686 rpms.
   a. Allow the system to boot and login as root when prompted.
   b. Insert the RHEL 7.3 x 64 installation CD/DVD into the system.
   c. Install the following rpms:
      • libX11...el7.i686
      • libXau...el7.i686
      • libXcb...el7.i686
      • libXext...el7.i686
      • libXi...el7.i686
      • libXtst...el7.i686
      • gtk2......el7.i686
      • libstdc++*.el7.i686
      • libSM-*.el7.i686
      • libpng12*.el7.i686
      • adwaita-gtk2-theme-*.el7.i686
      • libcanberra-gtk2-*.el7.i686
      • PackageKit-gtk3-module-*.el7.i686
22. Open a Web Browser, then do the following:
   a. Go to rpmfind.net
   b. Search for compat-libstdc++-33
   c. Download and install the compat-libstdc++-33-3.2.3-71.el7.i686.rpm
   d. Reboot the system.

7.5.3.2 Installing the AMD-RAID BIOS Drivers during a Supported Ubuntu Desktop Installation

Note: AMD-RAIDXpert2 supports the Ubuntu 16.04 desktop operating systems.

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or motherboard vendor. Copy the AMD-RAID drivers to the dd directory on a USB flash drive, following the instructions in Section 7.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on page 60.
Note: The Ubuntu driver CD-ROM .iso image contains all Linux variations for a particular release.

Note: Some of the windows indicated in this procedure might not appear during the installation.

1. Power on the system.
2. Remove the Ethernet cable from the system.
3. Insert the Ubuntu desktop operating system CD-ROM or DVD into the system's CD or DVD drive.
4. Create a bootable array by following the procedure in Section 6.4, Create Arrays, on page 51.
5. As soon as the Ubuntu desktop kernel starts loading, press F6 to go to Advanced Options.
6. Select the desired language, then press Enter.
7. From the list, select Try Ubuntu without Installing
8. Press F6 - Other Options, then press ESC.
9. At the end of the Boot Options string, type the following, then press Enter: break=mount
modprobe.blacklist=ahci nomodeset
Note: The string should look like the following: splash --- break=mount modprobe.blacklist=ahci nomodeset

10. When the BusyBox shell displays, perform the following steps:
   a. Insert the USB flash drive.
   b. Type the following, pressing Enter after each one:
      • mount -t vfat /dev/sdal /tmp
      • cp -ap /tmp/dd /
      • /dd/pre_install
      • umount /tmp
      • exit
   c. Remove the USB flash drive.

11. Wait patiently for the Ubuntu Desktop to appear
12. Double Click the Install Ubuntu 16.04.1 LTS Desktop ICON
13. When the Welcome screen displays, select the desired language then click Continue.
14. From the Preparing to Install Ubuntu window, accept the defaults, then click Continue.
15. From the Installation Type window, Select Erase Disk and install Ubuntu, then click Install Now.
16. From the Write Changes to Disks? window, then click Continue.
17. Select the desired time zone, then click Continue.
18. Select the desired keyboard layout, then click Continue.
19. Enter valid entries for the following, then click Continue.
a. Your name
b. Computer name
c. User name
d. Password
e. Confirm Password
f. Click Continue

20. When the Installation Complete window displays, do the following:
a. Insert the USB flash drive.
b. Press CTRL + ALT + T.
c. Type the following, pressing Enter after each one:
   • sudo mount -t vfat /dev/sda1 /mnt
   • sudo cp -ap /mnt/dd /
   • sudo /dd/post_install

21. Wait for the Setup is Complete message, then press CTRL + D. Click Restart Now, to finish the installation.

22. When prompted, remove the CD/DVD and USB flash drive from the system, then press Enter.

23. Reconnect the Ethernet cable.

24. Proceed to Section 7.7, Installing the AMD RAIDxpert2 Management Suite for Linux®, on page 76.

7.5.3.3 Install the AMD-RAID UEFI Drivers during a RHEL 7.3 64-bit Linux® Installation

Note: The Linux operating system modules must include the gcc+ compiler and the pthreads library, so that the rcdim program can be installed properly.

Note: Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or motherboard vendor. Copy the AMD-RAID drivers to a USB flash drive. See Section 7.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on page 60.

Note: When installing Red Hat Linux, use the Linux dd installation mode instead of the Linux expert mode.

Note: Not all of the windows indicated in this procedure will appear during the installation.

1. Power on the system.
2. Insert the USB drive containing the AMD-RAID drivers.
3. Insert the Red Hat operating system CD-ROM or DVD into the system’s CD or DVD drive.
4. Create a bootable array by following the procedures in Section 6.4.2.1, Create an AMD-RAID Bootable Array, on page 52.
5. At the Red Hat Enterprise Linux Welcome window:
a. Press the Up arrow.
b. Select Install Red Hat Enterprise Linux 7.3 64 bit.
c. Press the E key.
d. Press the down arrow to the linuxefi /images entry
e. Press the END key.
f. Add “modprobe.blacklist=ahci inst.dd nomodeset” to the end of the string
   1. Example – linuxefi /images.......quiet modprobe.blacklist=ahci inst.dd nomodeset

6. Wait for the **Driver Disk Device Selection** to appear
   a. Insert the USB drive (which contains the AMD-RAID drivers) into the USB port.
   b. Press the r key
c. Press **Enter**

7. At the **Driver Disk Device Selection**,
   a. Press 1 – the number of the flash drive
   b. Press **Enter**.

8. At the **Choose Driver Disk ISO file**
   a. Press 1 – the number of the dd-rraid-RHEL….el7 x86_64.iso entry
   b. Press **Enter**.

9. At the **Select Drivers to Install**
   a. Press 1 – the number of the /media/DD/…..x86_64.rpm entry
   b. Press **Enter**.
      i. The /media/DD/… is now selected and should look like [X]
         /media/DD/......x86_64.rpm
   c. Press the C key
d. Press **Enter**.

10. At the **Driver Disk Device Selection**
    a. Press the C key
    b. Press **Enter**.

11. At the **Welcome to Red Hat Enterprise Linux** Screen, do the following:
    a. Choose the desired **language** and **country**.
    b. In the bottom right corner, then click **Continue**.

12. At the **Installation Summary** Screen:
    a. Under **Localization**, configure the following:
       - **Date and Time**
       - **Keyboard**
       - **Language Support**
    b. Under **Software**, configure the following:
       - **Installation Source**
       - **Software Selection**
• Under **Base Environments**, select **Server with GUI**.
• Under **Add-Ons for Selected Environments**, select **Compatibility Library**.
• In the upper left corner, click **Done**.

c. Under **System**, configure the following:

  • **Installation Destination**
    • Under **Local Standard Disks**, select **AMD-RAID Array**.
    • In the upper left corner, click **Done**.

  • Configure Kdump

  • **Network and Hostname**
    • In the bottom left corner, enter a valid **Hostname**
      • Select an **Ethernet Port**
      • In the bottom right corner, click **Configure**.
      • Enter valid entries.
      • Click **Save**.
    • In the upper left corner, click **Done**.

13. In the bottom right corner, click **Begin Installation**.
14. At the **Configuration** window, do the following:

  a. Click **Root Password**
    • Enter an applicable root password
    • Re-enter the root password.
    • In the upper right corner, click **Done**.

  b. Click **User Creation**
    • Enter a **Full Name**
    • Enter a **Username**
    • Enter an applicable password.
    • Re-enter the user password.
    • In the upper right corner, click **Done**.

15. At the **Installation Complete** window, click **Reboot** in the bottom right corner, then eject and remove the USB flash drive.
16. At the **Initial Setup** Window

  • Click **License Information**
  • Review and Select (Check Mark) **I accept the License Agreement**
  • If desired, Configure **Subscription Management Registration**
  • If not already configured, configure **Configure Network & Hostname**
  • In the upper left corner, Click **Done**
  • In the bottom right corner, Click **Finish Configuration**
17. If a pop-up appears stating that the system has to reboot
   • Click OK
18. Login to the system
   • Select a user.
   • Enter a password.
19. At the Welcome window,
   • Select the desired Language
   • Click Next
20. At the Typing – Select your Keyboard Layout or Input Sources Window
   • Select the desired Input Source
   • Click Next
21. If desired, Configure Online Accounts, then click Next.
22. Click Start using Red Hat Enterprise Linux Server.
23. For RHEL 7.3 64 bit installs, manually load the following el7.686 rpms:
   a. Allow the system to boot and login as root when prompted.
   b. Insert the RHEL 7.3 64-bit installation CD/DVD into the system.
   c. Install the following rpms:
      • libX11...el7.i686
      • libXau...el7.i686
      • libxcb...el7.i686
      • libXext...el7.i686
      • libXi...el7.i686
      • libXtst...el7.i686
      • gtk2......el7.i686
      • libstdc++*.el7.i686
      • libSM-*...el7.i686
      • libpng12*...el7.i686
      • adwaita-gtk2-theme-*...el7.i686
      • libcanberra-gtk2-*...el7.i686
      • PackageKit-gtk3-module-*...el7.i686
24. Open a Web Browser and do the following:
   a. Go to rpmfind.net
   b. Search for compat-libstdc++-33
   c. Download and install the compat-libstdc++-33-3.2.3-71.el7.i686.rpm
   d. Reboot the system.
7.5.3.4 Installing the AMD-RAID UEFI Drivers during a Supported Ubuntu Desktop Installation

**Note:** AMD-RAIDXpert2 supports the Ubuntu 16.04 desktop operating system.

**Note:** Prior to starting this procedure, obtain the AMD-RAID drivers from your system supplier or motherboard vendor. Copy the AMD-RAID drivers to the dd directory on a USB flash drive, see Section 7.3.2, Copying AMD-RAID Drivers in a Linux® Environment, on page 60.

**Note:** The Ubuntu driver CD-ROM .iso image contains all Linux variations for a particular release.

**Note:** Not all of the windows indicated in this procedure will appear during the installation.

1. Power on the system.
2. Remove the Ethernet cable from the system.
3. Insert the Ubuntu desktop operating system CD-ROM or DVD into the system's CD or DVD drive.
4. Create a bootable array by following the procedure in Section 6.4.2.1, Create an AMD-RAID Bootable Array, on page 52.
5. Boot to the Ubuntu desktop CD-ROM or DVD. This will bring you to the GNU GRUB Window.
6. Select Try Ubuntu without installing
7. Press the E key to edit the commands before booting
8. Find the string that starts with linux /casper/vmlinuz.efi file=/cdrom......splash --
   - Press the END key
   - At the end of the Boot Options string add the following: break=mount modprobe.blacklist=ahci nomodeset
     **Note:** The string should look like: splash --- break=mount modprobe.blacklist=ahci nomodeset
   - Press F10, to boot.
9. When the BusyBox shell appears perform the following:
   **Note:** If the BusyBox shell doesn’t appear, reboot and try again.
   - Install the USB flash drive
   - Type: mount –t vfat /dev/sda1 /tmp
     **Note:** /dev/sda1 may need to be changed to /dev/sdb1 or /dev/sdc1...depending on the number of devices.
   - Type: cp –ap /tmp/dd /
   - Type: /dd/pre_install
   - Type: umount /tmp
   - Type: exit
   - Remove the USB flash drive
11. Double click the **Install Ubuntu 16.04.1 LTS** desktop ICON

12. From the **Welcome** window
   - Select the desired Language
   - Click **Continue**

13. From the **Preparing to Install Ubuntu** window
   - Accept the defaults
   - Click **Continue**

14. From the **Installation Type** window
   - Select **Erase Disk and Install Ubuntu**
   - Click **Install Now**

15. From the **Write Changes to Disks?** Window
   - Click **Continue**

16. Select the desired Time Zone
   - Click **Continue**

17. Select the desired Keyboard layout
   - Click **Continue**

18. Enter valid entries for the following:
   - Your name
   - Computer name
   - User name
   - Password
   - Confirm Password
   - Click **Continue**

19. When the “**Installation Complete**” window appears, do the following:
   - Install the USB flash drive
   - Press CTRL+ALT+T
   - Enter: sudo mount –t vfat /dev/sda1 /mnt
   - Enter: sudo cp –ap /mnt/dd /
   - Enter: sudo /dd/post_install

20. Wait for the **Setup is Complete**
   - Press **CTRL+ALT+D**
   - Click **Restart Now**, to finish the installation.

21. The installation will prompt the user to remove the installation media, remove the CD/DVD and USB flash drive from the system.
   - When installation media has been removed
   - Press **Enter**
7.6 Installing the AMD RAIDXpert2 Management Suite for Microsoft® Windows®

Obtain the latest Catalyst executable file from your system supplier or motherboard vendor. Download the file to the system’s desktop and execute it. Follow the on-screen prompts.

See Section 9.1.1.1, Browser Setup, on page 87, for supported browsers and configurations.

7.7 Installing the AMD RAIDXpert2 Management Suite for Linux®

Obtain the AMD RAIDXpert2 Management Suite executable file (Setup.sh) from your system supplier or motherboard vendor. Download the Setup.sh file to the system’s desktop.

Table 18. Linux® Procedure for Installing the Management Suite

<table>
<thead>
<tr>
<th>Element</th>
<th>Action</th>
</tr>
</thead>
</table>
| RHEL 7.3 64 bit | Manually load the following i686 rpms:  
  - libX11  
  - libXau  
  - libXeb  
  - libXext  
  - libXi  
  - libXtst  
  - compat-libstdc++  
  - gtk2  
  - libSM  
  - libpng12  
  - adwaita-gtk2-theme  
  - libcanberra-gtk2  
  - PackageKit-gtk3-module. |
| Ubuntu 16.04, 32-bit operating systems only | For Ubuntu 16.04, 32-bit operating system, enter the following command before executing Setup.sh:  
  \texttt{sudo ln -s /lib/i386-linux-gnu/libc.so.6 /lib/libc.so.6} |
Table 18. Linux® Procedure for Installing the Management Suite (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Action</th>
</tr>
</thead>
</table>
| Ubuntu 16.04, 64-bit operating system only | For the Ubuntu 16.04, 64-bit operating system, type the following commands before executing Setup.sh, pressing Enter after each one:  
  ```bash  
sudo ln -s /lib/x86_64-linux-gnu/libc.so.6 /lib/libc.so.6  
sudo apt-get install lib32z1  
sudo apt-get install lib32ncurses5  
sudo apt-get install libxext6:i386  
sudo apt-get install libxtst6:i386  
sudo apt-get install libxi6:i386  
sudo apt-get install libstdc++6:i386  
sudo apt-get install libgtk2.0-0:i386  
sudo apt-get install libxxf86vm1:i386  
sudo apt-get install libsm6:i386  
sudo apt-get install gtk2-engines-murrine:i386  
sudo apt-get install libcanberra-gtk-module:i386  
``` |
| Setup.sh | Verify that the Setup.sh file is executable by right-clicking on the Setup.sh file on the system’s desktop.  
From the pop-up menu, select the Properties category.  
Click the Permissions tab. |
| Permissions tab | Ensure that the Execute or Executable checkbox(es) is/are selected.  
Click Close. |
| Setup.sh icon | Double-click the Setup.sh icon that is on the desktop.  
At Do you want to run ‘Setup.sh’ or display its contents?, click Run.  
Wait while Linux runs the Management Suite installer. |
| Introduction window | Click Next. |
| License Agreement window | Select I accept the terms of the License Agreement.  
Click Next. |
| What would you like to install? window | Click Next. |
| Choose Install Folder window | Accept the default settings.  
Click Next. |
Table 18. Linux® Procedure for Installing the Management Suite (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Shortcuts window</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Pre-Installation Summary</td>
<td>Review the selections.</td>
</tr>
<tr>
<td>window</td>
<td>If they are okay, click Install.</td>
</tr>
<tr>
<td></td>
<td><em>Note: The Installing the AMD RAIDXpert2 Management Suite window appears, showing the progress of the installation.</em></td>
</tr>
<tr>
<td>Install Complete window</td>
<td>Click Done.</td>
</tr>
</tbody>
</table>

### 7.8 Installing the AMD RAIDXpert2 Graphical User Interface (GUI)

This section provides instructions for installing the AMD RAIDXpert2 GUI for Linux. For information on using the GUI, see Chapter 9, AMD RAIDXpert2 Graphical User Interface (GUI), on page 87.

#### 7.8.1 RHEL Linux® – AMD RAIDXpert2 Web GUI Installation

1. Copy xampp-linux x64-7.1.6-0-installer.run to the system’s desktop  
   - Open a terminal / console window and cd to /root/Desktop. (or similar)  
   - Enter into Super User mode: su  
   - Enter: ./xampp-linux-x64-7.1.6-0-installer.run --mode unattended --disable-components xampp_developer_files

2. Enter:  
   - cd /opt/raidxpert2/htdocs  
   - Enter: cp –rv raidxpert2 /opt/lampp/htdocs

3. To start lampp, type the following, then press Enter:  
   - /opt/lampp/lampp startapache  
   *Note: This must be done after each system reboot.*
   
   *Note: rc_cgi and lampp must be running for the Web GUI to function correctly.*

4. To start rcpopup, type the following, then press Enter:  
   - /opt/raidxpert2/bin/rcpopup &  
   *Note: This must be done after each system reboot.*

5. Click the RAIDXpert2 Desktop Icon
6. Enter the following default credentials:
   a. Username: admin
   b. Password: admin

7. Create a new username and password, and log into the system again with the new credentials.

### 7.8.2 Ubuntu – AMD RAIDXpert2 Web GUI Installation

1. Copy xampp-linux-x64-7.1.6-0-installer.run to the system’s Desktop.
   - Open a terminal / console window and cd to /root/Desktop. (or similar)
   - Enter: sudo ./xampp-linux-x64-7.1.6-0-installer.run --mode unattended --disable-components xampp_developer_files

2. Enter:
   - cd /opt/raidxpert2/htdocs
   - sudo cp –rv raidxpert2 /opt/lampp/htdocs

3. To start lampp, type the following, then press Enter:
   - sudo /opt/lampp/lampp startapache
   **Note:** This must be done after each system reboot.
   **Note:** rc_cgi and lampp must be running for the Web GUI to function correctly.

4. To start rcpopup, type the following, then press Enter:
   - /opt/raidxpert2/bin/rcpopup &
   **Note:** This must be done after each system reboot

5. Click the **RAIDXpert2 Desktop Icon**.

6. Enter the following default credentials:
   a. Username: admin
   b. Password: admin

7. Create a new username and password, and log into the system again with the new credentials.
Chapter 8  RAID Software Update

8.1  Purpose

This Chapter is designed to assist the user update their System to the latest released software.

This chapter describes the steps needed to update the AMD-RAID drivers installed on the following Operating Systems:

- Microsoft® Windows® 7 32 bit and 64 bit
- Microsoft Windows 10 32 bit and 64 bit
- Red Hat Enterprise Linux® (RHEL) 7.3 64 bit
- Ubuntu Desktop Linux 16.04.1 32 bit and 64 bit

8.2  System Overview Process

A generic System update process is described below.

1. Backup the user data before doing any upgrade.
3. Log into the System.
4. Copy the AMD RAIDXpert2 Installer to the Systems Desktop.
   - Windows – Latest Catalyst from AMD – See 2.1 on page 18.
   - Linux – Setup.sh
5. Run the AMD RAIDXpert2 Installer to update the AMD RAIDXpert2 Management Suite.
6. Update the AMD-RAID OS drivers.
7. Restart the System.

IMPORTANT: To protect your data; always perform a backup prior to installing any new, major hardware or software. If you are adding NVMe as RAID to your existing AMD-RAID arrays, update all the existing AMD-RAID controller drivers to the latest version and restart the system. Then connect the NVMe devices and install the AMD-RAID driver onto NVMe devices.
8.3 Updating the AMD RAIDXpert2 Management Suite.

8.3.1 Update the AMD RAIDXpert2 Management Application (Web GUI)—Catalyst

1. Backup the user data before doing any upgrade.
3. Obtain the latest Catalyst executable file from your system supplier or motherboard vendor. Download the file to the Systems Desktop and execute it. Follow the on-screen prompts.

8.3.1.1 Update the AMD RAIDXpert2 Management Application (Web GUI)—Manually

1. Backup the user data before doing any upgrade.
2. Open a browser and access the Web Site of your system supplier or motherboard vendor.
3. Download the AMD RAIDXpert2 Installer (setup.exe) from the web site and copy it to the Systems Desktop.
4. Open a Command Prompt terminal
   Enter: `cd Users\user_name\Desktop`
   Enter: `setup.exe -i silent`
   
   *Note: The user must clear the Browser History of the Internet Browser being used by AMD RAIDXpert2 Management Suite (Web GUI)*

8.3.2 Copy the AMD RAIDXpert2 Installer to the Systems Desktop: Red Hat Linux®

1. Power-on the System.
2. Go to a browser and access the Web Site of your system supplier or motherboard vendor.
3. Download the AMD RAIDXpert2 Installer (setup.sh) and copy it to the Systems / directory.
4. Open a console / terminal window and enter the following:
5. `./setup.sh -i silent cd /opt/raidxpert2/htdocs cp -rv raidxpert2 /opt/lampp/htdocs`
   
   *Note: Enter – `cp –rv raidxpert2 /opt/lampp/htdocs` to avoid answering y to all entries.*

8.3.3 Copy the AMD RAIDXpert2 Installer to the Systems Desktop: Ubuntu Linux®

1. Power-on the System.
2. Go to a browser and access the Web Site of your system supplier or motherboard vendor.
3. Download the AMD RAIDXpert2 Installer (setup.sh) and copy it to the Systems / directory.
• For Ubuntu 32-bit OS, enter the following commands before executing Setup.sh:
  sudo ln -s /lib/i386-linux-gnu/ libc.so.6 /lib/libc.so.6

• For Ubuntu 64-bit OS, enter the following commands before executing Setup.sh:
  sudo ln -s /lib/x86_64-linux-gnu/ libc.so.6 /lib/libc.so.6

4. Open a console / terminal window and enter the following
5. sudo ./setup.sh -i silent cd /opt/raidxpert2/htdocs sudo cp -rv raidxpert2 /opt/lampp/htdocs

   Note: Enter \cp –rv raidxpert2 /opt/lampp/htdocs to avoid answering y to all entries.

8.4 Updating the AMD-RAID OS Drivers – SOC and AMD 300-Series Chipset

8.4.1 Windows® Drivers

8.4.1.1 Windows®—Catalyst

1. Backup the user data before doing any upgrade.
2. If not already done, perform the steps in Section 7.4.1.1 on page 60.

8.4.1.2 Windows® 10—Manually

1. Backup the user data before doing any upgrade.
2. Open a browser and access the Web Site of your system supplier or motherboard vendor.
3. Download the AMD-RAID Drivers from the Web Site and copy it to the Systems C: drive.
5. Expand Storage Controllers.
6. Select the first AMD-RAID Bottom Device
   • Right Click and select Update Driver Software
   • Click Browse my computer for driver software.
   • Click Browse, set the path to the Systems C drive.
   • Click OK.
   • Click Next

   Note: if a Window Security Window pops up, select Install this driver software anyways.
   • Click Close
   • At System Settings Change pop up prompting the user to restart the system, Click No.
7. Select the first AMD-RAID Controller
   • Right Click and select Update Driver Software
8. Expand **System Devices**.

9. Select **AMD-RAID Config Device**
   - **Right Click** and select **Update Driver Software**
   - **Click Browse my computer for driver software**.
   - **Click Browse**, set the path to the Systems C drive.
   - **Click OK**
   - **Click Next**
   
   *Note: if a Window Security Window pops up, select Install this driver software anyways.*

   - **Click Close**

8.4.2 **Linux® Drivers**

8.4.2.1 **RHEL**

1. Insert a USB flash drive containing the AMD-RAID driver disk iso image.
2. Copy the dd-rcriad-RHEL7...86_64.iso file to the Systems Desktop
3. Right Click on the dd-rcriad-RHEL7...8x_64.iso and select Extract Here
4. In a terminal / console window and enter the following:

   - `cd /root/Desktop/dd-rcriad-RHEL7...x86_64/rpms/x86_64`
   - `rpm -i --force kmod-rcriad-6.0.0-3.10...rpm`

   *Note: If command doesn’t work, enter chmod 777 kmod-rcriad.....rpm*

5. Wait for command to complete.
6. Reboot the System.

   *Note: remember to remove the USB Flash drive*

8.4.2.2 **Ubuntu**

**Warning:** If the systems kernel has been updated, perform Section 3.2.2 before the system is rebooted. Failing to do so may result in the system failing to boot.
1. Open a terminal / console window.
   a. Enter `uname -r`
   b. Document the kernel version. (i.e., – 4.2.0-16-generic)
2. Open the Ubuntu Software Center
   a. In the upper right corner, search for **kernel header v.w.x yz**
      ii. Where v.w.x yz is the documented kernel version
   b. Select all that relate to the Systems kernel version
   c. Click **Install**
      iii. Example: 4.2.0-16-generic
   d. In the upper right corner, search for **build-essential**
   e. Select **build-essential**
   f. Click **Install**
3. Change directory to the RAIDxpert2 driver_sdk directory and enter the following:
   - cd /opt/raidxpert2/driver_sdk
   - sudo ./install
   **Note:** If command doesn’t work, sudo chmod 777 install.sh
4. Wait for command to complete.
5. Reboot the System.

8.4.3 Adding NVMe to Existing AMD-RAID System

8.4.3.1 Update Windows® 10 Drivers for SoC and AMD 300-Series Chipsets

1. Backup the user data before doing any upgrade
2. If not already done, perform the steps in Section 8.3.1.1 on page 81
3. If not already done, perform steps in Section 8.4.1.1 on page 82

8.4.3.2 Update Platform BIOS

4. Flash the BIOS with a version that supports **AMD-RAID NVMe RAID**
5. Enable RAID on the SOC, Promontory and NVMe
6. Save the BIOS settings
7. Power off the system
8. Install the NVMe devices
9. Power on the system

8.4.3.3 Install the AMD-RAID Driver for NVMe

1. Open **Device Manager**.
2. Expand **Storage Controllers**.
   - Select the desired **Standard NVM Express Controller**
   - **Right Click** and select **Update Driver Software**…
   - Click **Browse my computer for driver software**.
   - Click **Let me pick from a list of available drivers on my computer**
   - Click **Have Disk**
   - Click **Browse**, set the path to the Systems C: drive.
   - From the list, select the **rcbottom.inf** entry
   - Click **Open**
   - Click **OK**
   - Click **Next**

   **Note:** If a *Window Security Window* pops up, select **Install this driver software anyways**.
   - Click **Close**
   - At **System Settings Change** pop up prompting the user to restart the system, Click **No**.

3. Perform Step 2 for each additional NVMe device you want to run RAID.

4. Expand **Other Devices**
   - Select the desired **Unknown Device**

   **Note:** If you are unsure which entry to use, select an **Unknown Device**, **Right Click** and select **Properties**. **Click the Details Tab** and the Device instance path should display **rcbottom**.
   - **Right Click** and select **Update Driver Software**…
   - Click **Browse my computer for driver software**.
   - Click **Next**
   - Click **Have Disk**
   - Click **Browse**, set the path to the Systems C: drive.
   - From the list, select the **rcraid.inf** entry
   - Click **Open**
   - Click **OK**
   - Click **Next**

   **Note:** If a *Window Security Window* pops up, select **Install this driver software anyways**.
   - Click **Close**
   - At **System Settings Change** pop up prompting the user to restart the system, Click **No**.

5. Perform Step 4 for each addition NVMe you want to run RAID.

6. Expand **Other Devices**
   - Select **AMD-RAID Configuration SCSI Processor Device**
   - **Right Click** and select **Update Driver Software**…
- Click Browse my computer for driver software.
- Click Let me pick from a list of available drivers on my computer
- Click Next
- Click Have Disk
- Click Browse, set the path to the Systems C: drive.
- From the list, select the rccfg.inf entry
- Click Open
- Click OK
- Click Next

Note: If a Window Security Window pops up, select Install this driver software anyways.

- Click Close
- At System Settings Change pop up, Click No

Restart the System
Chapter 9  AMD RAIDXpert2 Graphical User Interface (GUI)

9.1  Start RAIDXpert2

RAIDXpert2 can be accessed using a web browser or Windows shortcut.

9.1.1  Web-Browser Access

9.1.1.1  Browser Setup

- Use Chrome version 20, Firefox version 14, Internet Explorer 8, or Safari 6, or a greater version of each.
- To optimize the display, use a color monitor and set its color quality to the highest setting.
- To navigate beyond the Sign In page (with a valid user account):
  - Set the browser’s local-intranet security option to medium or medium-low. For Internet Explorer 8, adding the controller’s network IP address as a trusted site can avoid access issues.
  - Verify that the browser is set to allow cookies at least for the IP address of the controller.
- To see the help window in Microsoft® Internet Explorer, you must enable pop-up windows.

9.1.1.1.1  Signing In Using a Web Browser

1. In the web browser’s address field, type the IP address of a controller network port and press Enter.
2. The AMD RAIDXpert2 Management Tool Login is displayed. If the Login page does not display, verify that you have entered the correct IP address.
3. On the Login page, enter the name and password of a configured user. The default user name and password are admin and admin.
   Note: Both usernames and passwords are case-sensitive.
4. Select a language at the drop-down menu.
5. Click Submit. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise, a message indicates that the system is unavailable.

9.1.1.2  Tips for Signing In and Signing Out Using a Web Browser

- Do not include a leading zero in an IP address. For example, enter 10.1.4.33 not 10.1.4.033.
- Multiple users can be signed in to each controller simultaneously.
- For each active RAIDXpert2 session an identifier is stored in the browser. Depending on how your browser treats this session identifier, you might be able to run multiple
independent sessions simultaneously. Internet Explorer can run separate RAIDXpert2 sessions if you select File > New Session. If you do not select a new session, all instances of Internet Explorer share the same session.

- End a RAIDXpert2 session by selecting Options > Logout. Do not simply close the browser window.

### 9.1.2 Desktop Shortcut Access

#### 9.1.2.1 Signing In Using the RAIDXpert2 Desktop Shortcut

1. Launch the AMD RAIDXpert2 Management Tool using by double-clicking the RAIDXpert2 desktop shortcut.
2. The **AMD RAIDXpert2 Management Tool Login** is displayed. If the Login page does not display, verify that you have used the correct shortcut.
3. Select a language at the drop-down menu.
4. On the **Login** page, enter the name and password of a configured user. The default user name and password are **admin** and **admin**.

*Note: Both usernames and passwords are case-sensitive.*

5. Click **Submit**. If the system is available, the RAIDXpert2 GUI page is displayed; otherwise, a message indicates that the system is unavailable.

### 9.2 Password Protection

When the system displays a window that prompts you to choose a username and password, use the procedure below.

1. In the Username field, enter the new username.
2. In the Password field, enter the new password. Follow the guidelines in Section 9.2.1, Things to Know About Passwords, on page 88.
3. In the Confirm New Password field, re-enter the new password.

*Note: Both usernames and passwords are case-sensitive.*

4. Click **Submit**.

#### 9.2.1 Things to Know About Passwords

- RAIDXpert2 cannot be opened without a password. Create a password that is easily remembered.
- The password must be 4 - 20 characters long.
- The password is case-sensitive.
- The application does not track previous passwords unless enabled through your web browser.
• To change an existing password, see Section 9.2.2, Change a Password at the Options Menu, on page 89.

• If a user forgets the username or password, delete rc_login.txt to restore the default user name and password (admin and admin).

### 9.2.2 Change a Password at the Options Menu

*Note: Both usernames and passwords are case-sensitive.*

1. At the Options menu, select **Password**.
2. The Choose a new Username and Password window displays.
3. In the Old Password field, enter the default password you used to login.
4. In the New Password field, enter the new password. Follow the guidelines in Section 9.2.1, Things to Know About Passwords, on page 88.
5. In the New Password field, re-enter the new password.
6. Click **Submit**.

### 9.3 Help and About Windows®

To view the software version and build number for the GUI, select About at the Help menu. The AMD RAIDXpert2 Driver Version and GUI Version displays.

For customer support, select **Help > User Guide**. A pdf version of this document will display. A pdf reader program will be necessary to view it.

For further customer support, contact your system supplier or motherboard vendor.

### 9.4 Reviewing the RAIDXpert2 GUI

#### 9.4.1 The Array View Section of the Array Status Window

#### 9.4.1.1 Elements of the Array View Section

The Array View section presents a graphical view of array properties. Table 19 provides information about the elements of the Array View section.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller Name</td>
<td>The RAIDXpert2 controller for the arrays displayed below it.</td>
</tr>
<tr>
<td>Array</td>
<td>The number assigned to an array.</td>
</tr>
</tbody>
</table>
Table 19. Elements of the Array View Section, Array Status Window (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array name</td>
<td>The name assigned to an array.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>The RAID level of the array.</td>
</tr>
<tr>
<td>Disk Number</td>
<td>The number assigned to disks in an array.</td>
</tr>
<tr>
<td>Disk Manufacturer</td>
<td>The manufacturer of disks in an array.</td>
</tr>
<tr>
<td>Disk Model Number</td>
<td>The model number of the disks in an array.</td>
</tr>
</tbody>
</table>

9.4.2 The Disk List Section of the Array Status Window

9.4.2.1 Elements of the Disk List Section

The Disk List section provides information about all disks assigned or available to arrays. Table 20 provides information about the elements of the Disk List section.

Table 20. Elements of the Disk List Section, Array Status Window

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk</td>
<td>Disk number.</td>
</tr>
</tbody>
</table>
| Capacity    | Disk capacity:  
1 MB = 1,000,000 bytes  
1 GB = 1,000,000,000 bytes  
*Note: Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units* |
| Port Type   | Negotiated Speed (not the speed of the port type and SATA NCQ or NVMe)                           |
| GS          | Indicates if the disk is assigned as a global spare.                                             |
| State       | State of the disk (Online, Offline, SMART Error).                                                |
| Type        | Disk type (Disk, Legacy, New).                                                                  |
| State       | State of the disk (Online, Offline, SMART Error)                                                 |
Table 20. Elements of the Disk List Section, Array Status Window (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Disk manufacturer’s model number.</td>
</tr>
<tr>
<td>Serial No.</td>
<td>Disk manufacturer’s serial number.</td>
</tr>
<tr>
<td>Firmware</td>
<td>Disk manufacturer’s firmware version.</td>
</tr>
<tr>
<td>Space Available</td>
<td>Total amount of space unused on the disk.</td>
</tr>
<tr>
<td>Largest Available</td>
<td>Largest contiguous unused space on the disk.</td>
</tr>
<tr>
<td>Features</td>
<td>Information about port communication and physical disk cache settings.</td>
</tr>
</tbody>
</table>

If a disk is missing from the Disk List, the most likely cause is:

- A loose cable. Make sure that all disk cables are connected, then perform a rescan.
- A disk that is not fully seated in its bay or slot. Make sure that the disk is inserted completely in its bay or slot, then perform a rescan.

For more information, see Section 9.5.2, Rescan Disks, on page 95.

9.4.3 The Array List Section of the Array Status Window

9.4.3.1 Elements of the Array List Section

The Array List section provides information about the arrays. Table 21 provides information about the elements of the Array List section.

Table 21. Elements of the Array List Section, Array Status Window

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>The array number.</td>
</tr>
<tr>
<td>Partition</td>
<td>Drive letter that was assigned to this array during the partition process. (A blank space appears if the array has not been partitioned.)\n<strong>Note:</strong> If a dynamic volume is created on an array, RAIDxpert2 cannot retrieve the volume’s drive letter.</td>
</tr>
<tr>
<td>Array Name</td>
<td>User-created name for the array.</td>
</tr>
<tr>
<td>Type</td>
<td>The RAID level (RAID type) or LEGACY.</td>
</tr>
</tbody>
</table>
### Table 21. Elements of the Array List Section, Array Status Window (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Total Capacity  | Total capacity: 1 MB = 1,000,000 bytes 1 GB = 1,000,000,000 bytes  
**Note:** Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units. |
| State           | State of the array (NORMAL, CRITICAL, OFFLINE).                                                                                                                                                            |
| Task            | Task type, if in progress (TRANSFORM, CHECK, CHECK_BITMAP, CREATE, RESTORE, ZERO, SECURE_ERASE).                                                                                                        |
| Task State      | The state of the task (STARTED, PAUSED, COMPLETED); the progress of the task is given in the Array View section.                                                                                        |
| Pri             | Task priority if a task is in progress.                                                                                                                                                                   |
| Scan            | Background Array Scan enabled? (Yes/No).                                                                                                                                                                  |
| Cache           | Current cache setting (NC = No Cache, R = Read Ahead Cache, W = Write Back Cache, RW = Read/Write Cache).                                                                                               |
| Cache Tag size  | Any Array with only HDD/SSD will have default CTS of 64k  
Any Array with NVMe/HDD/SSD will have default CTS of 256k |  

### 9.4.4 The Event View Section of the Array Status Window

#### 9.4.4.1 Elements of the Event View Section

The Event View section is an optional-view section. It can be displayed or hidden by selecting View > Event View.

The information in the Event View is linked to the View Log. The View Log displays user-initiated tasks or actions, and system-generated notifications and events. The View Log can be accesses by selecting View > Log.

The Event View provides information about the events. Table 22, on page 93, provides information about the elements of the Event View section.
Table 22. Elements of the Event View Section, Array Status Window

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The number of the event.</td>
</tr>
<tr>
<td>Date</td>
<td>The date and time at which the event occurred.</td>
</tr>
<tr>
<td>Event</td>
<td>The RAIDXpert2 Asynchronous Event Notification (AEN) number of the event.</td>
</tr>
<tr>
<td>Priority</td>
<td>The notification priority of the event: Low, Informational, Warning, Critical, or Fatal.</td>
</tr>
<tr>
<td>Text</td>
<td>A brief description of the event.</td>
</tr>
</tbody>
</table>

9.4.5 Array and Disk Commands

The Array and Disk menus of the Array Status window contain lists of commands. The commands allow the system user to initiate or modify array- and disk-related tasks.

Not all commands are available for an array or for the system. Availability depends on:

- The tasks that can be performed with the system’s license level.
- The RAID level of an array. For example, a Consistency Check can be performed only on arrays at a redundant RAID level.
- The remaining capacity of the disk drives. For example, if a system has three disk drives and large arrays have used all of the capacity on two of the disks, only non-redundant Volume arrays can be created on the remaining disk. Certain commands are not available with a non-redundant array.
Table 23 provides page numbers for each command.

Table 23. Commands at the Array and Disk Menus

<table>
<thead>
<tr>
<th>Array Commands</th>
<th>See Detailed Information on this Page</th>
<th>Disk Commands</th>
<th>See Detailed Information on this Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>page 97</td>
<td>Initialize</td>
<td>page 94</td>
</tr>
<tr>
<td>Name</td>
<td>page 99</td>
<td>Rescan</td>
<td>page 95</td>
</tr>
<tr>
<td>Transform</td>
<td>page 100</td>
<td>Properties</td>
<td>page 95</td>
</tr>
<tr>
<td>Prepare to Remove</td>
<td>page 103</td>
<td>Options</td>
<td>page 96</td>
</tr>
<tr>
<td>Delete</td>
<td>page 104</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Cache Settings</td>
<td>page 105</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>page 106</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check Consistency</td>
<td>page 106</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Background Array Scan</td>
<td>page 108</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Spares</td>
<td>page 108</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide</td>
<td>page 109</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secure Erase</td>
<td>page 109</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9.5 Working with Disks

9.5.1 Initialize Disks

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the Disk List.

Note: All new disks and legacy disks will have an associated array. You must delete the array in order to initialize the disk.

9.5.1.1 To Initialize Disks

1. At the Disk menu, select Initialize. The Initialize Disk window displays.
2. Select the disk(s) to be initialized, by selecting the box next to the disk(s).
3. Click Initialize Selected.

### 9.5.2 Rescan Disks

The Rescan Command Performs the Following Actions:

- Rescans the SATA channels that search for new, legacy, or removed disks.
- Rereads the configuration information from each disk.

When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then automatically resumes all tasks.

To rescan disks, select Rescan at the Disk menu.

### 9.5.3 Change Cache Properties for Disks

The Read Ahead and Write Back Cache properties can be changed if the disks support this option. The default settings are:

- Read Ahead: enabled.
- Write Back Cache: enabled.

**CAUTION:** Leaving Write Back Cache enabled can increase the likelihood of data being corrupted if the system experiences a power interruption or unexpected shutdown.

**Note:** A disk’s cache setting cannot be changed if a task is active for the array. The cache settings are enabled when the task is finished.

**Note:** As default setting NVMe Physical disk Read ahead and Write Back cache is always disabled. User cannot enable the setting as it may impact the operational performance of the NVMe disk.

### 9.5.3.1 Change Disk Caching Properties

1. At the Disk menu, select Properties.
2. The Properties window opens.
3. Select the disks you want to change the properties of.
4. Click Enable or Disable for the desired settings.

**Note:** Each time Enable or Disable is clicked, the disk selection clears. To change multiple settings on one disk, select the disk before clicking each setting.
9.5.4 Assign Spares

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be used in any array, while dedicated spares are assigned to a specific array.

9.5.4.1 Assign a Disk as a Dedicated or Global Spare

1. In the Disk List section, select a disk.
2. At the Disk menu, select **Options**.
3. Options for Disk Device displays in the Disk List panel.
4. Perform one of the following actions:
   - To use the disk as a dedicated spare, select **Assign as Dedicated Spare**.
   
   **Note:** The capacity of a dedicated spare must be equal to or larger than the capacity of the smallest disk in the array.

   - To use the disk as a global spare, select Assign as Global Spare.

5. Click **Confirm**.

9.5.5 Legacy Disks

A legacy disk is a disk that contains valid data from a non-RAID controller.

A legacy disk appears in RAIDXpert2 (and in the BIOS Configuration Utility / RAIDXpert2 Configuration Utility (HII)) with a corresponding legacy array. When the legacy disk is initialized in RAIDXpert2 (or in the BIOS Configuration Utility / RAIDXpert2 Configuration Utility (HII)), the legacy array disappears.

**CAUTION:** A legacy disk can contain valid data. When a legacy array is deleted the data is lost.
9.5.5.1 Legacy Disk and New Disk

Table 24 provides information on how disks appear in RAIDXpert2 web utility and in the BIOS Configuration Utility.

Table 24. New and Legacy Disks, as They Appear in the BIOS Configuration Utility / RAIDXpert2 Configuration Utility (HII) and RAIDXpert2

<table>
<thead>
<tr>
<th>Status of the Disk</th>
<th>RAIDXpert2 Web Utility</th>
<th>In the BIOS Configuration Utility/RAIDXpert2 Configuration Utility (HII)</th>
</tr>
</thead>
<tbody>
<tr>
<td>New, un-initialized disk.</td>
<td>The disk appears as a new disk with a legacy array. When the new disk is initialized, its state changes to Online (or similar).</td>
<td>The disk appears as a new disk (the disk can appear with a legacy array). When the new disk is initialized, RAIDXpert2 configuration data is written to the disk. The disk state changes to Online.</td>
</tr>
<tr>
<td>A disk containing non-RAIDXpert2 configuration data.</td>
<td>The disk appears as a legacy disk with a legacy array. When the legacy array is deleted, the legacy array disappears and the legacy disk type changes to Disk. The disk can now be used in RAIDXpert2 arrays.</td>
<td>The disk appears as a legacy disk with a legacy array. When the legacy array is deleted the state of the legacy disk changes to Empty. The disk can now be used in RAIDXpert2 arrays.</td>
</tr>
</tbody>
</table>

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its corresponding legacy disk is initialized, the data is lost.

See Chapter 9, AMD RAIDXpert2 Graphical User Interface (GUI), on page 87, for the disk initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility.

9.6 Working with Arrays

9.6.1 Create and Format Arrays

RAIDXpert2 allows the partitioning and creation of as many as eight arrays across the system’s disks. Portions of disks can be used to create arrays, at the same time that other arrays use different portions of the same disks.

9.6.1.1 Before You Begin...

Review the issues and recommendations indicated in Table 25.
Table 25. Creating Arrays: Issues and Recommendations

<table>
<thead>
<tr>
<th>Issues</th>
<th>Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to arrays</td>
<td>The creation of arrays, even redundant arrays, allows users immediate access to the arrays (unless the Zero Create option is used during the Create process).</td>
</tr>
<tr>
<td>Array numbers</td>
<td>Array numbers are valid only for a given boot, and can be different in the BIOS Configuration Utility and RAIDXpert2. If a permanent label is required, use the Array Naming feature described in Section 9.6.2, Name Arrays, on page 99.</td>
</tr>
<tr>
<td>Array size</td>
<td>The array size of the new array is limited to 2.199 TB on some versions of Windows and Linux. Refer to the operating system documentation for details on maximum array sizes.</td>
</tr>
<tr>
<td>Number of arrays</td>
<td>In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported by AMD-RAID.</td>
</tr>
<tr>
<td>System reboot</td>
<td>When the system reboots, the creation process continues where it left off.</td>
</tr>
</tbody>
</table>

9.6.1.2 Create an Array

9.6.1.2.1 Select an Array and Cache
1. At the Array menu, select Create.
2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in the Select Active Disks: field.

*Note:* Click All to select all disks, or click Unused to select disks that are not currently used in an array. Maximum of 8 NVMe/HDD/SSD disks can be part of an array. If more than 8 disks, the Create button will be grayed out or unselectable.

3. Enter a name for the array in the Array Name: field.

*Note:* The following characters are not allowed in an array name

   ( ) ^ , | = “ ”

4. Select an array type at the Array Type: drop-down menu.
5. At the Organized As: drop-down menu select an option.

*Note:* The Organized As: drop-down menu only displays options for advanced management of a RAID10 configuration if you selected RAID10.

6. Enter the capacity in the Capacity: field. The maximum available capacity changes with:
• The disks that are selected.
• The RAID level of the array.

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and Write Back Cache.)

8. Cache Tag Size will default to a setting based off of the disks that are selected. All HDD/SSD, default will be 64k. All NVMe or a mix of NVMe/HDD/SSD will default to 256k. The user should not change from the default settings.

9. Check **Background Array Scan** to enable background array scanning. (A background array scan checks the sectors of the disks in an array for potential problems. A background array scan runs continuously, until the user stops it by accessing Array > Background Array Scan > Stop).

   **Note:** Please refer to Table 17 on page 52 for Default Cache Tag Size.

   **Note:** See Section 9.6.12, Scan an Array in the Background, on page 108, for details.

10. Check **Skip Initialize** to skip initialization.

    **CAUTION:** Creating a redundant array with Skip Initialization selected can result in data corruption.

11. **Check Leave Existing Data Intact** if an array is lost or deleted, and the user immediately creates a replacement array of the same characteristics. This leaves the data on the disks of the lost or deleted array untouched when the replacement array is created. See Table 44, on page 134, for additional information.

12. Check **Zero Create** to write zeros on the created array. If Zero Create is used, the array is not immediately available (the array is hidden from the operating system during the Create process).

13. Click **Create** to create the array.

### 9.6.1.3 Partition and Format an Array

Each operating system has different names and paths for partitioning and formatting arrays and as such are outside the scope of this document. For more information, see your operating system’s user documentation.

### 9.6.2 Name Arrays

Naming an array can be useful when creating backups. It makes an array easy to identify in a list of arrays.

1. In the **Array View** section, select the array to name.
2. At the **Array** menu, select **Name**. The **Array Name** window displays.
3. Type the desired name in the blank field.

   **Note:** The following characters are not allowed in an array name:
4. Click **OK**. The array name appears in the Array List and in the BIOS Configuration Utility (only 17 characters of the name are displayed in the BIOS Configuration Utility).

**9.6.3 Transform Arrays**

With the Transform task, an array can be:

- Transformed from one RAID level to almost any other RAID level. This function is also referred to as Online RAID Level Migration (ORLM).
- Expanded dynamically, even under I/O load, by adding disks to the array to increase the capacity of the array. This function is also referred to as Online Capacity Expansion (OCE).

**9.6.3.1 Before You Begin**

Review the issues and recommendations indicated in Table 26.

**Table 26. Transforming Arrays: Issues and Recommendations**

<table>
<thead>
<tr>
<th>Issues</th>
<th>Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array size</td>
<td>An array cannot be transformed to a smaller-sized array. The transformed array must be the same size as or larger than the original array.</td>
</tr>
<tr>
<td>Array size limits</td>
<td>The array size of the transformed array is limited to 2.199 TB on some versions of the Windows and Linux operating systems. Refer to the operating system documentation for details on maximum array sizes.</td>
</tr>
<tr>
<td>Disk failure during a Transform</td>
<td>If a disk fails while the Transform task is in progress, no data is lost as long as the source and destination RAID levels are redundant. If a spare has been assigned to the destination array, a fail-over task starts as soon as the Transform completes (if the spare is available after the Transform).</td>
</tr>
<tr>
<td>Multiple arrays</td>
<td>If there are multiple arrays, it might not be possible to transform some of the arrays to a larger size. If, in the future, an array needs to be expanded in size, it is best to configure the available space as a single array.</td>
</tr>
</tbody>
</table>
Table 26. Transforming Arrays: Issues and Recommendations (Continued)

<table>
<thead>
<tr>
<th>Issues</th>
<th>Recommendations</th>
</tr>
</thead>
</table>
| Task control commands         | When using task control commands, a Transform task can only be paused or resumed but not removed. To end a Transform task, pause and delete it.  
  *Note: If a task is paused and then deleted, the array is deleted. Deleting a task is the same as deleting an array. Data loss occurs when a task is deleted. Please ensure that data is backed up prior to deleting a task involving a Transform or a Restore.* |
| System reboot during a Transform | If the system reboots during a Transform, the Transform continues where it left off. |

9.6.3.2 Transform an Array

1. In the Array View section, select the array to transform.
2. At the Array menu, select Transform.
   *Note: If the system window is not wide enough, only the Destination View is displayed.*
3. Select all the desired disks for the array (including disks that might be already in the array) by selecting the box next to the drive in the Disk List section.
   *Note: Click Same to select all disks currently used in the array, All to select all disks, or Unused to select disks that are not currently used in an array.*
4. Select the RAID level to be transformed at the Array Type: drop-down menu.
5. At the Organized As: drop-down menu select an option.
   *Note: The Organized As: drop-down menu only displays options for advanced management of a RAID10 configuration if you selected RAID10.*
6. Expand the array by entering the size of the new array in the Capacity: field. The maximum available capacity changes with:
   - The disks that are selected.
   - The RAID level of the array.
   *Note: If a Transform is not possible, the Commit option is not enabled. A typical reason preventing a Transform is insufficient available space on the disks.*
7. Click Commit.
   *Note: Unless the transformation is instantaneous, the Array Status window updates to show the source and destination arrays, along with the progress of the transformation.*
9.6.3.3 Access Additional Space

After an array has been transformed to a larger size, use the operating system tools to access the additional space.

There are several possible methods for expanding the existing file system on an array that has been transformed to a larger size:

- Microsoft provides a command prompt utility called Diskpart.exe that can expand any NTFS file system without requiring a reboot. The Diskpart.exe utility version to use depends on the version of Windows being run. The Diskpart.exe utility can be found on the CD that comes with some versions of Windows, or at the Microsoft website (http://www.microsoft.com) for others. Use the correct version for the operating system.
- For arrays formatted with FAT32, use a third-party application, such as PartitionMagic from PowerQuest Corporation.

9.6.4 Restore (Rebuild) Arrays

With the Restore task, a redundant-type array whose state has changed to Critical can be restored (rebuilt) in one of two ways:

- By assigning a dedicated spare to the array.
- By creating a global spare or by using an existing global spare. (An existing global spare automatically starts restoring a redundant-type array after the array’s state changes to Critical.)

An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume, RAID0) cannot be restored: when a single disk in a non-redundant array fails, the array state changes to Offline.

Note: If a Critical redundant array that is being restored loses a second disk (RAID1), or loses a second disk in the same mirror set (RAID10), the Restore task fails. The array must be re-created from backup storage data.

9.6.4.1 Before You Begin

- Make sure that the disk chosen as the dedicated spare or global spare has sufficient available capacity to restore the array. The capacity of the spare disk must be equal to or larger than the capacity of the smallest disk in the critical array.
- Know how to create a global or dedicated spare. See Section 9.6.13, Add or Remove Dedicated Spares, on page 108 or Section 9.6.14, Add or Remove Global Spares, on page 109.

9.6.4.2 Restore a Critical Array

1. In the Array View section, select the critical array.
2. At the Disk List section, double click on a disk.

3. At the Disk menu, select Options. Options for Disk Device displays in the Disk List panel. Perform one of the following actions:
   - To use the disk as a dedicated spare, select Assign as Dedicated Spare.
   - To use the disk as a global spare, select Assign as Global Spare.

4. Click Confirm.

9.6.5 Prepare to Physically Remove an Array

9.6.5.1 Physically Remove an Array

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array (Linux).

1. In the Array View section, select the array to remove.

2. At the Array menu, select Prepare to Remove.

3. At the Prepare to Remove window, click Yes. The array and all associated disks disappear from the Array Status window.

4. Remove the first disk from the system.

5. When the Drive Removed window displays, click Cancel.

6. Remove the remaining disks in the array.

7. When all disks in the array are removed from the system, select Rescan at the Disk menu.

9.6.5.2 Array Migration

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal RAIDXpert2 disks and array(s).

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based system, the disks appear in Disk Management of the second system as healthy, unknown partitions. To use the disks, use Disk Management to delete the RAIDXpert2-created partitions and to create Windows partitions on the disks.

CAUTION: All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the array are migrated to a non-RAIDXpert2 system.
9.6.6  Delete Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

9.6.6.1 Before You Begin

Review the issues and recommendations indicated in Table 27.

Table 27. Deleting Arrays: Issues and Recommendations

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive letters or partitions</td>
<td>Remove drive letters or partitions from the array using procedures in your operating system. Each operating system has different names and paths for removing drive letters or partitions and as such are outside the scope of this document. For more information, see your operating system’s user documentation.</td>
</tr>
<tr>
<td>Operating system impact on arrays</td>
<td>If the array is not being used by the operating system, the array can be deleted at any time, even while tasks are running on the array. If the array is being used by the operating system, the array cannot be deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the BIOS Configuration Utility.</td>
</tr>
</tbody>
</table>

9.6.6.2 Delete an Array

1.  In the Array Status window, select the array to delete.
2.  At the Array menu, select Delete. A window opens, warning about deleting the array.
3.  Click OK. The array disappears from the Array View section.

   Note: Also see Section 10.5, Delete Arrays: rcadm --delete, on page 119.

9.6.6.3 Recreate a Deleted Array

If an array is deleted, it might be possible to recreate the array. See Table 44. Recreate a Deleted Array, on page 134.
9.6.7 Change Cache Settings for Arrays

Table 28 provides information about the four array-caching options available.

Table 28. Cache Array Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Cache</td>
<td>I/O requests are translated and passed to the disks without keeping a cached copy of the data available for future requests</td>
</tr>
<tr>
<td>Read Cache</td>
<td>Data reads are cached, if appropriate. This option performs sequential Read Ahead, when necessary</td>
</tr>
<tr>
<td>Write Back Cache</td>
<td>Data writes are cached. This setting is intended for advanced users who understand the implications of Write Back caching</td>
</tr>
<tr>
<td>Read + Write Back Cache (default setting)</td>
<td>Both Read and Write Back Cache options can be selected</td>
</tr>
</tbody>
</table>

Note: Cache options cannot be changed while a task is active on the array. They can be changed at any other time, including while I/O is running.

9.6.7.1 Change Cache Settings

1. In the Array View section, select the array on which to change caching options.
2. At the Array menu, select Modify Cache Settings.
3. Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache. The new cache setting displays in the Array List Cache information.

9.6.8 Change the Priority Level of a Task

The task priority command allows the user to speed up or slow down tasks being performed on arrays.

To decrease the amount of time it takes for a task to complete, set the task priority higher (10 is the highest).

Note: A task priority can only be changed after a task is running on the array.

9.6.8.1 Change a Task Priority

1. In the Array View section, select the array on which tasks are being performed.
2. At the Array menu, select Task and select Priority.
3. At the **Task Priority** window, change the task priority by moving the slide one way or the other.

4. Click **OK**.

### **9.6.9 Interrupt, Cancel, or Resume a Task**

The task control commands allow the user to pause, resume, or cancel (remove) tasks being performed on arrays.

Full task control can be used on Create, Consistency Check, and Check Bitmap tasks. On Restores with dedicated or global spares the task can be removed, but the array returns to the Critical state.

*Note: Task control can be used only when a task is running on an array.*

#### **9.6.9.1 Interrupt, Cancel, or Resume a Task**

1. In the **Array View** section, select the array on which a task is being performed.

2. At the **Array** menu, select **Task** then click:
   - **Pause** to interrupt the task.
   - **Remove** to cancel the task.
   - **Resume** to interrupt the task.

### **9.6.10 Check for Consistency**

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When this task is selected it starts the process of verifying that the mirror drive consistency for fault-tolerant disks is correct. If inconsistent areas are found, they are corrected during this process.

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost. RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent consistency checks. See Section 9.6.11, **Schedule a Consistency Check**, on page 107.

When a redundant array is created using the Create command, and the Skip Initialize option is not checked (the default setting), a Consistency Check is performed automatically. Although a Consistency Check that runs during a Create task can be removed (by highlighting the array and selecting **Task > Remove**), the array that is created is not redundant. Unless a Consistency Check runs from end-to-end, an array is not protected.

After a Consistency Check has been started, adjust the priority of the Consistency Check task relative to user I/O activity. Use the Task Priority option (see Section 9.6.8, **Change the Priority Level of a Task**, on page 105).

A Consistency Check task can be scheduled with the Schedule Consistency Check task (see Section 9.6.11, **Schedule a Consistency Check**, on page 107).
9.6.10.1 Before you Begin

- The Consistency Check command can be started at any time on a redundant-type array, as long as another task is not running on the array.
- The Consistency Check command can be started while under I/O load.
- If the array state is Critical, the Consistency Check fails.
- To estimate the remaining time for a Consistency Check, look at the percentage of the task that is completed (in hours: minutes: seconds). These details are displayed next to the array in the Array View section of the Array Status window.

9.6.10.2 Manually start a Consistency Check

1. In the Array View section, select the array on which to run the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Click Start.

9.6.10.3 Manually stop a Consistency Check

1. In the Array View section, select the array on which to stop the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Click Stop.

9.6.11 Schedule a Consistency Check

A Consistency Check task can be scheduled for later in the day or week. A Consistency Check task can be scheduled to run each week or each month.

*Note:* Schedule only one Consistency Check event on an array. This means that if a monthly check has been scheduled and a weekly check is desired, delete the monthly event and schedule the new event.

Table 29 provides information on the available scheduling options for a Consistency Check.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Time Only</td>
<td>Schedule the Consistency Check for the current day (“Today”) or up to seven days in the future.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Events can be scheduled weekly. After it is selected, a Consistency Check runs on the specified array at the same time each week.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Events can be scheduled to run once per month to run on the specified array at a specified time.</td>
</tr>
</tbody>
</table>
9.6.11.1 Schedule a Consistency Check for Later

1. In the Array View section, select the array on which to run the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Select Schedule.
4. At the Check Consistency window, select the Frequency, Day, and Time, then click Confirm.

9.6.11.2 Delete a Scheduled Consistency Check

1. In the Array View section, select the array to on which to delete the Consistency Check.
2. At the Array menu, select Check Consistency.
3. Select Schedule.
4. At the Consistency Check window, click Remove.

9.6.12 Scan an Array in the Background

A Background Array Scan task performs a continuous background read operation of an array, accessing at least one copy of every block of the array from beginning to end.

A Background Array Scan is manually started by the user and runs continuously until the user stops it.

Although a Background Array Scan can run while an array is engaged in other tasks, it is recommended that the Background Array Scan run while the array is idle (that is, when there is no I/O to or from the array).

9.6.12.1 Enable or Disable a Background Array Scan

1. In the Array View section, select the array to on which to run the Background Array Scan.
2. At the Array menu, select Background Array Scan.
3. Enable or disable the Background Array Scan.

   - To enable a Background Array Scan, select Start.
   - To disable a Background Array Scan, select Stop.

Note: A Background Array Scan can also be enabled for an array when it is created.

9.6.13 Add or Remove Dedicated Spares

If a dedicated spare is added, make sure there is adequate space on the dedicated spare.

9.6.13.1 Add a Dedicated Spare

1. In the Array View section, select the array on which to assign a dedicated spare.
2. In the Disk List section, double click on the disk chosen as the dedicated spare.
3. At the Disk menu, select Options.
4. Select Assign as Dedicated Spare, then click Confirm.

### 9.6.13.2 Remove a Dedicated Spare Assignment

1. In the Array View section, select the array from which to remove a dedicated spare.
2. At the Disk menu, select Options.
3. Select Remove as Dedicated Spare, then click Confirm.

_TIP:_ For additional information see Section 3.10, Sparing Options: Disks and Arrays, on page 33.

### 9.6.14 Add or Remove Global Spares

If a global spare is being added, make sure there is adequate space on the global spare.

#### 9.6.14.1 Add a Global Spare

1. In the Disk List section, select the disk chosen as the global spare.
2. At the Disk menu, select Options.
3. Select Assign as Global Spare, then click Confirm.

#### 9.6.14.2 Remove a Global Spare

1. In the Disk List section, select the disk to be removed as the global spare.
2. At the Disk menu, select Options.
3. Select Remove as Global Spare, then click Confirm.

### 9.6.15 Hide an Array

Hide allows the user to hide the array from the operating system.

#### 9.6.15.1 Hide an Array

1. In the Array View section, select the array to hide.
2. At the Array menu, select Hide. The array will disappear from the Array View.

*Note:* If the array is currently hidden, select Array > Un-hide to display it.

### 9.6.16 Secure Erase

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable, even with advanced data recovery techniques.

*Data is Securely Erased By:*

- Hiding the array from the OS
- Writing over each region of the disk with 3 patterns (0xAA, 0x55, and random)
Using a 4th pass with all zeros to ensure that a RAID1 will be consistent.

After the secure erase is complete, a user can choose to manually delete the array or reuse it. If the user chooses to reuse it, it must be unhidden using the procedure in Section 9.6.15, Hide an Array, on page 109.

**CAUTION:** When an array is securely erased, the data on the array is lost.

### 9.6.16.1 Securely Erasing an Array

1. In the Array View section, select the array to erase.
2. At the Array menu, select Secure Erase, then click OK.

### 9.7 Working with Views

The View menu allows the user to:

- Display the event view.
- Display the event log.
- Refresh the display.

#### 9.7.1 Display or Hide Controller Event Log Panel

To display or hide the Controller Event Log, select Event View at the View menu. When the Controller Event Log panel displays, a checkmark appears next to the Event View option at the View menu.

#### 9.7.2 Log Window

The [system name]: View Log window displays all of the messages generated by RAIDXpert2. All messages are logged, not just the ones enabled at Options > Notification.

All messages received from the RAIDXpert2 driver are sent to a message log file. If desired, change the name of this file in the Notification window.

By default, notification events in Windows-based systems are saved to:

```
%Program Files%\RAIDXpert2\rc_service.log.
```

Notification events in Linux-based systems are saved to ` /var/log/rc_service.log`.

At the View menu, select Log to view the RAIDXpert2 messages.

#### 9.7.3 Refresh the Display

To refresh the display, select Refresh at the View menu.
9.8  Working with Options

9.8.1  Change Password Settings

A password can be changed at the Options menu. See Section 9.2.2, Change a Password at the Options Menu, on page 89.

9.8.2  Set Event Notifications

With the Notification option, the user can set the level of event notifications.

The Event View section of the Array Status window displays the priority listing. The event log priority levels, in ascending order, are indicated in Table 30.

Table 30. Event Log Priority Levels

<table>
<thead>
<tr>
<th>Event Priority</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Displays messages for normal system operations. (This event is not displayed unless requested by the user.)</td>
</tr>
<tr>
<td>Informational</td>
<td>Displays information that might be useful to know.</td>
</tr>
<tr>
<td>Warning</td>
<td>The system user should to be informed about this event, but probably does not need to take action.</td>
</tr>
<tr>
<td>Critical</td>
<td>The system user must be informed about this event and should take action.</td>
</tr>
<tr>
<td>Fatal</td>
<td>The RAIDXpert2 driver is fatally damaged and the RAID subsystem has shut down.</td>
</tr>
</tbody>
</table>

9.8.3  Licensing

To display Licensing information, including available licensing levels, select License at the Options menu.

9.9  Add Spares Using a RAIDABLE Array

*Note:* RAIDABLE array is formerly known as RAID Ready array.

1. Install a new disk. After a rescan, a pop-up window opens.

*Note:* To create a redundant RAID1 array, the new disk must be the same size or greater than the RAIDABLE disk.

2. In the Select a Disk section, select the new disk.

3. In the Choose a Task section, select the desired option.
Note: Selecting any option first initializes the disk before the selected task is started.

a. **Backup Array**: This option creates a backup of the RAIDABLE array on the new disk.
b. **Transform Array**: This option allows the user to either add space to the RAIDABLE array or create a redundant array.
c. **Initialize Disk for AMD-RAID**: This option allows the disk to be used when creating arrays.
d. **Make disk a Global Spare**: This option assigns the new disk as a global spare.

4. In the Select a Source/Destination section:
   a. Select the Source RAIDABLE Array from the drop-down menu.
   b. Select the **Destination Array Type** from the drop-down menu.

   Note: The **Destination Array Type** option is only available when either the Backup Array task or Transform Array task is selected. Only valid array types for the number of disks inserted will be displayed. For example, if one new disk is inserted, only RAID0 or RAID1 will display in the drop-down menu.

5. Click **Confirm**.

   If either the Backup Array task or Transform Array task is selected, a Task Progress dialog box opens. To hide the dialog box while the task is executing, click Close.
Chapter 10  \texttt{rcadm} Command Line Interface Tool

10.1  \textbf{What is \texttt{rcadm}?}

The \texttt{rcadm} program is a command line interface (CLI) tool for managing RAIDXpert2 in the Windows, Linux, or EFI operating system. See Section 10.8, on page 120, for \texttt{rcadm.efi} Information.

The \texttt{rcadm} program initiates RAIDXpert2 operations, such as:

- Manage RAIDXpert2, arrays and disks (see Section 10.2, Manage Arrays and Disks: \texttt{rcadm --manage}, on page 114).
- Create new arrays (see Section 10.4, Create New Arrays: \texttt{rcadm --create}, on page 118).
  - Delete arrays (see Section 10.5, Delete Arrays: \texttt{rcadm --delete}, on page 119).
- Transform arrays (see Section 10.6, Transform Arrays: \texttt{rcadm --transform}, on page 120).
- Follow or monitor arrays and disks (see Section 10.7, Follow or Monitor Arrays and Disks: \texttt{rcadm --follow}, on page 120).
- Information on drive and array states.

The \texttt{rcadm} program has five primary modes, with most primary modes having additional optional arguments. The five modes of operation are indicated in Table 39.

\begin{table}[h]
\centering
\begin{tabular}{|l|p{12cm}|}
\hline
\textbf{Mode} & \textbf{Usage} \\
\hline
Manage & Uses the \texttt{rcadm --manage} command to manage and query RAIDXpert2, arrays, and disks. \\
\hline
Create & Uses the \texttt{rcadm --create} command to create a new array. \\
\hline
Delete & Uses the \texttt{rcadm --delete} command to delete arrays. \\
\hline
Transform & Uses the \texttt{rcadm --transform} command to transform an array. \\
\hline
Follow & Uses the \texttt{rcadm --follow} command to follow or monitor arrays and disks. \\
\hline
\end{tabular}
\caption{Modes for the \texttt{rcadm} Program}
\end{table}

Follow these instructions to issue the command on the operating system. Also, see Section 10.3, View Help from the Command Line, on page 118.
10.1.1 To Use rcadm with a Linux® Operating System

By default, rcadm is installed in /usr/bin.

10.1.2 To Use rcadm with a Windows® Operating System

- Change directories to %Program Files%\RAIDXpert2.
- Run the rcadm.exe command from there.
  or
- Add %Program Files%\RAIDXpert2 to the system or user path environment variables.

10.2 Manage Arrays and Disks: rcadm --manage

The rcadm --manage or rcadm -M command allows the user to view information about RAIDXpert2 and manage the arrays and disks.

For example, the user can:

- Set cache attributes for arrays.
- Set priority levels for tasks on an array.
- Hide and unhide arrays.
- List arrays.
- Initialize disks.
- Query information about disks.
- Add and remove spares from an array.
- Set cache attributes for disks.

10.2.1 Understand Query Output

When the rcadm --manage --query-all or rcadm -M -qa command is used, information about the disks and arrays for the system is displayed.

To see information about a specific controller, disk, or array use the rcadm --manage --query command, in conjunction with the appropriate options.
### 10.2.2 `rcadm` Controller List Elements

**Table 32. `rcadm` Controller List Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Controller number assigned by RAIDXpert2</td>
</tr>
<tr>
<td>Type</td>
<td>Model number of the controller</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Serial number of the controller</td>
</tr>
<tr>
<td>Port Count</td>
<td>The number of ports supported by RAIDXpert2</td>
</tr>
<tr>
<td>PCIe Vendor ID</td>
<td>The PCIe vendor identification number</td>
</tr>
<tr>
<td>PCIe Device ID</td>
<td>The PCIe device identification number</td>
</tr>
<tr>
<td>PCIe SubVendor ID</td>
<td>The PCIe sub-vendor identification number</td>
</tr>
<tr>
<td>PCIe SubDevice ID</td>
<td>The PCIe sub-device identification number</td>
</tr>
<tr>
<td>SAS Address (WWID)</td>
<td>The SAS Address (world-wide identification number)</td>
</tr>
<tr>
<td>BIOS Version</td>
<td>The version of the AMD-RAID Configuration BIOS</td>
</tr>
</tbody>
</table>
10.2.3 *rcadm* Disk List Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk</td>
<td>Disk number assigned by RAIDXpert2, corresponding to the SATA channel ID.</td>
</tr>
<tr>
<td>State</td>
<td>State of the disk (Online, Failed, Unknown)</td>
</tr>
<tr>
<td>Disk Type</td>
<td>Disk type (Disk, Legacy, New, ATAPI)</td>
</tr>
<tr>
<td>Port Type</td>
<td>Port type (SATA, SATA II, SATA III, SSD, NVMe)</td>
</tr>
<tr>
<td>Port Speed</td>
<td>The negotiated speed of the port. <em>Note: For NVMe the port type is always N/A.</em></td>
</tr>
<tr>
<td>Size</td>
<td>Total size of the disk: <em>Note: Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units.</em></td>
</tr>
<tr>
<td>Free Space</td>
<td>Total amount of space unused on the disk</td>
</tr>
<tr>
<td>Largest Free Space</td>
<td>Largest contiguous unused space on the disk</td>
</tr>
<tr>
<td>GS</td>
<td>Indicates if the disk is assigned as a global spare</td>
</tr>
<tr>
<td>Ca</td>
<td>Current disk cache setting (NC = No Cache, R = Read Cache, W = Write Back Cache, RW = Read + Write Back Cache). <em>Note: For NVMe the CA is always NC.</em></td>
</tr>
<tr>
<td>Ctrl Chan</td>
<td>Disk controller and channel number.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Disk vendor</td>
</tr>
<tr>
<td>Model Number</td>
<td>Disk model number</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>Disk firmware version</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Disk serial number</td>
</tr>
</tbody>
</table>
## 10.2.4 \textit{rcadm} Array List Elements

Table 34. \textit{rcadm} Array List Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Array number assigned by RAIDXpert2</td>
</tr>
<tr>
<td>Type</td>
<td>RAID type.</td>
</tr>
<tr>
<td>O.S. Name</td>
<td>Name assigned by the operating system to the array. The name shows as “Hidden” if the array is hidden from the operating system. The name shows “??” if the array is Offline.</td>
</tr>
<tr>
<td>Sys or System Device</td>
<td>Indicates whether or not the array is being used as a system disk under Windows</td>
</tr>
<tr>
<td>State</td>
<td>State of the array (Normal, Critical, Offline)</td>
</tr>
</tbody>
</table>
| Size or Capacity   | Total size of the disk:                                                                                           
|                    | • 1 MB = 1,000,000 bytes                                                                                                                                           |
|                    | • 1 GB = 1,000,000,000 bytes                                                                                                                                 |
|                    | \textit{Note:} Because the ATA storage industry has standardized the meanings of MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 reports the same units. |
| Hide               | Whether the array is hidden from the operating system                                                            |
| Id                 | Globally unique identifier for the array assigned by RAIDXpert2                                                                                                                                         |
| Task               | Task type (Transform, Check, Check_Bitmap, Not_Active, Create, Restore)                                                                                                                                      |
|                    | \textit{Note:} See Section 3.7, Array Tasks: Starting and Stopping Tasks, on page 30 for detailed definitions.                                                                                             |
| Task State         | The state of the task (Started, Paused, Completed)                                                                                               |
| %                  | The progress of a current array task, such as a Create or Transform, shown as percent complete                                                                   |
| CA                 | Current array cache setting (NC=No Cache, R=Read Cache, W=Write Back Cache, RW=Read + Write Back Cache).                                                                                               |
Table 34. rcadm Array List Elements (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Cache tag size specifies the amount of data per disk in a stripe. Supported sizes are 64kB, 128kB or 256kB. Any Array with only HDD/SSD will have default CTS of 64k. Any Array with NVMe/HDD/SSD will have default CTS of 256k.</td>
</tr>
<tr>
<td>Scan</td>
<td>Background scan enabled (Yes/No)</td>
</tr>
<tr>
<td>Name</td>
<td>User-supplied name for the array</td>
</tr>
<tr>
<td>Dedicated Spare</td>
<td>Indicates the number of dedicated spares assigned to the array (--verbose mode only).</td>
</tr>
<tr>
<td>Disk</td>
<td>Listing of disks that are part of the array</td>
</tr>
<tr>
<td>Used</td>
<td>Capacity used of a specific disk</td>
</tr>
<tr>
<td>Offset</td>
<td>Location on the disk where the array begins</td>
</tr>
</tbody>
</table>

## 10.3 View Help from the Command Line

### 10.3.1 To view a List of the Major Modes of Operation

Type: `rcadm --help` or `rcadm -?`

### 10.3.1.1 To View Help for a Specific Mode and its Options

Type: `rcadm <mode> --help` or `rcadm <mode> -?`

For example, typing `rcadm --manage --help` or `rcadm --M -?` displays help and examples regarding that specific mode and its options.

### 10.3.1.2 To view the rcadm Man Page on a Linux® System

Type: `man rcadm`

## 10.4 Create New Arrays: `rcadm --create`

The `rcadm --create` or `rcadm -C` command allows new arrays to be created. As many as eight arrays can be partitioned and created across all disks.
Portions of disks can be used to create arrays, while other arrays are using different portions of the same disks. A maximum of eight arrays can be created.

10.4.1 Before You Begin...

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the system reboots, the creation process continues where it left off.

**CAUTION:** In some circumstances, more than eight arrays are possible. They might appear to function properly, but are not supported.

**Note:** The array size of the new array is limited to 2.199 TB with some operating systems. Refer to the operating system documentation for details on maximum array sizes.

**Note:** The ability to create RAID10 or RAIDABLE arrays may not be available on your system.

10.4.2 Example

To create a 1 GB RAID1 array using disk members 1, 2, and 3, type:

```
rcadm -C -r1 -d 1 2 -s 1000
```

To see more examples, type: `rcadm -C -?`

10.5 Delete Arrays: `rcadm --delete`

The `rcadm --delete` or `rcadm -D` command allows the user to delete one or more arrays.

**CAUTION:** Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.

10.5.1 Before You Begin...

- If the operating system is using an array it cannot be deleted.
- If an array is accidentally deleted, and the user wants to try and recover the data, create an array using the same disks, same size, and same cache, and use the `--leave-existing-data` option. This option writes new configuration information to the array while trying to use the exact same disk space as before.

10.5.2 Example

To delete array 1, type: `rcadm -D -a 1`

To see more examples, type `rcadm -D -?`
10.6 Transform Arrays: \texttt{rcadm --transform}

The \texttt{rcadm --transform} or \texttt{rcadm -T} command allows the user to transform (migrate) an array from one RAID level to almost any other RAID level, and to expand the array dynamically, even under I/O load.

10.6.1 Before You Begin...

- An array cannot be transformed to a smaller-sized array. New arrays must be either the same capacity or larger.
- When using the task control option, a Transform can only be paused or resumed but not removed.
- If a spare has been assigned to the destination array, a fail-over task starts as soon as the Transform completes, provided the spare is available after the Transform.
- If there are multiple arrays on a single controller, it might not be possible to transform some of the arrays to a larger size. If the size of an array might be expanded in the future, it is best to configure the available space as a single array.
- The array size of the transformed array is limited to 2.199 TB on some operating systems.

10.7 Follow or Monitor Arrays and Disks: \texttt{rcadm --follow}

The \texttt{rcadm --follow} or \texttt{rcadm -F} command allows the user to follow or monitor arrays and disks. It polls the RAID subsystem for any status changes and logs them in the Windows System Event Log.

10.7.1 Before You Begin...

It is recommended that the user not run more than one instance of \texttt{rcadm --follow} at the same time. If the user runs more than one instance of the command, each instance captures some of the events, but no single instance captures all events.

10.8 \texttt{rcadm.efi} Information

10.8.1 \texttt{rcadm -?}

-\?, --help

Displays all primary \texttt{rcadm} commands, or if used after an option, displays help for that specific option.

-\log, --log-file
Print output to a log file as well as standard output. Requires a log file name argument. Overwrites existing file. Only one occurrence of this option on the command line is allowed.

Example: rcadm -M -qa -v -log status.txt

-C, --create

Command for creating arrays. Array types include linear (JBOD), volume (JBOD), RAID0, RAID1, RAID10, RAID10n, and RAIDABLE. Some of the major functions include assigning spare disks; setting array size; and setting cache attributes.

-D, --delete

Command for deleting arrays. This mode does not have any optional arguments.

-M, --manage

Commands for managing and querying controllers, arrays, and disks. Some of the major functions include querying for information, adding and removing dedicated and global spare disks, setting cache attributes for arrays and disks, performing consistency checks on redundant array types, initializing disks, prioritizing tasks for arrays, scanning arrays and disks for changes in status, and hiding or unhiding arrays.

10.8.2 rcadm -M

MANAGE

-a, --array

Used with certain options to specify arrays.

-as, --add-spare

Adds a dedicated spare disk to an array. No space is reserved on the disk selected.

-rs, --remove-spare

Removes a dedicated spare disk from an array.

-ras, --remove-all-spares

Removes any spares from an array.

-ags, --add-global-spare

Adds a disk as a global spare. No space is reserved on the disk selected.

-rgs, --remove-global-spare

Removes a global spare disk.

-ca, --cache-array
Sets the cache attributes for an array. Cache attributes include read cache (r), read and writeback cache (rw), write-back cache (w), and no cache (nc).

-\texttt{cd}, --\texttt{cache-disk}

Sets the cache attributes for a disk. Cache attributes include read cache (r), read and writeback cache (rw), write-back cache (w), and no cache (nc).

-\texttt{d}, --\texttt{disk}

A required qualifier used with certain options to specify disks.

-\texttt{h}, --\texttt{hide}

Hides an array from the operating system.

-\texttt{uh}, --\texttt{unhide}

Unhides an array, making it visible to the operating system.

-\texttt{id}, --\texttt{initialize-disk}

Initializes a disk. If the disk is new and has not been used, you must initialize it before you can create arrays.

-\texttt{n}, --\texttt{name}

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of those characters display in the BIOS.

-\texttt{p}, --\texttt{priority}

Sets an array's task priority from 1-10, with 10 being the highest priority.

-\texttt{q}, --\texttt{query}

Lists information about specific controllers, arrays, and disks.

-\texttt{qa}, --\texttt{query-all}

Lists information about controllers, arrays, and disks.

-\texttt{v}, --\texttt{verbose}

Modifier of the --query and --query-all option. Specifies more detail for arrays and disks.

-\texttt{rsc}, --\texttt{rescan}

Rescans the serial ATA (SATA) channels for new or removed disks.

-\texttt{sa}, --\texttt{scan-array} <on|off>

Specifies if background array scan scanning is on or off.
-sp, --smart-poll
   Turns SMART polling on or off for the specified drive(s).

-t, --task
   Used to pause, resume, and remove tasks.

-ul, --unlink
   Unlinks two arrays linked through a create copy operation.

SYNTAX and EXAMPLES

ADD SPARE

   --add-spare --array <list> --disk <list>
   -as -a <list> -d <list>

   Examples: rcadm --manage --add-spare --array * --disk 1
              rcadm -M -as -a 1 2 -d 5 6

REMOVE SPARE

   --remove-spare --array <list> --disk <list>
   -rs -a <list> -d <list>

   Examples: rcadm --manage --remove-spare --array 5 --disk *
              rcadm -M -rs -a * -d 5

REMOVE ALL SPARES

   --remove-all-spares --array <list>
   -ras -a <list>

   Examples: rcadm --manage --remove-all-spares --array 5
              rcadm -M -ras -a *

ADD GLOBAL SPARE

   --add-global-spare --disk <list>
   -ags -d <list>

   Examples: rcadm --manage --add-global-spare --disk 1 2 3
              rcadm -M -ags -d *

REMOVE GLOBAL SPARE

   --remove-global-spare --disk <list>
   -rgs -d <list>

   Examples: rcadm --manage --remove-global-spare --disk *
rcadm -M -rgs -d 5

CACHE SETTINGS FOR ARRAYS

--cache-array <cache_attribute> --array <list>
-ca <cache_attribute> -a <list>
Cache attributes: <r> for read cache
$r$ for read and write-back cache
$w$ for write-back cache
$nc$ for no cache
Examples: rcadm --manage --cache-array rw --array *
rcadm -M -ca nc -a 1

DISK SETTINGS (Advanced)

Disk cache:

--cache-disk <cache_attribute> --disk <list>
-cd <cache_attribute> -d <list>
Cache attributes: <r> for read cache
$rw$ for read and write-back cache
$w$ for write-back cache
$nc$ for no cache
Examples: rcadm --manage --cache-disk r --disk 1 2 3
rcadm -M -cd w -d *

HIDE ARRAY

--hide --array <list>
-h -a <list>
Examples: rcadm --manage --hide --array 5 6
rcadm -M -h -a 4

UNHIDE ARRAY

--unhide --array <list>
-uh -a <list>
Examples: rcadm --manage --unhide --array *
rcadm -M -uh -a 5

INITIALIZE DISK

--initialize-disk --disk <list>
-id -d <list>
Examples: rcadm --manage --initialize-disk --disk *
           rcadm -M -id -d 1 2 3

NAME ARRAY
  --name "name" --array <list>
  -n "name" -a <list>
Examples: rcadm --manage --name "System Disk" --array 5
           rcadm -M -n "Backup Disk" -a 4

QUERY
  --query [--array <list>] [--disk <list>] [--verbose]
  -q [-a <list>] [-ct <list>] [-d <list>] [-v]
Examples: rcadm --manage --query --array 1 --disk --verbose
           rcadm -M -q -a 1 2 3 -d -v

QUERY ALL
  --query-all
  -qa
Example: rcadm --manage --query-all

RESCAN DISKS
  --rescan
  -rsc
Example: rcadm --manage --rescan

SCAN ARRAY
  --scan-array <on|off> --array <array_number>
  -sa <on|off> -a <array_number>
Example: rcadm -M --array 1 --scan-array on
         rcadm -M -a 1 -sa off

SMART POLL
  --smart-poll <on|off> --disk <list>
  -sp <on|off> -d <list>
Example: rcadm --manage --smart-poll on --disk
         rcadm -M -sp off -d 1 2 3

TASK CONTROL
  --task <task_operation> --array <array_number>
  -t <task_operation> -a <array_number>
Task Operation
<pause> to temporarily pause a task
<resume> to continue running a task
<remove> to permanently remove a task
Examples: rcadm --manage --task pause --array 5
rcadm -M -t remove -a 4

TASK PRIORITY
--priority <1..10> --array <list>
-p <1..10> -a <list>
Examples: rcadm --manage --priority 5 --array 6
rcadm -M -p 1 -a

UNLINK ARRAY
--unlink --array <array_number>
-ul -a <array_number>
Examples: rcadm --manage --unlink --array 2
rcadm -M -ul -a 5

10.8.3 rcadm -C

CREATE
Long form:
rcadm --create <raid_type> --disk <list> [--size <size_mb>]
[--sub-member <num>] [--spare-disk <list>]
[--no-sync] [--d-spare] [--cache <r,rw,w,nc>]
[--max-size] [--name "name"] [--priority <1..10>]
[--zero][--scan-array]

Short form:
rcadm -C <raid_type> -d <list> [-s <size_mb>] [-sub <num>]
[-sp <list>] [-ns] [-ds] [-ca <r, rw, w, nc>] [-ms]
[-n "name"] [-p <1..10>] [-z] [-sa] }

RAID Types:
--volume, -v Single disk or concatenation of disks (JBOD)
--raidable, -ra Single disk, RAIDABLE
--raid0, -r0 Stripe of two or more disks
--raid1, -r1  Mirror of two disks
--raid10, -r10  Stripe set of mirror sets

OPTIONS
- sp, --spare-disk
Specifies the dedicated spare disk or disks to assign, with a maximum of four. No space is reserved on the selected disks.

-s, --size
Specifies the size of the array in MBs. If you do not use this option, the largest possible size is used by default.

-ns, --no-sync
Disables background synchronization of redundant types when creating the array.

-ca, --cache
Specifies a cache setting for the array(s): read cache <r>, read and write-back cache <rw>, write-back cache <w>, or no cache <nc>. The default is read and write-back cache <rw>.

-cts, --cachetagsize
Specifies the Cache Tag Size. This is the amount of data per disk in a stripe. Supported sizes are 64, 128, or 256; sizes in kB.

Please refer to Table 17, Default Cache Tag Size, on page 52.

-ms, --max-size
Prints the maximum possible size for an array without actually creating an array.

-n, --name
Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of those characters display in the BIOS.

-p, --priority
Sets the background initialization task priority from 1 to 10, with 10 being the highest priority. For redundant array types only.

-led, --leave-existing-data
Leaves the existing data on the disks untouched after the array is created. This option can be used to try to recover user data when an array has been accidentally deleted or the configuration information is lost but the data is still intact. Unless you immediately recreate the array after deleting it and no other tasks have been performed, the likelihood of recovering data with this method is very low.

-d, --disk
A required qualifier used with the --create option to specify the disk or disks to be included in the array.
-sa, --scan-array
Specifies that a background array scan should be continuously run whenever the array is idle (Default is off).

-z, --zero
Zero the array in the foreground. This method is faster than doing a background consistency verifies if the array is a redundant type. For non-redundant types, the zero option can be used to verify all blocks in the array can be accessed.

EXAMPLES
Example: Create a RAID1 set of the maximum possible size using all disks.
   \texttt{rcadm} \texttt{-C} \texttt{--raid} 1 \texttt{--disk} *

Example: Create a RAID1 set of the maximum possible size, with a spare disk and without a background initialization task.
   \texttt{rcadm} \texttt{-C} \texttt{--raid} 1 \texttt{--spare-disk} 3 \texttt{--disk} 1 2 \texttt{--no-sync}

10.8.4  \texttt{rcadm -D}
DELETE
Long form:
   \texttt{--delete} \texttt{--array} <list> [\texttt{--no-ask}]
Short form:
   \texttt{-D} \texttt{-a} <list> [-\texttt{na}] [-\texttt{cg} <group number>]
OPTIONS
   \texttt{-na, --no-ask}
If the no ask option is specified the array is deleted without confirmation.

EXAMPLES
Example: Delete arrays 1 and 2.
   \texttt{rcadm} \texttt{-D} \texttt{--array} 1 2
Example: Delete all arrays.
   \texttt{rcadm} \texttt{-D} \texttt{--array}
Chapter 11 Troubleshooting

11.1 Troubleshooting

The chapter discusses four major categories of troubleshooting:

- Problems with system startup.
- Warning messages that might appear at the Power-On Self-Test (POST) screen.
- Problems with arrays.
- Problems with disks.

11.2 System Startup Problems

Table 35 and Table 36 correlate possible startup issues and corrective actions for system boot.

Table 35. The System Does Not Boot

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller mode is set incorrectly during system startup</td>
<td>In the system’s BIOS screen, ensure SATA settings are in RAID mode.</td>
</tr>
<tr>
<td>The system’s boot mode or boot sequence retry mode is set incorrectly</td>
<td>In the system’s BIOS screen, ensure that the bootable array is the first array listed. If not, use the Swap Two Arrays option to reposition the arrays.</td>
</tr>
<tr>
<td>A bootable array is in an Offline state</td>
<td>Restart the system. Enter the system’s BIOS screen. Check the state of the bootable array. Check for missing or offline disks.</td>
</tr>
</tbody>
</table>

Table 36. The BIOS Configuration Utility Does Not Display

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The controller mode is set incorrectly in the system BIOS</td>
<td>In the system’s BIOS screen, ensure the SATA settings are correct.</td>
</tr>
</tbody>
</table>
Table 37. Username and Password

<table>
<thead>
<tr>
<th>Problem</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A user forgets the username or password.</td>
<td>Reset the username and password by deleting <em>rc_login.txt</em>. This restores the default user name and password (<em>admin</em> and <em>admin</em>).</td>
</tr>
</tbody>
</table>

11.3  **Warning Messages: POST Screen**

The POST screen is one of the first screens to appear during the system’s boot sequence. If the system’s arrays were in Normal or Ready state prior to a system boot, the boot sequence continues normally to the operating system.

But, if an array is in Critical or Offline state, or if specific options at Controller Options were changed previously at the BIOS Configuration Utility, the warning messages displayed by OProm are described in Table 38 appear during the boot sequence.

**Table 38. POST Screen Warning Messages**

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Additional Information</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WARNING: Found arrays that are Critical [or equivalent]</strong></td>
<td>This warning message appears when at least one array is in a Critical state and Toggle Pause if Critical is set to ON at the BIOS Configuration Utility. The Critical state of an array depends on the RAID level of the array and the number of disks that have failed. See Section 3.3, Array States, on page 27, for information on criticality. If an array is Critical (even a bootable array), the system can continue through the boot process to the operating system.</td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135.</td>
</tr>
</tbody>
</table>
Table 38. POST Screen Warning Messages (Continued)

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Additional Information</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WARNING: Found arrays that are Offline [or equivalent]</strong></td>
<td>This warning message appears when at least one array is in an Offline state and <strong>Toggle Pause if Offline</strong> is set to <strong>ON</strong> at the BIOS Configuration Utility. If two or more disks in a redundant array have failed, or if a single or multiple disks in a non-redundant array have failed, data has been lost. In RAID10 array, if a single disk fails in each mirrored set, the redundant array goes to a Critical state but data is not lost. If two disks fail in one of the mirrored sets, the redundant array goes to an Offline state and data is lost.</td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135. If, after performing a rescan, the state remains Offline, the bootable array has suffered an unrecoverable failure. Create a new bootable array. Reinstall the operating system and drivers.</td>
</tr>
<tr>
<td><strong>WARNING: Found arrays that are Critical and Offline [or equivalent]</strong></td>
<td>A bootable array that is in an Offline state prevents the operating system from booting.</td>
<td></td>
</tr>
<tr>
<td><strong>BIOS NOT INSTALLED - User Disabled INT13 BIOS Load [or equivalent]</strong></td>
<td>This warning message appears when <strong>Toggle INT13 Boot Support</strong> option has been set to <strong>OFF</strong> at the BIOS Configuration Utility and another boot device is not selected. Bootable devices do not function with the controller when <strong>Toggle INT13 Boot Support</strong> is set to <strong>OFF</strong>. The default setting is <strong>ON</strong>, which allows bootable devices to function with the controller.</td>
<td>Restart the system. Enter the system’s BIOS screen. Select <strong>Main Menu &gt; Controller Options &gt; Toggle INT13 Boot Support</strong>. Change <strong>Toggle INT13 Boot Support</strong> from <strong>OFF</strong> to <strong>ON</strong>. Navigate to Main Menu. Select <strong>Continue to Boot</strong>. The system boot process continues to the operating system.</td>
</tr>
</tbody>
</table>

### 11.4 Array-Related Errors

- Table 39. Cannot Create an Array, on page 132
- Table 41. An Array is in an Offline State, on page 133
- Table 40. An Array is in a Critical State, on page 133
- Table 42. Cannot Assign a Dedicated Spare to an Array, on page 133
- Table 43. Cannot Create a Global Spare, on page 134
- Table 44. Recreate a Deleted Array, on page 134
### Table 39. Cannot Create an Array

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The disk is not displayed.</td>
<td>The controller cannot communicate with the disks.</td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135.</td>
</tr>
<tr>
<td>Insufficient free space available on the selected disks</td>
<td></td>
<td>Select a different combination of disks.</td>
</tr>
<tr>
<td>Incorrect number of disks selected for the desired RAID level</td>
<td>See 3.2, RAID Levels, on page 26, for a description of RAID levels and the allowable number of disks used with each RAID level.</td>
<td>Select the correct number of disks.</td>
</tr>
<tr>
<td>The desired disk is unavailable.</td>
<td>The disk is a dedicated spare for a different array.</td>
<td>Select a different disk.</td>
</tr>
<tr>
<td></td>
<td>The disk is full.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The disk’s available capacity is insufficient.</td>
<td></td>
</tr>
<tr>
<td>The disk has SMART errors.</td>
<td>An array can be created with a disk that has SMART errors, but only if the array is created in the BIOS Configuration Utility. RAIDXpert2 cannot be used to create an array with a disk that has SMART errors.</td>
<td>Use the BIOS Configuration Utility to create the array.</td>
</tr>
<tr>
<td>The system already has a maximum of eight arrays</td>
<td></td>
<td>Delete unused arrays.</td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION:</strong> Deleting an array permanently destroys all data that is on the array. This action cannot be undone and it is very unlikely the data can be recovered.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 40. An Array is in a Critical State

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>One or more disks in the array have failed or been removed.</td>
<td>Due to the failed disk or disks, the array is no longer maintaining redundant (mirrored or parity) data. The failure of an additional disk results in an Offline state and lost data.</td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135.</td>
</tr>
</tbody>
</table>

### Table 41. An Array is in an Offline State

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The array has lost the maximum allowable disks per RAID level.</td>
<td>One or more disks have failed.</td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135.</td>
</tr>
<tr>
<td></td>
<td>• If the array is non-redundant, the failure of a single disk causes the array to fail.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the array is redundant, the failure of two or more disks causes the array to fail.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The array cannot be restored (rebuilt).</td>
<td></td>
</tr>
</tbody>
</table>

### Table 42. Cannot Assign a Dedicated Spare to an Array

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The RAID level does not allow dedicated spares.</td>
<td>Dedicated spares cannot be created for Volume or RAID0 arrays.</td>
<td>• Create an array with a different RAID level and assign a dedicated spare.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create a global spare.</td>
</tr>
<tr>
<td>The designated disk does not have sufficient capacity to be a dedicated spare</td>
<td>The capacity of the disk selected to be a dedicated spare must be equal to or larger than the capacity of the smallest disk in the array.</td>
<td>Select a different disk.</td>
</tr>
</tbody>
</table>
Table 43. Cannot Create a Global Spare

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The disk is already part of an array</td>
<td>A global spare cannot be selected if it is already part of an existing array.</td>
<td>Select a different disk.</td>
</tr>
<tr>
<td>There are no empty disks available or the disks have not been initialized</td>
<td>A disk with a legacy state can be initialized, if desired, but it is no longer legacy (initialization adds RAIDXpert2 configuration information to the disk).</td>
<td>Install additional disks. Initialize the disks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>CAUTION:</strong> <em>When a disk is initialized, all data on the disk is lost.</em></td>
</tr>
<tr>
<td>The disk assigned as the global spare has failed or is missing.</td>
<td></td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135.</td>
</tr>
</tbody>
</table>

Table 44. Recreate a Deleted Array

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>An array(s) was accidentally deleted, or the wrong array was deleted</td>
<td>This procedure might recreate a deleted array and with its data intact. However, this is not guaranteed to occur. If I/O was running to the deleted array(s) just prior to it being deleted, there might be some data loss in the recreated array(s). If multiple arrays were deleted, all of the deleted arrays must be recreated in order to recover the desired array.</td>
<td>1. At the Array pop-up menu, select <strong>Create</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Create a new array using the same settings as the deleted array.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same disks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same RAID type (RAID level).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same capacity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same cache options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Check <strong>Leave Existing Data Intact</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click <strong>Create</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Ensure the settings are the same as the deleted array:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same drive letter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same RAID type (RAID level).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same disks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same capacity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The same cache option</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. Check the data files of the array for corrupted or missing files, incorrect file extensions, and so on.</td>
</tr>
</tbody>
</table>
11.5 Disk Related Errors

- Table 45. Disk Errors
- Section 11.5.1, Troubleshooting Disks, on page 135.

Table 45. Disk Errors

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Additional Information</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A disk has been removed from an array</td>
<td></td>
<td>See Section 11.5.1, Troubleshooting Disks, on page 135.</td>
</tr>
<tr>
<td>A disk is not visible in the BIOS Configuration Utility or is offline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A disk is highlighted red at the BIOS Configuration Utility</td>
<td>The disk has failed. Depending on the RAID level of the array, data might be lost.</td>
<td></td>
</tr>
<tr>
<td>RAIDXpert2 cannot communicate with the spare</td>
<td>The dedicated spare is not visible in the BIOS Configuration Utility or is offline.</td>
<td></td>
</tr>
</tbody>
</table>
| The disk cannot be initialized                             | Only disks that are Ready can be initialized.  
   **CAUTION:** *When a disk is initialized, all data on the disk is lost.* | • Ensure the disk is not already a member of an array.
   • Ensure the disk is still assigned as a global or dedicated spare.
   • Ensure the disk is reporting a Ready state. |

11.5.1 Troubleshooting Disks

Perform the following actions when there may be a problem with a disk.

- Ensure there is no damage to the system’s backplane.
- Ensure all cables are installed correctly.
- Ensure the disk is seated correctly in the backplane or bay and the latch is secured.
- Reinsert the disk.
- Replace the disk.
- After reconnecting, reseating, reinserting, or replacing a disk:
  - Perform a rescan.
  - Initialize the disk.

**CAUTION:** *When a disk is initialized, all data on the disk is lost.*
If problems with a disk have caused an array to go Critical, it may be necessary to also assign a dedicated or global spare for the array.

If problems with a disk have caused an array to go Offline, data may have been lost. Recover lost data from a backup storage source.
Chapter 12  Software License: EULA

12.1  Software License: End-User License Agreement (EULA)

BY INSTALLING, DOWNLOADING AND/OR USING THE SOFTWARE THAT ACCOMPANIES THIS END USER LICENSE AGREEMENT ("AGREEMENT") AND ANY ASSOCIATED DOCUMENTATION OR UPDATES THERETO ("SOFTWARE"), YOU AGREE THAT, WHETHER AS AN INDIVIDUAL OR AUTHORIZED REPRESENTATIVE OF AN ENTITY, YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY IT. IF YOU DO NOT AGREE TO IT, YOU ARE NOT AUTHORIZED TO INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE AND ARE ASKED TO PLEASE RETURN THE SOFTWARE TO THE PARTY FROM WHOM YOU RECEIVED IT. THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY UPON THE CONDITION THAT YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.

FURTHER, YOU UNDERSTAND THAT THIS SOFTWARE MAY ONLY BE OBTAINED FROM Advanced Micro Devices, Inc. (“AMD”) OR AN AUTHORIZED DISTRIBUTOR OF AMD. IF YOU OBTAINED THIS SOFTWARE FROM ANY OTHER SOURCE, THAT SOURCE PROVIDED IT TO YOU ILLEGALLY, AND YOU HAVE NO RIGHT TO INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE; SUCH USE IS A VIOLATION OF INTELLECTUAL PROPERTY RIGHTS.

12.1.1  Limited License to Authorized Distributors

If you are an OEM, distributor, reseller, integrator or other entity in the business of providing technology products and/or services, and if you have been expressly authorized to distribute copies of the Software to End User(s), you are an "Authorized Distributor." Subject to the terms and conditions of this Agreement, you are granted a limited, non-exclusive, non-transferable, non-sublicensable license to distribute and/or install the Software in its unaltered, object code form solely (i) to, and on behalf of, a purchasing End User for the End User’s internal business purposes; and (ii) only for use with one (1) AMD product, purchased through authorized AMD sales channels. Except as specifically stated in this Section 1, Authorized Distributors are expressly prohibited from: copying and/or distributing the Software in whole or in part; using the Software to provide consulting or other services to third parties; and distributing the Software in any form or format. Authorized Distributors are subject to all other terms and conditions of this Agreement. Authorized Distributors must ensure that its End Users see and agree to this Agreement.

12.1.2  Limited License to End Users

If you have licensed the Software for your own personal use or your company's internal use, you are an "End User." You are hereby granted, subject to the terms and conditions of this Agreement, a limited, non-exclusive, non-transferable, non-sublicensable license to use this Software in its
unaltered, object code form solely (i) for internal business purposes; and (ii) only with respect to one (1) AMD product that was purchased through authorized AMD sales channels. Further, you must obtain this Software only from authorized AMD sales channels. Obtaining it from any other source is a violation of the intellectual property rights of AMD and its licensors.

12.1.3 Restrictions

Except as expressly authorized in Sections 1 and 2 above, Authorized Distributors and End Users (collectively "You") shall not (nor cause or permit any other person to): (i) reverse engineer, translate, disassemble, derive source code from, decompile, rent, lease, manufacture, adapt, create derivative works from, or otherwise modify or distribute the Software or any part thereof; (ii) copy, in whole or in part, the Software with the exception that only End Users may make one copy of the Software for their backup or archival purposes; (iii) publicly display the Software or use the Software to provide consulting or other services to third parties; or (iv) delete any copyright, trademark, patent or other notices of proprietary rights as they appear anywhere in or on the Software.

12.1.4 Proprietary Rights

The Software is primarily the intellectual property of Seagate Technology PLC. (“Seagate”) and its licensors (“Licensors”). In no event shall You obtain title to the Software or any component thereof. As between Seagate and You, Seagate has all rights, title, interest, ownership and proprietary rights in and to the Software. Seagate's rights include, but are not limited to, all copies of the Software and any patent rights, copyrights, trademark rights, trade secret rights, and any other intellectual property right recognized in any country or jurisdiction in the world.

The Software is protected by both United States law and international treaty provisions.

All rights not expressly granted in this Agreement are reserved by Seagate and Licensors, respectively.

Certain modifications to the Software are the intellectual property of Advanced Micro Devices, Inc. As between AMD and You, AMD has all rights, title, interest, ownership and proprietary rights in and to those modifications including but not limited to any patent rights, copyrights, trademark rights, trade secret rights, and any other intellectual property right recognized in any country or jurisdiction in the world.

12.1.5 Terms and Conditions

This Agreement shall continue in effect until terminated. AMD may terminate this Agreement immediately if You fail to comply with any provision of this Agreement. Upon termination, You shall discontinue use of the Software, and either destroy, erase, or return all copies of the Software in Your possession or control.
12.1.6 No Warranty

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. SEAGATE AND AMD DISCLAIM, ON THEIR OWN BEHALF AND ON BEHALF OF LICENSORS, ANY EXPRESS OR IMPLIED WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE OR WILL OPERATE IN COMBINATION WITH OTHER SOFTWARE OR HARDWARE. Seagate and its Licensors will not provide support for the Software and, to the extent you believe that are entitled to support, you are advised to contact the party from whom you received the Software. Notwithstanding the foregoing, Updates to the Software (which may or may not be distributed) shall be governed by this Agreement, and such Updates will be considered Software for purposes of this Agreement.

The Software is not absolutely fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance in which the failure of the Software could lead directly to death, personal injury or severe physical or environmental damage, such as the operation of nuclear facilities, aircraft navigation, air traffic control, direct life support machines, or weapons systems (“High Risk Activities”). Express or implied warranties for High Risk Activities are specifically disclaimed.

12.1.7 Limitation of Liability

IN NO EVENT SHALL SEAGATE, AMD OR LICENSORS BE LIABLE TO ANY PARTY FOR ANY LOST REVENUE, LOST PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE EVEN IF THEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL SEAGATE’s, AMD’s or LICENSORS’ LIABILITY, TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNT OF ANY FEE PAID BY YOU FOR THE SOFTWARE. THE FOREGOING LIMITATIONS SHALL APPLY EVEN IF THE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some jurisdictions do not allow for the exclusion of implied warranties as described in Section 6, or the limitation of liabilities as described in this Section 7, so the above exclusions or limitations may not apply to You. In that event, to the extent permissible, any exclusion of warranties or limitation of liability will be limited in duration or type to the greatest extent allowed by law.

12.1.8 Export Controls

You agree to comply fully with all relevant export laws, regulations, treaties, and orders ("Export Laws") to assure that neither the Software nor any components thereof are (i) exported, directly or indirectly, in violation of Export Laws; or (ii) are intended to be used or are used for any purposes prohibited by the Export Laws.
12.1.9 General

This Agreement and any disputes arising from or relating to it shall be governed by and construed in accordance with the laws of the State of Colorado without reference to conflict of laws principles and excluding the U.N. Convention on Contracts for the International Sale of Goods. Any legal action or proceeding shall be instituted in a state or federal court in Denver, Colorado, U.S.A. and You agree to be subject to the jurisdiction of these courts. Taxes and charges imposed by any government with respect to the Software shall be paid by the End User. The waiver by either party of a breach of this Agreement or a failure to exercise any right hereunder shall not operate or be construed as a waiver of any subsequent breach or as a waiver of any other right. If any provision of this Agreement is held to be unenforceable or overbroad for any reason, it will be modified rather than voided, if possible, in order to achieve the intent of the parties to the extent necessary to make the provision enforceable under applicable law and enforced as amended. In any event, all other provisions of this Agreement will be deemed valid and enforceable to the full extent. This Agreement constitutes the complete agreement between the parties and supersedes all prior or contemporaneous agreements or representations, written or oral, concerning the subject matter of this Agreement including any purchase order or ordering document. This Agreement may not be modified or amended except in writing and signed by both parties.